ldentity and Access Management
for Electric Utilities

Executive Summary

e The National Cybersecurity Center of Excellence (NCCoE) developed an example solution that electric sector
businesses can use to more securely and efficiently manage access to the networked devices and facilities upon
which power generation, transmission, and distribution depend.

e The security characteristics in our access management platform are informed by guidance and best practices
from standards organizations, including the North American Electric Reliability Corporation’s (NERC) Critical
Infrastructure Protection (CIP) standards.

e The NCCoFE’s approach uses commercially available products that can be included alongside your current
products in your existing infrastructure. They provide a centralized system with a comprehensive view of all
users within the enterprise and across the IT, operational, and access control silos often found in electric
companies.

e The example solution is packaged as a “How To” guide that demonstrates implementation of standards-based
cybersecurity technologies in the real world, based on risk analysis. The guide helps organizations gain
efficiencies in access management, while saving them research and proof of concept costs.

The electric power industry is upgrading older, outdated infrastructure to take advantage of emerging technologies that
will create “a platform [that] efficiently [integrates] new energy resources, new technologies, and new devices into the
system.”* The ever greater numbers of technologies, devices, and systems connected to utilities’ grid networks need
protection from physical and cybersecurity attacks."

Our conversations with utility company employees confirmed that current identity and access management (IdAM)
implementations are often decentralized and controlled by numerous departments within a company. Several negative
outcomes can result from this: an increased risk of attack and service disruption, inability to identify potential sources of
a problem or attack, and a lack of overall traceability and accountability regarding who has access to both critical and
noncritical assets.

To better protect power generation, transmission, and distribution, electric companies need to be able to control access
to their networked resources, including buildings, equipment, information technology, and industrial control systems—
all of which have unique technical and political chaIIenges.* Identity and access management (IdAM) systems for these
assets often exist in silos, and employees who manage these systems lack methods to effectively coordinate access to
devices and facilities in these silos. This drives inefficiency and can result in security risks for utilities, according to our
electric sector stakeholders.

’ Thought Leaders Speak Out: The Evolving Electric Power Industry, The Edison Foundation Institute, June 2015.
" State of the Electric Utility 2015, Utility Dive, January 2015.
* Protect Critical Infrastructure, McAfee, 2012.



Imagine that a technician has access to several substations and remote terminal units connected to the company’s
network in those substations. The technician moves out of the region, so she quits her job. Without a centralized IdAM
system, managing her access to various facilities and systems can be cumbersome and time-consuming, even error-
prone. Electric utilities need the ability to provide the right person with the right degree of access to the right resources
at the right time, and quickly.

The NIST Cybersecurity Practice Guide “Identity and Access Management” demonstrates how commercially available
technologies can meet your utility’s need to control access to resources across the enterprise.

In our lab at the NCCoE, part of the National Institute of Standards and Technology (NIST), we built an environment that
simulates an electric company’s IT architecture, including the typical technology silos found in a utility (such as IT,
operational technology, and physical access control systems).

We show how an electric utility can implement a centralized IdAM platform to provide a comprehensive view of all users
within the enterprise across all silos, and the access rights they have been granted, by using multiple commercially
available products.

The guide:

e maps security characteristics to guidance and best practices from NIST and other standards organizations, and to
NERC CIP standards

e provides
o adetailed example solution with capabilities that address security controls
o ademonstrated approach using multiple products that achieve the same result

o instructions for implementers and security engineers, including examples of all the necessary
components and installation, configuration, and integration

e uses products that are readily available and interoperable with your existing information technology
infrastructure and investments

e is modular and suitable for organizations of all sizes, including corporate and regional business offices, power
generation plants, and substations

While we have used a suite of commercial products to address this challenge, this guide does not endorse these
particular products, nor does it guarantee regulatory compliance. Your utility’s information security experts should
identify the standards-based products that will best integrate with your existing tools and IT system infrastructure. Your
company can adopt this solution or one that adheres to these guidelines in whole, or you can use this guide as a starting
point for tailoring and implementing parts of a solution.

Our example solution has the following benefits:

e products and capabilities can be adopted on a component-by-component basis, or as a whole, thereby
minimizing impact to the enterprise and existing infrastructure

e can reduce the risk of malicious or untrained people gaining unauthorized access to critical infrastructure
components and interfering with their operation, thereby lowering overall business risk

e allows rapid provisioning and de-provisioning of access from a centralized platform, so IT personnel can spend
more time on other critical tasks



e improves situational awareness: proper access and authorization can be confirmed via the use of a single,
centralized solution

e improves security posture by tracking and auditing access requests and other IdAM activity across all networks

e can enhance the productivity of employees and speed delivery of services, and support oversight of resources,
including information technology, personnel, and data

You can get the guide at http://nccoe.nist.gov and help improve it by contributing feedback. As you review and adopt
this solution for your own organization, we ask you and your colleagues to share your experience and advice with us.

e email energy nccoe@nist.gov
e participate in our forums at hhttp://nccoe.nist.gov/forums/energy

Or learn more by arranging a demonstration of this reference solution by contacting us at energy nccoe@nist.gov.

TECHNOLOGY PARTNERS

The technology vendors who participated in this project submitted their capabilities in response to a call in the Federal
Register. Companies with relevant products were invited to sign a Cooperative Research and Development Agreement
with NIST, allowing them to participate in a consortium to build this example solution.
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Certain commercial entities, equipment, or materials may be identified in this document in
order to describe an experimental procedure or concept adequately. Such identification is not
intended to imply recommendation or endorsement by NIST or NCCoE, nor is it intended to

imply that the entities, materials, or equipment are necessarily the best available for the
purpose.
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The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards
and Technology (NIST) addresses businesses’ most pressing cybersecurity problems with
practical, standards-based solutions using commercially available technologies. The NCCoE
collaborates with industry, academic, and government experts to build modular, open, end-to-
end reference designs that are broadly applicable and repeatable. The center’s work results in
publicly available NIST Cybersecurity Practice Guides, Special Publication Series 1800, that
provide users with the materials lists, configuration files, and other information they need to
adopt a similar approach.

To learn more about the NCCoE, visit http://nccoe.nist.gov. To learn more about NIST, visit
http://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific
cybersecurity challenges in the public and private sectors. They are practical, user-friendly
guides that facilitate the adoption of standards-based approaches to cybersecurity. They
show members of the information security community how to implement example solutions
that help them align more easily with relevant standards and best practices.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. The documents in this series do not
describe regulations or mandatory practices, nor do they carry statutory authority.

To protect power generation, transmission, and distribution, energy companies need to control
physical and logical access to their resources, including buildings, equipment, information
technology, and industrial control systems. They must authenticate authorized individuals to
the devices and facilities to which they are giving access rights with a high degree of certainty.
In addition, they need to enforce access control policies (e.g., allow, deny, inquire further)
consistently, uniformly, and quickly across all of their resources. This project resulted from
direct dialogue among NCCoE staff and members of the electricity subsector, mainly from
electric power companies and those who provide equipment and/or services to them. The goal
of this project is to demonstrate a centralized, standards-based technical approach that unifies
identity and access management (IdAM) functions across operational technology (OT)
networks, physical access control systems (PACS), and information technology systems (IT).
These networks often operate independently, which can result in identity and access
information disparity, increased costs, inefficiencies, and loss of capacity and service delivery
capability. This guide describes our collaborative efforts with technology providers and electric
company stakeholders to address the security challenges energy providers face in the core
function of IdAM. It offers a technical approach to meeting the challenge, and also incorporates
a business value mind-set by identifying the strategic considerations involved in implementing
new technologies. This NIST Cybersecurity Practice Guide provides a modular, open, end-to-end
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example solution that can be tailored and implemented by energy providers of varying sizes
and sophistication. It shows energy providers how we met the challenge using open source and
commercially available tools and technologies that are consistent with cybersecurity standards.
The use case scenario is based on a normal day-to-day business operational scenario that
provides the underlying impetus for the functionality presented in the guide. While the
reference solution was demonstrated with a certain suite of products, the guide does not
endorse these products in particular. Instead, it presents the characteristics and capabilities
that an organization’s security experts can use to identify similar standards-based products that
can be integrated quickly and cost-effectively with an energy provider’s existing tools and
infrastructure.

Cyber, physical, and operational security; cyber security; electricity subsector; energy sector;
identity and access management; information technology
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When the National Cybersecurity Center of Excellence (NCCoE) met with electricity subsector
stakeholders, they told us they need a more secure and efficient way to protect access to
networked devices and facilities. The NCCoE developed an example solution to this problem
using commercially available products.

The NCCoE’s approach provides a centralized access management system that reduces risk of
disruption of service by reducing opportunities for cyberattack or human error.

This example solution is packaged as a “How To” guide that demonstrates how to implement
standards-based cybersecurity technologies in the real world, based on risk analysis and
regulatory requirements. The guide helps organizations gain efficiencies in identity and access
management, while saving them research and proof of concept costs.

1.1 The Challenge

The electric power industry is upgrading older, outdated infrastructure to take advantage of
emerging technologies that will create “a platform [that] efficiently [integrates] new energy
resources, new technologies, and new devices into the system.”* The ever greater numbers of
technologies, devices, and systems connected to utilities’ grid networks need protection from
physical and cybersecurity attacks.?

IdAM implementations in the electricity subsector are often decentralized and controlled by
numerous departments within an energy company. Several negative outcomes can result from
this: an increased risk of attack and service disruption, inability to identify potential sources of a
problem or attack, and a lack of overall traceability and accountability regarding who has access
to both critical and noncritical assets.

To better protect power generation, transmission, and distribution, energy companies need to
be able to control physical and logical access to their networked resources, including buildings,
equipment, information technology, and industrial control systems (ICS)—all of which have
unique technical and political chaIIenges.3 Identity and access management (IdAM) systems for
these assets often exist in silos, and employees who manage access to these systems lack
methods to effectively coordinate access to devices and facilities in these silos. This drives
inefficiency and creates security risks, according to our electric utility stakeholders.

We considered a scenario in which a utility technician has access to several physical substations
and remote terminal units connected to the company’s network in those substations. Personal

! Thought Leaders Speak Out: The Evolving Electric Power Industry, The Edison Foundation Institute, June 2015.
? State of the Electric Utility 2015, Utility Dive, January 2015.
® Protect Critical Infrastructure, McAfee, 2012.
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matters require the technician to move out of the region, so she terminates her employment at
the company. Without a centralized IdAM system, managing routine events like this one can
become cumbersome and time-consuming. How can energy companies be confident that
access to the appropriate physical and technological resources across the enterprise is granted
or revoked correctly, and in a timely fashion?

As this scenario shows, energy companies need to be able to authenticate the individuals and
systems to which they are giving access rights with a high degree of certainty. In addition,
energy companies need to be able to enforce access control policies (e.g., allow, deny, inquire
further) consistently, uniformly and quickly across resources.

1.2 The Solution
The example solution we propose demonstrates the following capabilities:
e centrally assigns and provisions access privileges to users based on a set of programmed
business rules for IT, OT, and physical resources
e creates, activates, and deactivates users for IT, OT, and physical resources

e provides a view of all user accounts within the enterprise and the access rights they have
been granted

e can change an existing user’s access to one or more resources

We accomplished this solution through deployment of a single centralized IdAM platform that
implements:

e an IdAM workflow to manage the overall process and to require explicit approval of
requests to access certain resources

e an identity store, which is the authoritative source for digital identities and their
associated access rights to resources

e a provisioning capability to populate information from the workflow and identity store
into the run-time capabilities

These combined capabilities can greatly reduce the time to update access to IT, OT, and
physical resources. They reduce opportunities for attack or error and lower the impact of
identity and access incidents on energy delivery, thereby lowering overall business risk. They
also improve a company’s security posture by integrating all the IdAM-related audit logs into
one, greatly improving visibility into authentication and authorization activities. Another benefit
of this example solution is that it supports use of multiple digital identities by a single person. A
current employee is likely to have several distinct digital identities because of independent
management of digital identities across IT, OT, and physical resources.

The guide:

e maps security characteristics to guidance and best practices from standards
organizations, including the North American Electric Reliability Corporation’s (NERC)
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Critical Infrastructure Protection (CIP) standards and NIST SP 800-53, Rev.4, ” Security
and Privacy Controls for Federal Information Systems and Organizations ”

e providesa
o detailed example solution and capabilities that address security controls
o demonstrated approach using multiple products to achieve the same result

o how-to for implementers and security engineers with instructions on how the
example solution can be integrated and configured into their enterprises in a
manner that achieves security goals, with minimum impact on operational
efficiency and expense

Commercial, standards-based products, like the ones we used, are readily available and
interoperable with existing information technology infrastructure and investments. While our
simulated environment may be most similar in breadth and diversity to the widely distributed
networks of large organizations, this guide is modular and provides guidance on
implementation of unified IdAM capabilities to organizations of all sizes. These include, but are
not limited to, corporate and regional business offices, power generation plants, and
substations.

This guide lists all the necessary components and provides installation, configuration, and
integration information so that an energy company can replicate what we have built. While we
have used a suite of commercial products to address this challenge, this guide does not endorse
these particular products. Your utility’s security experts should identify the standards-based
products that will best integrate with your existing tools and IT system infrastructure. Your
company can adopt this solution or one that adheres to these guidelines in whole, or you can
use this guide as a starting point for tailoring and implementing parts of a solution.

1.3 Risks

While risk is addressed in current industry standards, such as NERC CIP, our sector partners told
us about additional risk considerations at both the operational and strategic levels.

Operationally, a lack of a centralized IdAM platform can increase the risk of people gaining
unauthorized access to critical infrastructure components. Once unauthorized access is gained,
the risk surface increases and the opportunity for introduction of additional threats to the
environment, such as malware and denial of service (especially oriented towards OT) is
realized.

At the strategic level, you might consider the cost of mitigating these risks and the potential
return on your investment in implementing a product (or multiple products). You may also
want to assess if a centralized IdAM system can help enhance the productivity of employees
and speed delivery of services, and explore if it can help support oversight of resources,
including information technology, personnel, and data. This example solution addresses
imminent operational security risks and incorporates strategic risk considerations, too.
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Adopting any new technology can introduce new risks to your enterprise. We understand that
this example solution to mitigate the risks of decentralized IdAM may, in turn, introduce new
risks. By centralizing IdAM functions, we decrease the risk that multiple IdAM platforms can be
infiltrated to gain unauthorized access to networked devices. We recognize, however, that
centralizing IdAM functions may provide a point of single infiltration of multiple critical systems
(OT, PACS, and IT). We address this key risk in detail in Section 5.9.5.1 Threats, Vulnerabilities
and Assumptions, and provide a comprehensive list of mitigations in Section 5.9.6, Security
Recommendations.

1.4 Benefits
The example solution described in this guide has the following benefits:
e products and capabilities can be adopted on a component-by-component basis, or as a
whole
e minimizes impact to the enterprise and existing infrastructure

e reduces opportunities for attack or error, and impact of identity and access incidents on
energy delivery, thereby lowering overall business risk

e allows rapid provisioning and de-provisioning of access from a centralized platform, so IT
personnel can spend more time on other critical tasks

e improves situational awareness: proper access and authorization can be confirmed via
the use of a single, centralized solution

e improves security posture by tracking and auditing access requests and other IdAM
activity across all networks

1.5 Technology Partners
The technology vendors who participated in this build submitted their capabilities in response
to a notice in the Federal Register. Companies with relevant products were invited to sign a
Cooperative Research and Development Agreement (CRADA) with NIST, allowing them to
participate in a consortium to build this example solution. We worked with:

e AlertEnterprise

e CATechnologies

e Cisco Systemes, Inc.

e GlobalSign

e Mount Airey Group

e RS2 Technologies

e RSA Security, LLC

e RADiFlow
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e Schneider Electric
e TDi Technologies

e XTegc, Inc.

1.6 Feedback

You can improve this guide by contributing feedback. As you review and adopt this solution for
your own organization, we ask you and your colleagues to share your experience and advice
with us.

e email energy nccoe@nist.gov

e participate in our forums at http://nccoe.nist.gov/forums/energy

Or learn more by arranging a demonstration of this example solution by contacting us at
energy nccoe@nist.gov.

13 | NIST Cybersecurity Practice Guide SP 1800-2b
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This NIST Cybersecurity Practice Guide demonstrates a standards-based example solution and
provides users with the information they need to replicate this approach to identity and access
management. The example solution is modular and can be deployed in whole or in part.

This guide contains three volumes:
e NIST SP 1800-2a: Executive Summary

e NIST SP 1800-2b: Approach, Architecture, and _ YOU ARE HERE

Security Characteristics — what we built and why
e NIST SP 1800-2c: How To Guides — instructions for building the example solution

Depending on your role in your organization, you might use this guide in different ways:

Energy utility leaders, including chief security and technology officers will be interested in the
Executive Summary (NIST SP 1800-2a), which describes the:

e challenges electricity subsector organizations face in implementing and using IdAM
systems

e example solution built at the NCCoE

e benefits of adopting a secure, centralized IdAM system, and the risks of isolated,
decentralized systems

Technology or security program managers who are concerned with how to identify,
understand, assess, and mitigate risk, will be interested in this part of the guide, NIST SP1800-
2b, which describes what we did and why. The following sections will be of particular interest:

e Section 4.3, Risk Assessment and Mitigation, provides a detailed description of two
types of risk analysis we performed

e Table 1, Use Case Security Characteristics Mapped to Relevant Standards and Controls, in
Section 4.3, Risk Assessment and Mitigation, maps the security characteristics of this
example solution to cybersecurity standards and best practices, including NERC-CIP v.3
and v.5

IT professionals who want to implement an approach this like this will find the whole practice
guide useful. You can use the How-To portion of the guide, NIST Special Publication Series 1800-
2¢, to replicate all or parts of the build created in our lab. The How-To guide provides specific
product installation, configuration, and integration instructions for implementing the example
solution. We do not recreate the product manufacturers’ documentation, which is widely
available. Rather, we show how we incorporated the products together in our environment to
create an example solution.

This guide assumes that IT professionals have experience implementing security products in
energy industry organizations. While we have used a suite of commercial products to address
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this challenge, this guide does not endorse these particular products.* Your organization’s
security experts should identify the standards-based products that will best integrate with your
existing tools and IT system infrastructure. Your organization can adopt this solution or one that
adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring
and implementing parts of a solution for operational technology systems (OT), physical access
control systems (PACS), and IT systems (IT). If you use other products, we hope you will seek
those that are congruent with applicable standards and best practices.

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution.
This is a draft guide. We seek feedback on its contents and welcome your input. Comments,
suggestions, and success stories will improve subsequent versions of this guide. Please
contribute your thoughts to energy nccoe@nist.gov, and join the discussion at
http://nccoe.nist.gov/forums/energy.

The NCCoE initiated this project because IT security leaders in the electricity subsector told us
that IdAM was a concern to them. As we developed the original problem statement, or use
case, on which this project is based, we consulted with electric company chief information
officers, chief information security officers, security management personnel, and others with
financial decision-making responsibility (particularly for security).

The individuals we consulted told us that they need to control physical and logical access to
their resources, including buildings, equipment, IT, and industrial control systems. They need to
authenticate only designated individuals and devices to which they are giving access rights with
a high degree of certainty. In addition, they need to enforce access control policies (e.g., allow,
deny, inquire further) consistently, uniformly, and quickly across all of their resources. Current
IdAM implementations are often not centralized and are controlled by numerous departments
within an energy company. Several negative outcomes can result from this situation: an
increased risk of attack and service disruption, inability to identify potential sources of a
problem or attack, and a lack of overall traceability and accountability regarding who has access
to both critical and noncritical assets. Another key consideration is the need for companies to
demonstrate compliance with industry standards and/or government regulations.

We constructed two versions of an end-to-end identity management solution that provides
access control capabilities across the OT, PACS, and IT networks. We used the same approach
for each build in that we only interchanged two core products that contained the same

# Certain commercial entities, equipment, or materials may be identified in this document in order to describe an
experimental procedure or concept. Such identification is not intended to imply recommendation or endorsement
by NIST or the NCCoE, nor is it intended to imply that the entities, materials, or equipment are necessarily the best

available for the purpose.
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functionality and capability. Sections 5.3.1 and 5.3.2 detail these two example solutions. The
end result is that a user’s access to facilities and devices can be provisioned from a single
console. Access privileges can be modified by adding new users and assigning access for the
first time, modifying existing user access privileges, or disabling user access privileges. Our goal
was to provide the electricity subsector with a solution that addresses the key tenet of
cybersecurity—access management/rights—based on the principle of least privilege.’

4.1 Audience

This guide is intended for individuals responsible for implementing IT security solutions in
electricity subsector organizations.

4.2 Scope

This project began with a detailed discussion between NCCoE and members of the electricity
subsector community of their main security challenges. The risk of unauthorized access to
facilities and devices and the inability to verify if user access had been properly established,
modified, or revoked quickly became the focus.

In response, the NCCoE drafted a use case that identified numerous desired solution
characteristics. After an open call in the Federal Register, we chose technology partners on the
basis of their ability to provide these characteristics. We initially thought it would be feasible to
include federation of identity management® services in the scope. As we progressed through
the initial stages of solution development, we realized that access, authentication, and
authorization through federated identity means would vastly increase the amount of time
needed to complete a build. We narrowed the scope to providing identity management of
energy company employees including a centralized provisioning capability to the OT, PACS, and
IT networks. The scope became successful execution of the following provisioning functions:

1. enabling access for a new employee
2. modifying access for an existing employee

3. disabling access for a former employee

The objective is to perform all three actions from a single interface that can serve as the
authoritative source for all access managed within an energy provider’s facilities, networks, and
systems.

) Saltzer, Protection and the control of information sharing in multics, Communication of the ACM, 17 (7), 388-
402 (1974)

® “Federated identity management (FIM) is an arrangement that can be made among multiple enterprises that lets
subscribers use the same identification data to obtain access to the networks of all enterprises in the group.”
http://searchsecurity.techtarget.com/definition/federated-identity-management
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4.2.1  Assumptions

42.1.1 Security

All network and system changes have the potential to increase the attack surface within an
enterprise. In Section 4.3, Risk Assessment and Mitigation, we provide detailed
recommendations on how to secure this reference solution.

4.2.1.2 Modularity

This example solution is made of many commercially available parts. You might swap one of the
products we used for one that is better suited for your environment. We also assume that you
already have some IdAM solutions in place. A combination of some of the components
described here, or a single component, can improve your identity and access/authorization
functions, without requiring you to remove or replace your existing infrastructure. This guide
provides both a complete end-to-end solution and options you can implement based on your
needs.

4.2.1.3 Human Resources Database/Identity Vetting

This build is based on a simulated environment. Rather than recreate a human resources (HR)
database and the entire identity vetting process in our lab, we assumed that your organization
has the processes, databases, and other components necessary to establish a valid identity.

4.2.1.4 Identity Federation

We initially intended to work with energy providers to demonstrate a means for sharing
selected identity information across organizational boundaries. While we assumed the NCCoE
could implement some type of identity federation mechanism to authenticate and authorize
individuals both internal and external to the organization, this capability exceeded the scope of
the build.

4.2.1.5 Technical Implementation

The guide is written from a “how-to” perspective. Its foremost purpose is to provide details on
how to install, configure, and integrate components. We assume that an energy provider has
the technical resources to implement all or parts of the build, or has access to companies that
can perform the implementation on its behalf.

4.2.1.6 Limited Scalability Testing

We experienced a major constraint in terms of replicating the user base size that would be
found at medium and large energy providers. We do not identify scalability thresholds in our
builds, as those depend on the type and size of the implementation and are particular to the
individual enterprise.

4.2.1.7 Replication of Enterprise Network

We were able to replicate the three silos: 1) physical access control systems, 2) information
technology or corporate networks, and 3) the operational technology network, in a limited

NIST Cybersecurity Practice Guide SP 1800-2b



284
285
286
287
288
289
290
291
292

293

294
295
296
297

298
299
300
301
302
303
304
305

306
307
308
309
310
311
312

313
314

315
316

DRAFT

manner. The goal was to demonstrate both logically and physically that provisioning functions
could be performed from a centralized IdAM system regardless of its location in the enterprise.
In a real-world environment, the interconnections between the OT, PACS, and IT silos depend
on the business needs and compliance requirements of the enterprise. We did not attempt to
replicate these interconnections. Rather, we acknowledge that implementing our build or its
components creates new interfaces across silos. We focused on providing general information
on how to remain within the bounds of compliance should you adopt this example solution. In
addition, we provide guidance on how to mitigate any new risks introduced to the
environment.

4.3 Risk Assessment and Mitigation

We performed two types of risk assessment: the initial analysis of the risk posed to the
electricity subsector as a whole, which led to the creation of the use case and the desired
security characteristics, and an analysis to show users how to manage the risk to the
components introduced by adoption of the solution.

4.3.1  Assessing Risk Posture

According to NIST Special Publication (SP) 800-30, Risk Management Guide for Information
Technology Systems,’ “Risk is the net negative impact of the exercise of a vulnerability,
considering both the probability and the impact of occurrence. Risk management is the process
of identifying risk, assessing risk, and taking steps to reduce risk to an acceptable level.” The
NCCoE recommends that any discussion of risk management, particularly at the enterprise
level, begin with a comprehensive review of the Risk Management Framework (RI\/IF)8 material
available to the public.

Using the guidance in NIST’s series of publications concerning the RMF, we performed two key
activities to identify the most compelling risks encountered by energy providers. The first was a
face-to-face meeting with members of the energy community to define the main security risks
to business operations. This meeting identified a primary risk concern—the lack of centralized
IdAM services, particularly on OT networks. We then identified the core risk area, IdAM, and
established the core operational risks encountered daily in this area. We deemed these the
tactical risks:

e lack of authentication, authorization, and access control requirements for all OT in the
electricity subsector

e inability to manage and log authentication, authorization, and access control
information for all OT using centralized or federated controls

’ Guide for Conducting Risk Assessments, National Institute of Standards and Technology Special Publication 800-
30, Rev. 1, September 2012, http://csrc.nist.gov/publications/nistpubs/800-30-rev1/sp800_30_r1.pdf

® National Institute of Standards and Technology (NIST), Risk Management Framework (RMF)
http://csrc.nist.gov/groups/SMA/fisma/Risk-Management-Framework/
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e inability to centrally monitor authorized and unauthorized use of all OT and user
accounts

e inability to provision, modify, or revoke access throughout the enterprise (including OT)
in a timely manner

Our second key activity was conducting phone interviews with members of the electricity
subsector. These interviews gave us a better understanding of the actual business risks as they
relate to the potential cost and business value. NIST SP 800-39, Managing Information Security
Risk,” focuses particularly on the business aspect of risk, namely at the enterprise level. This
foundation is essential for any further risk analysis, risk response/mitigation, and risk
monitoring activities. Below is a summary of the strategic risks:

e impact on service delivery
e cost of implementation

e budget expenditure as they relate to investment in security technologies

e projected cost savings and operational efficiencies to be gained as a result of new
investment in security

e compliance with existing industry standards
e high-quality reputation or public image

e risk of alternative or no action

e successful precedents

Undertaking these activities in accordance with the NIST RMF guidance yielded the necessary
operational and strategic risk information, which we subsequently translated to security
characteristics. We mapped these characteristics to NIST’s SP 800-53 Rev.4™ controls where
applicable, along with other applicable industry and mainstream security standards.

43.2  Managing IdAM Risk

A foundation of cybersecurity is the principle of least privilege, defined as providing the least
amount of access (to systems) necessary for the user to complete his or her job.11 To enforce
this principle, the access control system needs to know the appropriate privileges for each user
and system. An analysis of the IdAM solution reveals two components that need to be
protected from both external and internal threat actors: the central identity and authorization

° Security and Privacy Controls for Federal Information Systems and Organizations, National Institute of Standards
and Technology Special Publication 800-53, Rev. 4, April 2013, http://dx.doi.org/10.6028/NIST.SP.800-53r4

10 Managing Information Security Risk, National Institute of Standards and Technology Special Publication 800-39,
March 2011, http://csrc.nist.gov/publications/nistpubs/800-39/SP800-39-final.pdf

1, Saltzer, Protection and the control of information sharing in multics, Communication of the ACM, 17 (7), 388-
402 (1974)
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store, and the authorization workflow management system. The authorization workflow
management system is trusted to make changes to the central identity and authorization store.
Therefore, any inappropriate or unauthorized use of these systems could change authorization
levels for anyone in the enterprise. If that occurred, the enterprise would experience a lack of
integrity of the identity and authentication stores. The central identity and authorization store
is the authoritative source for the enterprise and holds the hash for each user password, as well
as the authorizations associated with each user. Access to this information would enable an
unauthorized user to impersonate anyone in the organization. In this situation, the enterprise
would lose the confidentiality of its users.

To protect the build components, we implemented the following requirements in our lab
environment: access control, data security, and protective technology. Section 5.9, Evaluation
of Security Characteristics, provides a security evaluation of the example solution and a list of
the security characteristics. Please note that we addressed only the core requirements
appropriate for the IdAM build.

4.3.3  Security Characteristics and Controls Mapping

As explained in Section 4.3.1, we derived the security characteristics through a risk analysis
process conducted in collaboration with our electricity subsector stakeholders. This is a critical
first step in acquiring or developing the capability necessary to mitigate the risks as identified
by our stakeholders. Table 1 maps the desired security characteristics and example capabilities
of the use case to the Framework for Improving Critical Infrastructure Cybersecurity, relevant
NIST standards, industry standards, and controls and best practices.

12 Section 5.9.5.1.1 describes the security controls in place to mitigate this risk.
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Table 1. Use Case Security Characteristics Mapped to Relevant Standards and Controls

Example Characteristic

Cybersecurity Standards and Best Practices

Specific
Related and
Best Practices

NIST
Security Example CSF CSF SANS NERC CIP
Characteristics | Capability Function | Category S L ?3‘?1;53 B CAG20 | v3/5"

CIP-003-5 R1,
CSC 3-3, | CIP-004-5 R4,
PR.AC-1: Identities ISO/IEC CSC 12- | CIP-004-5 R5,
and credentials 27001:2013 1, CSC CIP-005-5 R1,
are managed for A.9.2.1,A9.2.2, 12- CIP-005-5 R2,
Authentication Authentication Access authorized devices | AC-2, 1A | A.9.2.4,A.9.3.1, 10,CSC CIP-007-5 R2,
for OT mechanisms Protect Control and users Family A9.4.2,A9.4.3 16-12 CIP-007-5 R5

B The relationship of NERC CIP requirements to the Security Characteristics is derived from a mapping between NIST 800-53 rev4 security controls and NERC
CIP requirements. It is provided for reference only. Please consult your NERC CIP compliance authority for any questions on NERC CIP compliance.
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Example Characteristic

Cybersecurity Standards and Best Practices

Specific
Related and
Best Practices

NIST
Security Example CSF CSF SANS NERC CIP
Characteristics | Capability Function | Category S ?3‘?‘;53 e CAG20 | v3/5"
PR.AC-2: Physical
access to assets is
managed and
protected AC-3,
PR.AC-3: Remote AC-17, CIP-003-5 R1,
access is managed | AC-19, CIP-004-5 R2,
PR.PT-3: Access to | AC-20, ISO/IEC CSC 3-3, | CIP-004-5 R4,
systems and CM-7, 27001:2013 CSC12- | CIP-004-5 R5,
Access assets is PE-2, A.6.2.2, A.9.1.2A, 1, CSC CIP-005-5R1,
Control controlled, PE-3, 11.1.1,A11.1.2, 12-10, CIP-005-5 R2,
and incorporating the PE-4, A.11.1.4,A.11.1.6, | CSC16- | CIP-006-5R1,
Access Control Access control Protective principle of least PE5, PE- | A.11.2.3,A.13.1.1, | 4, CSC CIP-006-5 R2,
for OT mechanisms Protect | Technology | functionality 6, PE-9 A13.2.1 16-12 CIP-007-5 R1,
PR.AC-4 Access
Permissions are CSC 3-3, | CIP-003-5R1,
managed, CSC 12- | CIP-004-5 R4,
incorporating AC-2, ISO/IEC 1, CSC CIP-004-5 R5,
principles of least | AC-3, 27001:2013 12-10, CIP-005-5 R1,
Authorization Access policy privilege and AC-5, A.6.1.2,A9.1.2, CSC 16- | CIP-005-5 R2,
(provisioning) management Access separation of AC-6, A9.2.3,A94.1, 4, CSC CIP-006-5 R1,
oT mechanisms Protect Control duties. AC-16 A9.4.4 16-12 CIP-007-5 R5
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Example Characteristic

Cybersecurity Standards and Best Practices

Specific
Related and
Best Practices

NIST
Security Example CSF CSF SANS NERC CIP
Characteristics | Capability Function | Category S ?3‘?‘;53 e CAG20 | v3/5"
CIP-003-5 R1,
DE.CM-3: CIP-004-5 R4,
Personnel activity CIP-004-5 R5,
is monitored to CIP-005-5 R1,
detect potential AC-2, CSC 4- CIP-005-5 R2,
cybersecurity AU-12, 2,CSC CIP-006-5 R1,
events AU-13, 12-1, CIP-006-5 R2
Continuous | PR.PT-1: Audit/log | CA-7, ISO/IEC CSC12- | CIP-007-5 R4,
Monitoring | records are CM-10, 27001:2013 10, CSC | CIP-007-5 R5,
Centrally & determined, CM-11 Al12.4.1,A.12.4.2, | 14-2, CIP-008-5 R2,
monitor use of Log account Detect, Protective documented, AU A.12.4.3,A.12.4.4, | CSC14- | CIP-010-5R1,
accounts activity Protect | Technology | implemented... family Al12.71 3, CIP-011-5 R2
Protect PR.DS-1: Data-at- ISO/IEC
exchange of rest is protected 27001:2013 A.8.2,
identity and PR.DS-2: Data-in- A.13.1.1, A.13.2.1, | CSC 16-
access Data transit is SC-8, SC- | A.13.2.3,A.14.1.2, | 16, CSC
information Encryption Protect Security protected 28 A.14.13 17-7 CIP-011-5R1
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Example Characteristic

Cybersecurity Standards and Best Practices

Specific
Related and
Best Practices

NIST

Security Example CSF CSF SANS NERC CIP
Characteristics | Capability Function | Category S ?3‘?‘;53 e CAG20 | v3/5"

PR.AC-1: Identities

and credentials

are managed for

authorized devices

and users

PR.AC-4 : Access ISO/IEC CIP-003-5 R1,

permissions are AC-2, 27001:2013 CSC 3-3, | CIP-004-5 R4,
Provision, managed, AC-3, A.6.1.2,A9.1.2, CSC12- | CIP-004-5 R5,
modify or Mechanisms for incorporating the | AC-5, A.9.2.1,A9.2.2, 1, CSC CIP-005-5 R1,
revoke access centrally principles of least | AC-6, A.9.2.3,A9.2.4, 12-10, CIP-005-5 R2,
throughout all managed privilege and AC-16, A9.3.1,A94.1, CSC 16- | CIP-006-5R1,
federated provisioning of Access separation of 1A A9.4.2,A9.43 4, CSC CIP-007-5 R4,
entities access Protect | Control duties Family ,A.9.4.4 16-12 CIP-007-5 R5
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4.4 Technologies

Table 2 provides information about the products and technologies that we implemented in order to satisfy the security control

requirements.14

Table 2. Products and Technologies Used to Satisfy Security Control Requirements

Security Example CSF .. .
. ore Application Compan Product Version Use
Characteristics Capability Subcategory pplicatl pany " :
Implements workflows for
creating digital identities
. R12.0 ).
Identity . and authorizing them
CA SP14 Build .
Manager 9140 access to physical and
-1 i logical includi
Authentication | Authentication PR:AC 1: Identity ogica 'resc.Jurces, including
. Identities and Management authoritative source
for OT mechanisms )
credentials are Platform Implements workflows for
managed for IMG™ creating digital identities
authorized Governance 6.9.74968 | and authorizing them
devices and Lifecycle access to physical and
users RSA logical resources.
Provision, Mechanisms for Authoritative source for
modify or centrally Vil Bfiaee Afjaptwe 7.1.5 digital |'dent|t|es and
revoke access managed Directory R29692 authorized access to

throughout all

provisioning of

resources.

“ This table describes only the product capabilities used in our builds. Many of the products have significant additional security capabilities that were not used
in our builds. The product column of the table contains links to vendor product information that describes the full capabilities.
> RSA IMG is now known as RSA VIA Governance and RSA VIA Lifecycle
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Security Example CSF . L. .
. .t Application Compan Product Version Use
Characteristics Capability Subcategory PP pany
federated access Credential Provides NAESB-compliant
entities GlobalSign Enterprise PKI | N/A X.509 certificates to OT
Management
personnel.
. Provides PIV-l smartcard
Credential . . .
Credential credentials and physical
Management / - L
. XTec Issuance N/A access control capability
Physical Access - - .
Solutions using the smartcard.
Control e
Physical
Credential Access Control Provides PIV-I smartcard
PR.AC-2: Management / XTec Logical Access N/A credentials and physical
Physical access | Physical Access - Control access control capability
Access Control Access control . . .
. to assets is Control Authentication using the smartcard.
for OT mechanisms L
managed and and Validation
protected Physical Access RS2 Controls physical access to
Control . AccessIT! 4.1.15 power facilities, buildings,
Technologies
Enforcement etc.
Authorization Access policy PR.AC-4: Access
(provisioning) management permissions are
oT mechanisms managed, L.
Provision incorporating Provisions access
modif or' VA RIS el the principles Provisionin AlertEnterprise Guardian 4.05P04 I EE R ) BiTs
v centrally P P . 2 HF3 IdAM workflow to Access It
revoke access of least .
managed L Universal
throughout all O privilege and
provisioning of .
federated separation of
. access .
entities duties
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Security Example CSF . L. .
. .t Application Compan Product Version Use
Characteristics Capability Subcategory PP pany
Authorization Access policy Identit Identit R12.0 Provisi identiti q
(provisioning) management M entity ¢ CA M—Yana or SP14 Build ri\;:sm,mst,' entl Iisf,n
or mechanisms anagemen Mensker | " gyqp | authorizationstoActive
RSA IMG™ 6.9.74968 v
Ozone
Ozone Console Q%tqonty
Provision, . and Ozone T
. Mechanisms for . Ozone
modify or Authority
centrally Server .
revoke access . . Secure Manages attributes that
managed Secure Attribute Mount Airey ) 2.1.301, .
throughout all . Attribute control access to high-
provisioning of Management Group - Ozone .
federated Management value transactions.
" access . Envoy
entities Public Key 4.1.0
Enablement dzc;n’e
Ozone Mobile
— | Console
2.0.2
PR.PT-1:
Audit/log
records are Industrial
. Controls access to
Centrally determined, Control System . . .
. Log account TDi industrial control system
monitor use of > documented, (ICS) User . Console Works | 4.9-0u0 .
activity . Technologies (1CS) devices by people (ICS
accounts implemented, Access . .
. engineers and technicians).
and reviewed Management

in accordance
with policy

' RSA IMG is now known as RSA VIA Governance and RSA VIA Lifecycle
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Security Example CSF .. .
Characteristics Capability Subcategory SERRcEtion Company AL Version Use
Industrial
Control System DI Creates an audit trail of
(ICS) User . Console Works | 4.9-0u0 access to ICS devices by
Technologies
Access people.
Management
Industrial
Control
PR.PT-3: Access ICS Device-to- . System ‘ o
to systems and . . Firewall and iSIM Controls communication
. Device Access Radiflow . .
assets is TV CEp——— iSIM Software | 3.6.07 among ICS devices.
Access Control Access control controlled, OT Security
for OT mechanisms incorporating Substation
the principle of Security
least Controls access to
functionality Identity resources in OT by users in
Access Gateway Cisco Service Engine | 1.4.0.253 | IT based on both user
(ISE) identity and device
identity.
ConneXium
T Schneider Tofino 510 Controls access to devices
Electric Ethernet in the ICS/SCADA network
Firewall
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373

374 5.1 Example Solution Description

375 IdAM is the discipline of managing the relationship between a person and the resources the
376  person needs to access to perform a job. It encompasses the processes and technologies by
377  which individuals are identified, vetted, credentialed, and authorized access to and held

378 accountable for their use of resources. These processes and technologies create digital identity
379 representations of people, bind those identities to credentials, and use those credentials to
380 control access to resources. IdAM is composed of the capabilities illustrated in Figure 1.

381

2. Credential
Issuance &
Management

1. User
Registration

3. Access Rights
Management

5. Authentication 6. Access Control 7. Audit
382

383 Figure 1. IdAM capabilities

384 1. User registration determines that a reason exists to give a person access to resources,
385 verifies the person’s identity, and creates one or more digital identities for the person.
386 2. Credential issuance and management'’ provides life-cycle management of credentials
387 such as employee badges or digital certificates.

388 3. Access rights management determines the resources a digital identity is allowed to use.
389 4. Provisioning populates digital identity, credential, and access rights information for use
390 in authentication, access control, and audit.

391 5. Authentication establishes confidence in a person’s digital identity.

392 6. Access control’® allows or denies a digital identity access to a resource.

393 7. Audit maintains a record of resource access attempts by a digital identity.

394  The top three capabilities are administrative capabilities in that they involve human actions or
395 are used infrequently. For example, verifying identity typically involves physically reviewing
396 documents such as a driver’s license or passport. Credential issuance and management is

Y NIST SP 800-63-2, Electronic Authentication Guideline, provides additional information on credential issuance
and management, as well as authentication.

B NIST IR 7316, Assessment of Access Control Systems, explains commonly used access control policies, models,
and mechanisms.
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invoked when an employee is hired, changes jobs, leaves the company, loses a credential, or
when a credential expires.

The bottom three capabilities are “run-time” capabilities in that they happen whenever a
person accesses a resource. Authentication, access control, and audit are typically automated
activities that occur every time a person enters a facility using a badge, or logs into a computer
system. A directory, such as Microsoft Active Directory (AD), is often used in the
implementation of run-time functions.

Provisioning is the “glue” that connects the administrative activities to the run-time activities by
providing the run-time capabilities with the information needed from the administrative
activities.

In the electricity subsector today, all of these IdAM capabilities are frequently replicated at
least three times—once for a person’s access to OT, again for access to PACS, and then to
access IT. Additionally, these capabilities may be independently replicated for each system
within OT or IT. This replication makes it difficult to ensure that employees have access to the
resources they need to perform their jobs, and only those resources. Newly hired employees
may not have access to all the resources they need. Employees who change jobs may retain
access to resources they no longer need. Terminated employees may retain access long after
they have left. Further, multiple, independent IdAM processes make it difficult to periodically
review who has access to what resources.

The example solution described here addresses these problems by centralizing some of the
administrative capabilities into a core IdAM capability used across OT, PACS, and IT, while
leaving the run-time capabilities replicated and distributed. Figure 2 illustrates the example
solution.
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Figure 2. IdAM example solution

The centralized IdAM capability implements:

e an IdAM workflow to manage the overall process

e anidentity store, which is the authoritative source for digital identities and their
associated access rights to resources

e a provisioning capability to populate information from the workflow and identity store
into the run-time capabilities

The combined capabilities can reduce the time to update access in the OT, PACS, and IT systems
from days to minutes. They also improve the audit trail capture by integrating the three audit
logs into one. Provisioning may also verify that authorizations stored locally in the run-time
capabilities are consistent with those in the identity store. If locally stored authorizations are
inconsistent with authoritative values in the identity store, provisioning may raise an alarm or
change locally stored authorizations to be consistent with the identity store.

The example solution implements three basic transactions:

e creating all required credentials, authorizing access, and provisioning access for a new
employee

e updating credentials and access for an existing employee who is changing jobs or
requires a temporary access change
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e destroying credentials and removing accesses for a terminated employee

The IdAM workflow receives information about employees and their jobs from the HR system.
For a new employee, HR is responsible for performing initial identity verification. Based on a
new employee’s assigned job, the IdAM workflow creates one or more digital identities and
determines the credentials and resource accesses required. The workflow triggers credential
management capabilities to create physical identification badges, physical access cards, and any
logical access credentials such as X.509 public key certificates that may be needed. The
workflow records information about these credentials in the identity store.

The example solution does not assume that each person will have a single digital identity. A
current employee is likely to have several distinct digital identities because of independent
management of digital identities in physical security, business systems, and operational
systems. Requiring a single digital identity would create a significant challenge to adoption of
the example solution.

Instead, the identity store associates all of an employee’s digital identifiers so all of that
person’s accesses can be managed together. Once the example solution is in place, an
organization can continue issuing multiple digital identifiers to new employees or can assign a
single digital identifier that is common to physical security, business systems, and operational
systems.

The workflow automatically authorizes some physical and logical accesses that either are
needed by all employees or for an employee’s job. The workflow stores information about
credentials and authorized accesses in the identity store. The workflow can then invoke
provisioning to populate run-time functions with credential information and access
authorizations. This allows the employee to access facilities and systems.

Access to some resources, both logical and physical, will require explicit approval before being
authorized. For these, the workflow notifies one or more access approvers for each such
resource and waits for responses. When the workflow receives approvals, it stores the
authorized accesses in the identity store and provisions them to the run-time functions. All
information about approved, pending,19 and provisioned physical and logical access
authorizations is maintained in the identity store.

When the HR system notifies the workflow that an employee is changing jobs, the workflow
performs similar actions. First, it identifies resource accesses and credentials associated only
with the employee’s former job. It revokes those resource accesses in the identity store and de-
provisions them from the run-time functions. It directs that associated credentials be
invalidated and destroyed. It removes information about those credentials from the identity

9 Pending access authorizations may be either authorizations that have been approved but not yet provisioned or
time-bounded authorizations to be provisioned/deprovisioned at a future time.
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store and de-provisions credential information from the run-time functions.? It then identifies
resource accesses needed for the employee’s new job, authorizes them in the identity store,
and provisions them to the run-time functions. The workflow identifies any new credentials
that will be needed in the new job, triggers creation and issuance of those credentials, waits for
them to be created, updates the identity store, and provisions new credential information to
the run-time functions.

When the HR system notifies the workflow that an employee has been terminated, the
workflow removes all the employee’s resource accesses from the identity store and de-
provisions them from the run-time functions. It triggers invalidation and destruction of the
employee’s credentials, removes credential information from the identity store, and de-
provisions credential information from the run-time functions.

In addition to input from the HR system to process personnel actions, the workflow can provide
a portal for employees to request access to resources, which can be reviewed and approved.
Also, systems other than HR can be integrated with the workflow to initiate resource access
requests. These capabilities reduce overhead and administrative downtime.

5.1.1 The Physical Access Control System Silo

The PACS silo hosts both access control and badging systems. The badging systems implement a
credential issuance capability that creates the badges employees use to gain access to facilities
and other physical resources. The access control systems read information from badges and
check authorization information provided by the centralized IdAM capability to determine if a
person should be allowed access. If access is allowed, the access control system unlocks a door,
allowing the person to enter the facility.

Figure 3 shows the architecture of the PACS silo.

20 . . . . .o
Workflow actions are programmable and can be customized to meet organization-specific needs.
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Figure 3. Notional PACS architecture

An instance of Microsoft Active Directory contains identities and access control information for
the people who operate the badging systems and the people who manage the access control
systems. This access control information is provisioned into the PACS Active Directory instance
from the centralized IdAM system.

The PACS Active Directory instance may also store authorized physical access information used
by the access control systems. If the access control systems are integrated with Active
Directory, then the IdAM system will provision authorization information to PACS Active
Directory. If the access control systems are not integrated with Active Directory, then
authorization information will be provisioned directly to the access control system.?*

5.1.2  The Operational Technology Silo
The OT silo is composed of two types of systems—operational management systems that
operators and engineers use to monitor and manage the generation and delivery electric
energy to customers, and industrial control systems (ICSs) and supervisory control and data
acquisition (SCADA) systems that provide real-time and near real-time control of the equipment
that produces and delivers electric energy.

Figure 4 shows the notional architecture of the OT silo.

! Build #1 provisions directly to the access control system. Build #2 provisions to the PACS AD.
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Figure 4. Notional OT silo architecture

The operations and management network within the OT silo has an Active Directory instance
that contains identities and access authorizations for operational management systems. These
identities and authorizations are provisioned from the centralized IdAM system. A cross-silo
access control capability allows some access to operational management systems from the IT
silo. The centralized IdAM system provisions authorizations to access OT resources from the IT
silo into the OT Active Directory.

An electronic access control and monitoring system (EACMS) controls access to ICS/SCADA
devices on the ICS/SCADA network from the operations management network. The EACMS
allows operators and engineers terminal access to the programmable logic controllers (PLCs)
and remote terminal units (RTUs) that provide real-time control of energy production and
delivery. Authorizations allowing access via the EACMS may be provisioned into the OT Active
Directory instance or directly into the EACMS by the centralized IdAM system. The centralized
IdAM system can provide time-bounded authorizations that will allow access during a limited
time period. When the period expires, a workflow is triggered that revokes the authorization in
the identity store and de-provisions the authorization from the OT Active Directory instance.

An ICS/SCADA firewall controls communication among ICS/SCADA devices. The centralized
IdAM system does not currently manage or provision authorizations that control device-to-
device communication. Authorizations for device-to-device communications are either learned
by the firewall in training mode, or configured using a vendor-supplied application. This
capability could be added in a future version of the centralized IdAM system.
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5.1.3 The Information Technology Silo

The IT silo hosts business systems. These systems consist of user workstations and business
applications running on Microsoft Windows or Linux servers. An IT Active Directory instance
contains identities and access authorizations for both business system users and system
administrators who manage the applications and servers. These authorizations are provisioned
from the centralized IdAM system. Applications that are not integrated with Active Directory
can be provisioned directly by the centralized IdAM system.

Figure 5 shows the notional architecture of the IT silo.

Figure 5. Notional IT silo architecture

5.2 Example Solution Relationship to Use Case

When we first defined this chaIIenge22 in collaboration with industry members, we wrote the
following scenario:

“An energy company technician attempts to enter a substation. She is challenged to prove her
identity in a way that provides a high degree of confidence and is not onerous (i.e., does not
require a significant behavior change). Her attempt at entry initiates an authentication request
that, if possible, connects to the company’s authentication and authorization services to
validate her identity, ensure that she is authorized to access the substation, and confirm that a
work order is on file for that substation and that worker at that time.

Once she gains access to the substation, she focuses on the reason for her visit: She needs to
diagnose a remote terminal unit (RTU) that has lost its network connectivity. She identifies the
cause of the failure as a frayed Ethernet cable and replaces the cable with a spare. She then

2 http://nccoe.nist.gov/sites/default/files/nccoe/NCCoE_ES_ldentity_Access_Management.pdf
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uses her company-issued mobile device, along with the same electronic credential she used for
physical access, to log into the RTU’s Web interface to test connectivity. The RTU queries the
central authentication service to ensure the authenticity and authority of both the technician
and her device, then logs the login attempt, the successful authentication, and the commands
the technician sends during her session.”

The first portion of the scenario deals with physical access to a substation. Unlike the
description in this scenario, the example solution provides centralized management of
identities and authorizations, but assumes the decision to allow a particular technician access
to a particular facility at a particular time may be distributed. Distributing the access decision-
making capability helps ensure that access control continues to function in the event of
communication failures. Utilities have indicated that communication failures with substations
are common. Therefore, authorization to allow the technician access to the substation will be
created centrally by the IdJAM workflow, placed in the identity store, and then provisioned to
the PACS responsible for the substation. Accomplishing this requires integrating the work order
management system with the IJAM workflow. Assigning the technician a work order that
requires access to a substation triggers actions within the IdAM workflow to authorize access to
the substation and provision that authorization to the substation PACS. When the technician
presents her physical access credential at the substation, the PACS uses the provisioned
authorization to determine if she should be allowed access. Likewise, while not explicitly stated
in the example, completion of the work order triggers the IdAM workflow to remove the
technician’s substation access authorization and de-provision it from the substation PACS.

The second portion of the scenario deals with logical access to ICS/SCADA devices within the
substation. Again, unlike the description in the scenario, the example solution centralizes
management of identities and authorizations but assumes that run-time functions such as
authenticating a user and granting her access to specific ICS/SCADA devices are distributed
functions. In this case, the example solution assumes that the substation contains an EACMS to
which the technician connects her mobile device. The EACMS authenticates the technician and
controls her access to ICS/SCADA devices within the substation. Assigning the technician to this
work order triggers an IdAM workflow that authorizes her access to ICS/SCADA devices in the
substation, stores these authorizations in the identity store, and provisions both the
authorizations and any needed authentication credentials to the substation’s EACMS.
Completion of the work order triggers removal of the access authorization and de-provisioning
of authorizations and credentials from the substation EACMS.

5.3 Core Components of the Reference Architecture

To verify the modularity of the example solution and to demonstrate alternative provisioning
methods, we created two builds of the centralized IdAM capability. Both builds used the
following products:

e AlertEnterprise Guardian implements provisioning to an RS2 Technologies (RS2)
AccessIT! Physical Access Control System (PACS).
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596 e TDi Technologies ConsoleWorks and a Schneider Electric Tofino firewall serve as an
597 EACMS.

598 e A RADiIFlow ICS/SCADA firewall controls interactions between two Modbus-speaking
599 RTUs—a Schweitzer Engineering Laboratories (SEL) RTU and an RTU emulated by a
600 Raspberry Pi single-board computer.

601  Build #1 used CA Technologies (CA) Identity Manager to implement the IdAM workflow and

602  aspects of provisioning, and CA Directory to implement the identity store. Build #2 used the RSA
603  Identity Management and Governance (IMG) [now known as RSA VIA Governance and RSA VIA
604  Lifecycle] to implement the IdJAM workflow and the RSA Adaptive Directory to implement the
605 identity store and aspects of provisioning.

606 5.3.1 Build #1
607  Figure 6 illustrates Build #1.
608

609

610 Figure 6. Build #1

611  CA Identity Manager implements the IdJAM workflow. It receives input from an HR system in the
612 form of comma-separated value (.csv) files. We simulated the HR system using manually
613  produced .csv files. Identity Manager also provisions information to Microsoft Active Directory
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instances in business systems (IT), and the operational system (OT). No relationship among
these Active Directory instances is assumed.

IT applications are assumed to be integrated with Active Directory and use credential
information and authorization information in the IT Active Directory instance. If there are IT
applications that are not integrated with Active Directory, the provisioning capabilities of CA
Identity Manager would be used to directly provision the applications.

AlertEnterprise Guardian® provisions physical access authorizations into the RS2 PACS. CA
Identity Minder supports call-outs within a workflow that can be used to invoke external
programs. A call-out is used to connect with AlertEnterprise Guardian and provide information
to be provisioned to the RS2 PACS.

An instance of TDi Technologies ConsoleWorks is installed in the OT silo and integrated with the
OT Active Directory instance. Identity Manager provisions ICS/SCADA access authorizations in
the OT Active Directory instance. ConsoleWorks uses the access authorizations in OT Active
Directory to control user access to ICS/SCADA devices. Console Works also captures an audit
trail of all user access to the ICS/SCADA network.

A Schneider Electric Tofino firewall is installed between Console \Works and the ICS/SCADA
network. The firewall determines which IP addresses within the ICS/SCADA network are
accessible through ConsoleWorks and which network protocols can be used when accessing
those addresses. The combination of Console Works and the Tofino firewall implement an
Electronic Access Control and Monitoring System (EACMS) between the Energy Management
System / Operations Management Network and the ICS/SCADA network.

5.3.2  Build #2
Figure 7 illustrates Build #2.

** Guardian is also capable of implementing workflow and provisioning ICS devices. However, those capabilities
were not used in this build.
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Figure 7. Build #2

RSA IMG implements the IdAM workflow. It receives input from an HR system in the form of
.csv files. RSA IMG also has the capability to provision information to systems. In Build #2, RSA
IMG stores information in RSA Adaptive Directory, which subsequently provisions the
information to its associated Active Directory instances.

RSA Adaptive Directory implements the identity store and provisioning portions of the example
solution. RSA Adaptive Directory is a virtual directory that acts as a proxy in front of multiple
back-end directories. The build assumes that each silo—OT, PACS, and IT—hosts a Microsoft
Active Directory instance. No relationship among these Active Directory instances is assumed.
When an IMG workflow stores information in Adaptive Directory, that information is actually
stored in one or more of the underlying Active Directory instances. In this way, storing
information in Adaptive Directory provisions that information into one or more Active Directory
instances.
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AlertEnterprise Guardian provisions physical access authorizations into the RS2 PACS. RSA IMG
writes these authorizations into Adaptive Directory, which stores them in the PACS Active
Directory instance. AlertEnterprise Guardian monitors the Active Directory PACS instance for
updates such as changed physical access authorizations for an existing user, addition of a new
user with physical access authorizations, or removal of an existing user and associated access
authorizations. When changes are detected, Guardian provisions them into the RS2 PACS.

As in Build #1, TDi Technologies ConsoleWorks and a Schneider Electric Tofino firewall are used

is used in the OT silo to provide an EACMS between the EMS/Operations Management Network
and the ICS/SCADA network. ConsoleWorks utilizes the OT Active Directory for authorization of

users in this build as well.

5.3.3 Implementation of the Use Case lllustrative Scenario
This section explains how each of the two builds implements the scenario in Section 5.2

A work order management system assigns a technician to resolve an issue with an RTU at a
substation. The system initiates a workflow in either CA Identity Manager or RSA IMG that
authorizes the technician physical access to the substation. In Build #1, this authorization is sent
to AlertEnterprise Guardian via a call-out in the workflow in CA Identity Manager. Guardian
provisions the authorization into the RS2 PACS. The authorization is also stored in the CA
directory. In Build #2, this authorization is written to Adaptive Directory and stored in the PACS
Active Directory instance. AlertEnterprise Guardian detects the authorization change for the
technician and provisions it to RS2. When the technician arrives at the substation and scans her
credentials at the door, RS2 allows her entry.

The workflow also authorizes access to ICS/SCADA devices in the substation. In Build #1,
Identity Manger stores this authorization in the CA directory and provisions it to the OT Active
Directory instance. In Build #2, IMG writes this authorization to Adaptive Directory, which
stores it in the OT Active Directory instance. When the technician connects her mobile device to
ConsoleWorks in the substation, she is authenticated, and ConsoleWorks checks the OT Active
Directory instance, sees that she is authorized, and allows her to access the ICS/SCADA devices
in the substation.

When the work order is closed, the work order management system triggers another workflow
that removes the technician’s access authorizations. In Build #1, the authorizations are
removed from the CA directory. Substation physical access is de-provisioned from RS2 via a call-
out from the workflow to AlertEnterprise Guardian. Identity Manager de-provisions ICS/SCADA
access from the OT Active Directory. ConsoleWorks detects the change in the OT Active
Directory instance and de-provisions the technician’s access to the RTU.

In Build #2, IMG removes the authorizations from Adaptive Directory. This removes the
authorizations from the PACS and OT Active Directory instances. AlertEnterprise Guardian
detects the change in the PACS Active Directory instance and de-provisions the technician’s
substation physical access. ConsoleWorks detects the change in the OT Active Directory
instance and de-provisions the technician’s access to the RTU.
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Without an active assigned work order, the technician has no physical or logical access to the
substation.?*

5.4 Supporting Components of the Reference Architecture

In addition to the products used to build an instance of the core example solution (the build),
several products provide supporting components to the build as show in Figure 8. These
products implement IdAM capabilities that, while necessary to completely implement IdAM
within an organization, are not an integral part of the centralized IdAM capability.

XTec AuthentX and GlobalSign demonstrate outsourcing some credential issuance and
management capabilities. XTec AuthentX also demonstrates outsourcing of some physical
access control capabilities.

XTec AuthentX Identity and Credential Management System25 provides a personal identity
verification interoperable (PIV-1) smartcard credential based on NIST standards that can be used
for logical and physical access. AuthentX demonstrates outsourcing of some aspects of user
registration, credential issuance and management, authentication, and access control
capabilities. These capabilities are provided using a cloud-hosted solution with identity vetting
workflows, credential issuance stations, and full life-cycle maintenance tools. AuthentX
produces Homeland Security Presidential Directive 12-compliant smart cards that are
interoperable with and trusted by federal counterparts.

XTec demonstrates a cloud-based implementation of the XTec physical access control (PACS)
product. The components of the XTec solution in our lab included XNode, card readers, and
compliant PIV-I cards. The XTec product places the XNode, an IP addressable RS232/RS485
controller within close range of the reader and door strike, as opposed to a typical central
control panel deployment. The XNode can also control SCADA devices and send them
encrypted instructions.

AuthentX IDMS/CMS can also provide a Web-based implementation of the IdAM workflow in
the example solution, as well as credential management and provisioning. AuthentX IDMS/CMS
can control, log, and account for identity vetting, credential issuance, and credential usage with
AuthentX PACS and logical access controls, as well as control credential revocation to all
interoperable resources immediately.

** The reference architecture requires substations to have power and communications to receive provisioned
authorizations. The reference architecture does not address crisis / emergency situations where this requirement
is not met. The reference architecture assumes existing energy company procedures for crisis / emergency
response will be used / updated to address this challenge.

> The description of the XTec product and its role supporting the implementation of the example solution was
provided to NCCoE by XTec.
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GlobalSign operates a North American Energy Standards Board (NAESB)-accredited Software as
a Service Certificate Authority. It illustrates an outsourced credential issuance and management
capability that provides NAESB-compliant X.509 digital certificates. NAESB-compliant digital
certificates are required credentials for authenticating Open Access Same-Time Information
Systems (OASIS) transactions and access to the Electronic Industry Registry—the central
repository for information related to energy scheduling and management activities in North
America.?®

Mount Airey Group (MAG) Ozone and Cisco Identity Services Engine (ISE) demonstrate access
control decision and enforcement capabilities that the centralized IdAM capability can
provision. MAG Ozone can also provide authorization management capabilities.

The MAG Ozone product provides a high-assurance attribute-based access control?’ (ABAC)
implementation. ABAC controls access to resources by evaluating access rules using attributes
associated with the resource being accessed, the person accessing the resource, and the
environment. Ozone Authority provides a high-assurance attribute store. Attributes stored in
Ozone Authority are managed using Ozone Console. Ozone manages attributes that control
access to high-value transactions such as high-dollar-value financial transactions.

Ozone Authority pulls attributes either from Adaptive Directory in Build #2 or from an AD
instance in Build #1. Once Ozone Authority pulls the attributes, their values are managed
through Ozone Console.

?® https://www.GlobalSign.com/en/digital-certificates-for-naesb/
7 NIST Special Publication 800-162, Guide to Attributed Based Access Control (ABAC) Definition and
Considerations.
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Figure 8. Supporting components

Ozone Server uses these attributes, in either the OT or IT silo, to decide if a user is allowed to
perform a transaction. Ozone Server provides its decision to the policy enforcement point
associated with the application.

MAG provided an application for the IT silo to demonstrate some of Ozone’s capabilities. The
application is described in Appendix c.®

Cisco ISE controls the ability of devices to connect over the network. ISE expands on basic
network address-based control to include the identity of the person using a device. ISE is used
in the builds to provide a gateway function between OT and IT, limiting which users and devices
are allowed to connect from IT to resources in OT.

?8 Other than the MAG demonstration application, a full ABAC capability was not included in the architecture. A
separate NCCoE project is creating an ABAC building block that could be used in IT or OT.
http://nccoe.nist.gov/content/attribute-based-access-control
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5.5 Build #3 - An Alternative Core Component Build of the Example Solution

RSA, CA, and AlertEnterprise all provide products that can implement the IdAM workflow,
identity store, and provisioning. Our initial builds of the example solution used RSA and CA
products to implement the IdAM workflow, the identity store, and Active Directory
provisioning. AlertEnterprise Guardian was used to provision the RS2 PACS; however, Guardian
can also implement the IdJAM workflow, identity store, and both OT and IT provisioning. To
illustrate Guardian’s full capabilities, AlertEnterprise created this independent build of the
example solution in their labs using the Guardian product.

Figure 9. Build #3

AlertEnterprise Guardian implements the IdAM workflow. It receives input from an HR system
in the form of comma-separated value (.csv) files. We simulated the HR system using manually
produced .csv files. Guardian provisions information to Microsoft Active Directory instances in
OT and IT. No relationship among these Active Directory instances is assumed.

IT applications are assumed to be integrated with Active Directory and use credential
information and authorization information in the IT Active Directory instance. If there are IT
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applications that are not integrated with Active Directory, the provisioning capabilities of
Guardian would be used to directly provision the applications.

Guardian provisions physical access authorizations into the RS2 PACS. Physical Access and
Cardholder life cycle functions are supported through Guardian workflow to ensure right level
of access is granted to the right people based on training, compliance and security
requirements.

An instance of TDi Technologies ConsoleWorks and a Schneider Electric Tofino firewall are
installed in the OT silo to implement an EACMS between the EMS/Operations Management
network and the ICS/SCADA network. ConsoleWorks is integrated with the OT Active Directory
instance. Guardian provisions ICS/SCADA access authorizations in the OT Active Directory
instance. ConsoleWorks uses the access authorizations in OT Active Directory to control user
access to ICS/SCADA devices.

Additional information about Build #3 is available from the AlertEnterprise Web site at
http://www.alertenterprise.com/resources-standards-nistcoe.php .

5.6 Build Implementation Description

The infrastructure was built on Dell model PowerEdge R620 server hardware. The server
operating system was VMware vSphere virtualization operating environment. In addition, we
used a 6-terabyte Dell EqualLogic network attached storage (NAS) product, and Dell model
PowerConnect 7024, and Cisco 3650 physical switches to interconnect the server hardware,
external network components, and the NAS.

The NCCoE built two instantiations of the example solution to illustrate the modularity of the
technologies. Build #1 uses the CA Technologies Identity Manager product. Build #2 uses the
RSA Identity Management and Governance (IMG) [now known as RSA VIA Governance and RSA
VIA Lifecycle] and RSA Adaptive Directory products.

The lab network is connected to the public Internet via a virtual private network (VPN)
appliance and firewall to enable secure Internet and remote access. The lab network is not
connected to the NIST enterprise network. Table 3 lists the software and hardware components
we used in the build, as well the specific function each component contributes.
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Product Vendor
Dell
Dell
Dell

VMware

Microsoft

Microsoft

Windows

Windows

AlertEnterprise

CA Technologies

Cisco

Cisco

GlobalSign

Mount Airey Group

Mount Airey Group

Table 3. Build Architecture Component List

Component Name
PowerEdge R620
PowerConnect 7024
Equallogic

vSphere vCenter Server
version 5.5

Windows Server 2012 r2
Active Directory Server

Windows 7

Windows Server 2012 r2
DNS Server

SQL Server

Enterprise Guardian

Identity Manager
Rel 12.6.05 Build 06109.28

ISE Network Server 3415

Catalyst Model 3650

Digital Certificates

Ozone Authority

Ozone Console

NIST Cybersecurity Practice Guide SP 1800-2b

Function

Physical server hardware
Physical network switch
Network attached storage

Virtual server and
workstation environment

Authentication and authority

Information management

Domain name system

Database

Interface and translation
between IdAM central store
and the PACS management
server

Identity and access
automation management
application, IdAM
provisioning

Network access controller

TrustSec-enabled physical
network switch

Cloud certificate authority

Central attribute
management system

Ozone administrative
management console
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Product Vendor

Mount Airey Group

Mount Airey Group

RADiFlow

RADiFlow

RSA

RSA

TDi Technologies

RS2 Technologies

Schweitzer Electronics
Laboratory

Schneider Electric

XTEC

Component Name

Ozone Envoy

Ozone Server

(iSIM) Industrial Service
Management Tool

SCADA Router
RF-3180S

Adaptive Directory
Version 7.1.5

IMG
Version 6.9
Build 74968

ConsoleWorks

AccessIT! Universal
Release 4.1.15

Physical access control
components

SEL-2411

Tofino Firewall model

number TCSEFEA23F3F20

XNode

5.6.1 Build Architecture Components Overview
The build architecture consists of multiple networks that mirror the infrastructure of a typical
energy industry corporation. The networks are a management network and a production
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Function

Enterprise identity store
interface

Ozone centralized attribute
based authorization server

Supervisory control and data
acquisition (SCADA) router
management application

Router/firewall for SCADA
network

Central identity store, [dAM
provisioning

Central IdAM system
(workflow management)

Privileged user access
controller, monitor, and
logging system

Configures and monitors the
PACS devices (e.g., card
readers, keypads, etc.)

Programmable automation
controller

Industrial Ethernet firewall

Remote access control and
management
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network (Figure 10). The management network was implemented to facilitate the
implementation, configuration, and management of the underlying infrastructure, including the
physical servers, vSphere infrastructure, and monitoring. The production network, Figure 11
consists of:

e the demilitarized zone (DMZ)

e |[dAM

e OT—ICS/SCADA industrial control system and energy management system (EMS)

e PACS—physical access control system network

e |T—business management systems

These networks were implemented separately to match a typical electricity subsector
enterprise infrastructure. Firewalls block all traffic except required internetwork
communications. The primary internetwork communications are the user access and
authorization updates from the central IdJAM systems between the directories and OT, PACS,
and IT networks.
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815

816 Figure 10. Management and production networks
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Figure 11. IdAM build architecture production network

The IdAM network represents the proposed centralized/converged IdAM network/system. This
network was separated into OT, PACS, and IT to highlight the unique IdAM components
proposed to address the use case requirements.

The IT network represents the business management network that typically supports corporate
email, file sharing, printing, and Internet access for general business-purpose computing and
communications.

The OT network represents the network used to support the EMSs and ICS/SCADA systems.
Typically, this network is either not connected to the enterprise IT network or is connected with
a data diode (a one-way communication device from the OT network to the IT network). Two-
way traffic is allowed per NERC-CIP and is enabled via the OT firewall only for specific ports and
protocols between specific systems identified by IP address.

The PACS network represents the network that supports the physical access control systems
across the enterprise. Typically, this network uses the enterprise IT network and is segmented
from the user networks by virtual local area networks (VLANSs). In our architecture, a firewall
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allows limited access to and from the PACS network to facilitate the communication of access
and authorization information. Technically, this communication consists of user role and
responsibility directory updates originating in the IdAM system.

5.6.2  Build Network Components
Internet — The public Internet is accessible by the lab environment to facilitate both cloud
services and access for vendors and NCCoE administrators.

VPN Firewall — The VPN firewall is the access control point for vendors to support the
installation and configuration of their components of the architecture. We used this access to
facilitate product training and implementation support. This firewall also blocks unauthorized
traffic from the public Internet to the production networks. We used additional firewalls to
secure the multiple domain networks (OT, PACS, IT, and IdAM).

Switching and Routing — Switching in the architecture is executed using a series of physical and
hypervisor soft switches. VLANs are implemented to segment the networks shown in Figures 9
and 10. VLAN switching functions are handled by physical Dell switches and the virtual
environment. Routing was accomplished using the firewall.

Demilitarized Zone — The DMZ provides a protected neutral network space that the other
networks of the production network can use to route traffic to/from the Internet or each other.

5.6.3 Operational Technology Network
The builds include the following OT network components:
e directory instance
e OT management workstation
e RTU with IP interface
e RTU with serial interface
e |ICS/SCADA router
e router management workstation
e |CS/SCADA gateway/access control system

This network emulates an energy enterprise OT network and systems. The specific vendor
products used in this network are identified in Table 3 and Figure 12. OT network.
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Figure 12. OT network

In the OT network, the RADiFlow router performs the ICS/SCADA network firewall function. The
ConsoleWorks product provides the access control/gateway function. The build used the
gateway function to manage access to the OT router and RTU management/console interface.
The interface can be used to configure the RTU as well as issue real-time function commands
(e.g., open/close relays). The access control/gateway uses the OT directory to obtain access
authority for each user requesting access to an RTU.

5.6.4 Information Technology Network
The builds include the following IT network components:
e Active Directory
e Cisco ISE
e TrustSec switch
e workstation
A typical enterprise includes information-sharing systems, email, and application servers. We

did not include these systems in the architecture because they are not needed to demonstrate
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879  the effectiveness of the IdJAM example solution. The specific vendor products used in this
880 network are identified in Table 3 and Figure 13.

881

882 Figure 13. IT network

883 5.6.5 Physical Access and Control System Network
884  The builds include the following PACS network components:

885 e Active Directory

886 e PACS control server — Access IT!

887 e integrated access control unit (including a card reader, keypad, and door strike)—RS2
888 Technologies

889 e workstation

890 This network emulates a typical enterprise PACS. The specific vendor products used in this
891 network are identified in Table 3 and Figure 14.
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Figure 14. PACS network

Two technologies are demonstrated in the PACS network: XTEC XNode and RS2 Technologies
AccessIT!. XTEC XNode is a physical access system using smart card readers, pin pads, and an
Internet cloud-based authorization service. The cloud service can federate (interoperate) with
corporate identity and access stores or can be operated as a fully outsourced PACS IdAM
solution. The RS2 Technologies system includes card readers, pin pads, and the AccessIT! local
management server. The local management server is integrated with the central identity and
access store via the AlertEnterprise Guardian product. In Build #1, Guardian receives IdAM data
directly from Identity Manager. Once the information is received, Guardian provisions the
information to the PACS management server. In Build #2, Guardian monitors the PACS directory
for IdAM changes. Once changes are identified, Guardian collects the information and
provisions the IdAM information to the PACS management server.

5.6.6 Identity and Access Management Network

5.6.6.1 Build #1

Build #1 includes the following IdJAM network components:
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e central IdAM system

e PACS IdAM interface system

e Structured Query Language (SQL) server
e MAG Ozone components

The IdAM was separated to highlight the unique IdAM components proposed to address the
use case requirements. The implementation is not a recommendation to separate I[dAM
functions on their own network. The products used in this build are identified in Table 3 and
Figure 15. Central IdAM network.

Figure 15. Central IdAM network, Build #1

The central IdAM system is the authoritative central store for identity and access authorization
data. CA Identity Manager provides central identity and access store as well as workflow
management capability in Build #1 (see Figure 15). The central IdAM system takes over control
of the directory instances in each silo. The control is implemented by providing an
administrative account credential for each managed directory to the IdAM system. This is an
important aspect of the implementation. When the administrative credential is issued, the
organization must limit access to the managed directories of the IdAM system to a reduced
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number of administrative users. The security of the solution partially depends on limited access
to the managed directories, as discussed in Section 5.9.6, Security Recommendations.

In this build, the OT, PACS, and IT directories synchronize (sync) with the central IdJAM system
using Lightweight Directory Access Protocol Secure (LDAPS). This synchronization is set up to
sync changes immediately from the IdAM system to each directory. In addition, an automated
sync function can be implemented to check for unauthorized changes in each directory to
increase the security of the implementation. Automated sync was not implemented in this
build.

AlertEnterprise Guardian integrates the IdAM central store with the PACS access management
system (AccessIT!). Guardian includes integration and translation capabilities to transfer the
IdAM data to the AccessIT! management server database. In this build, Guardian is integrated
with Identity Manager for IdJAM synchronization.

5.6.6.2 Build #2

The IdAM network components include a central IdJAM system, PACS IdAM interface system,
and the MAG Ozone components. The IdAM network represents the proposed
centralized/converged identity and access management network/system. This network was
separated to highlight the unique IdAM components proposed to address the use case
requirements. The implementation is not a recommendation to separate IdAM functions own
their own network. The products used in this build are identified in Table 3 and Figure 16.
Central IdAM network, Build #2.
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Figure 16. Central IdAM network, Build #2

The central IdAM systems are the authoritative central store for identity and access
authorization data. RSA IdAM products and AlertEnterprise provide central identity and access
stores as well as workflow management capability. The central IdAM system takes over control
of the directory instances in each silo. The control is implemented by providing an
administrative account credential for each managed directory to the IdAM system. This is an
important aspect of the implementation. When the administrative credential is issued, the
organization must limit the access to the managed directories of the IdAM system to a reduced
number of administrative users. The security of the solution partially depends on limited access
to the managed directories, as discussed in Sections 5.9.6

In this build, the OT, PACS, and IT directories sync with the central IdAM system using LDAPS.
This synchronization is set up to sync changes immediately from the IdAM system to each
directory. The IdAM system automatically syncs with each directory to check for unauthorized
changes to increase the security of the implementation.

In this build, Guardian was used to integrate the IdAM system with the PACS access
management system (AccessIT!). Guardian includes integration and translation capabilities to
transfer the IdAM data to AccessIT! Guardian monitors the PACS directory for IdAM updates.
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The MAG Ozone product provides secure attribute distribution within the enterprise. Section
5.4 describes its use.

5.6.7 Access Authorization Information Flow and Control Points

The access and authorization for each user is based on the business and security rules
implemented in workflows within the central IdAM system products (RSA IMG, CA Identity
Manager). The workflows include management approval chains as well as approval/denial data
logging. Once the central IdAM system has processed the access and authority request, the
updated user access and authorization data is pushed to the central ID store. The central ID
store contains the distribution mechanism for updating the various downstream (synchronized)
directories with user access and authorization data. This process applies to new users,
terminated users (disabled or deleted users), and any changes to a user profile. Changes include
promotions, job responsibility changes, and anything else that would affect the systems a user
needs to access.

5.6.7.1 OT Access and Authorization Information Flow

This section describes the OT ICS/SCADA access and authorization information flow for both
builds.
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Figure 17. Access and authorization information flow for OT ICS/SCADA devices
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Figure 17 depicts the access and authorization information flow for OT ICS/SCADA devices. The
red lines indicate the access and authorization data exchanges. The black lines depict the data
paths of two OT ICS/SCADA technicians accessing RTUs in the SCADA network (one from the IT
network and one from the OT network). Note that all data routed between networks flows
through the DMZ and network firewalls.

In the OT network, ConsoleWorks controls access to the OT ICS/SCADA devices. ConsoleWorks
uses the OT directory to determine which users are authorized to access OT ICS/SCADA devices.
It is the control point for users accessing OT network devices. ConsoleWorks stores profiles for
groups and specific users. The profiles define which OT devices each user is authorized to
access. In addition, ConsoleWorks monitors and logs each user session. This feature allows an
organization to monitor user activity, block undesired activities, and generate alerts for
suspicious or undesired activities.

In the IT network, a TrustSec switch controls which users have access to the OT network. ISE
controls the TrustSec switch. This meets the NERC CIP-005 requirement to maintain an
electronic security perimeter between the ICS/SCADA network and the rest of the corporate
networks. ISE uses the IT directory identity store to determine user access authority and limit
access to the ICS/SCADA network to authorized users. This capability enhances the enterprise’s
ability to follow NERC CIP-005. ConsoleWorks also authorizes users to access OT devices.

5.6.7.2 PACS Access and Authorization Information Flow

The PACS access and authorization information flows in each build are described below.
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Build #1

Figure 18. Access and authorization information flow for the PACS network, Build #1

The PACS network includes devices such as door locks and keypads. In Figure 18, the red lines
indicate the access and authorization data exchanges. Note that all data routed between
networks flows through the DMZ and network firewalls.

In the PACS network, the AccessIT! management server controls physical access to facilities,
rooms, and the like. AccessIT! updates the PACS devices as needed. The devices also report/log
user accesses to this server for logging/auditing purposes. In most environments, the PACS
network is segregated from other networks, typically using VLANs. Guardian provides the
access and authorization data that it collects from the Identity Manager provisioning server to
AccessIT!.
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1038  Build #2

1039

1040

1041 Figure 19. Access and authorization information flow for the PACS network, Build #2

1042 Thered lines in Figure 19 indicate the access and authorization data exchanges or PACS access
1043  in Build #2. In this build, IMG provisions all PACS IdAM data to the PACS directory.

1044  AlertEnterprise provides the access and authorization data that it collects from the PACS

1045  directory to AccessIT!.
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56.7.3 IT Access and Authorization Information Flow

Figure 20. Access and authorization information flow for the IT network

The red lines in Figure 20 indicate the access and authorization data exchanges in both builds.
Note that all data is routed among the OT, PACS, IT, and IdAM networks through the DMZ. In
the IT network, the hosts and other systems access the IT directory to determine which users
are authorized to access devices on the IT network. Active Directory provides the typical
identity store function of storing the access permissions.

5.7 Data

The builds required a user dataset to populate the central IJAM system. In both builds, the
IdAM system was initially populated with user data from a synthetic dataset. The dataset was
designed to mirror a typical HR system dataset export file. A .csv file was used, which is a typical
HR system export file type. The data included user names, titles, access assignments, unique
identifiers, and other details required to complete valid directory entries. Once the set of user
data was loaded into the IdAM system, each silo directory was provisioned with the appropriate
user data. Each silo directory was pre-configured with the group and attribute fields needed to
support the builds. For example, the OT network directory had user groups corresponding to
the ConsoleWorks user groups. The details are included in the How-To guide.
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5.8 Security Characteristics Related to NERC-CIP

The example solution both impacts and is impacted by the requirement to conform to NERC-CIP
standards.”

Because the example solution uses routed protocols, by definition, it falls within the security
perimeter of the adopting electricity subsector organization.>® According to NERC-CIP, there
must be a well-defined process for controlling access to all components within the
organization’s security perimeter.® So, access to the IdJAM network must be controlled.

The example solution is informed by NERC-CIP requirements and may contribute to CIP-aligned
implementations by providing mechanisms for centralizing logging and auditing of all IdAM
activity efficiently and cost-effectively.*? With this solution in place, information regarding
which users have access to what components is easily available via the central identity store.
Without the solution, this information would have to be gathered separately from each of the
IT, OT, and PACS network access control/directory components.

Table 4 describes how the centralized IdAM solution relates to NERC-CIP requirements.
Table 4. NERC-CIP Requirements

NERC-CIP Requirement IdAM Role

CIP 004-3a Maintain a list of individuals with | IJAM maintains, in the identity store, a

logical or unescorted physical access to record of all logical and physical access to

Critical Cyber Assets. resources. If critical cyber assets are
identified as such, IdAM inherently maintains
such a list.

CIP 004-3a Conduct a cybersecurity training | The IdAM workflow can be configured to
program for individuals with logical or check a training system before granting
unescorted physical access to Critical Cyber | access to critical cyber assets.

Assets.

CIP 004-3a Conduct personnel risk The IdAM workflow can be configured to

* The North American Electric Reliability Corporation (NERC) Critical Infrastructure Protection (CIP) cybersecurity
standards provide specific requirements that apply to the bulk power system and were used as a reference by the
development team. The proposed solution is designed to be CIP-informed. This document attempts to capture
some of the key areas where CIP standards are relevant to elements of the solution and its implementation, for
reference purposes. Please consult your NERC-CIP compliance authority for any questions on NERC-CIP
compliance.

** NERC Standard CIP-002-3 Cyber Security — Critical Cyber Asset Identification, Requirements section R3.

*! NERC Standard CIP-005-3a Cyber Security — Electronic Security Perimeter(s), Requirements section R2.

% NERC Standard CIP-007-3a Cyber Security — Systems Security Management, Requirements section R6.
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NERC-CIP Requirement IdAM Role

assessment. Individuals must have an verify that individuals have an acceptable risk
acceptable risk assessment before being assessment before granting access to critical
granted access to Critical Cyber Assets. cyber assets.

CIP 004-3a A list of all personnel with logical | The identity store maintains authoritative

or unescorted physical access to Critical information on all logical and physical access
Cyber Assets must be maintained. to resources. The identity store is a list of all
personnel with logical or unescorted physical
access to critical cyber assets.

CIP 004-3a Personnel with logical of physical | The IdJAM workflow receives information

access to Critical Cyber Assets must have from the HR system on terminations and can
that access removed within 24 hours if immediately de-provision access for
terminated for cause and within 7 days terminated employees. Information from the
otherwise. HR system will need to be provided to the

IdAM workflow at least daily to meet the 24-
hour constraint.

CIP 005-3 requires documentation of the The IdAM workflow is the process for
process for authorizing access in accordance | authorizing access. The workflow design and
with NERC CIP 004-3. implementation documents the process.

NERC CIP 005-3 requires cyber assets used in access control and/or monitoring of an electronic
security perimeter to be protected per CIP requirements. In both builds, the IdAM workflow,
the identity store, and the provisioning capability control the information used to make access
control decisions. They are considered inside the electronic security perimeter and must be
protected according to NERC-CIP requirements. Connections from the IdAM components to IT,
OT, and PACS must be considered access points to the electronic security perimeter.

5.9 Evaluation of Security Characteristics

The security characteristic evaluation seeks to understand the extent to which the IdAM
example solution provides a more secure, centralized, uniform, and efficient solution for
managing authentication and authorization services and access control across three
independent electricity subsector networks. In addition, it seeks to understand the security
benefits and drawbacks of the example solution.

59.1 Scope
The evaluation included analysis of the example solution to identify weaknesses, discuss
mitigations, and understand benefits and trade-offs.
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We considered the following elements of the IdAM example solution:

security functionality of components depicted within the OT, PACS, IT, and IdAM
networks in Figure 2, and their interactions with each other, with the exception of the
XTEC stand-alone access control system

analysis of the capabilities and overall workflow process for centralizing the
management of authentication and authorization services on and access control to the
IT, OT, and PACS networks, including assumptions, threats, vulnerabilities, mitigations,
benefits, drawbacks, trade-offs, and risks related to the following characteristics:

o centralization

o automation

o audit (accountability and tracking)
o authentication

o authorization

o access control

O provisioning

new “cross-silo” attacks that would not have been possible without the centralized IdAM
capability

how the example solution addresses the security characteristics listed in the use case
description https://nccoe.nist.gov/content/energy

security recommendations that should be addressed when deploying the IdJAM design in
a real-world, operational environment

hands-on evaluation of the laboratory build as appropriate to support analysis and
demonstrate value

security-related aspects of the OT, PACS, and IT networks as they potentially impact the
solution posed by the example solution

The following elements of the example solution were not considered:

59.2

evaluation of any specific vendor product or its implementation

considerations regarding how to secure direct access to each of the three energy
networks (OT, PACS, and IT)

aspects of the build that are specific to the laboratory setting in which the build is
implemented

Security Characteristics Evaluation Assumptions and Limitations

This security characteristic evaluation has the following limitations:
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e The evaluation examines the security claims made by the example solution; however, it
is not a comprehensive test of all security components.

e The evaluation cannot identify all weaknesses. Its purpose is to verify that the example
solution meets its security claims, and to understand the trade-offs involved in doing so.

e This is not a red team exercise. The intent was to verify the security claims, not to break
hardware or software involved in the example solution.

e The lab routers and firewalls were not included in the evaluation. It is assumed that they
are hardened. Testing these devices would reveal only weaknesses in implementation

that would not be of value to those adopting this example solution.

593

Example Solution Analysis

Table 5 lists the example solution components, their functions, and the security characteristics
they provide. This analysis focuses on these security capabilities rather than on the vendor-
specific components. In theory, any number of commercially available components can provide
these security capabilities. Some of these components are in Build #1 of the IJAM example
solution and others are in Build #2. We discuss them as generic components providing a specific
security functionality rather than as vendor products. One vendor product could be substituted
for another that provides the same security functionality without affecting the results of the

evaluation.

Component

Identity,
Authorization, and
Workflow Manager

Table 5. IdAM Components and Security Capability Mapping

Specific Product

RSA IMG
Or
CA Identity Manager

Function

IdAM workflow engine; manages
identities, credentials, and
authorization for all other network
components in the use case.
Enforces workflows to ensure that

access control policies are enforced.

Security
Characteristic

Authentication and
authorization

Identity Store

RSA Adaptive Directory
(identity Store), which is
used with RSA IMG

Or

Windows SQL 2012,
which is used with CA
Identity Manager

Database of user identities

Authentication and
authorization

High Assurance
Attribute Service
(AAS)

MAG Ozone System

Access control solution with ABAC
architecture; provides increased
assurance by signing attributes with
private key infrastructure (PKI) and
requiring users to authenticate with
PKI
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Component

Translator between
Active Directory and
PACS and OT
Access Management
Systems (AMS)

Specific Product

AlertEnterprise Guardian

Function

Translates from RSA/CA IdAM
stores on IdAM network to OT and
PACS access management
systems, enabling access
management devices in the OT and
PACS networks to be provisioned
from the IdAM network

Security
Characteristic

Authorization, access
control

Directory Service

MS Active Directory (for
IT devices)
Or

RS2 PACS Server (for
PACS devices)

Database of PACS or IT resource
and user identifiers and their
associated security policies

Authentication and
authorization

SCADA Router and RADIFlow IP-addressable industrial control Access control
Remote Manager system gateway that enables remote
(RM) of SCADA control of physical devices:
Router Management workstation enables
remote management of physical SCADA
router; SCADA router serves as firewall,
terminal server, IP-to-serial
connectivity
Network Access Cisco ISE Allows access policies for network Network security
Control (AC) and endpoints to be controlled centrally
Policy Enforcement
System (PES)
Stand-alone XTEC Smartcard-based physical access Authentication,
Smartcard control authorization, access

Provisioning (SP)
and Access System
(AS)

control

59.4

Security Characteristics Addressed

One aspect of our security evaluation involved assessing how well the IdJAM example solution
addresses the security characteristics that it was intended to support. These security
characteristics are listed in a security control map published in the appendix of the IdJAM use

case description

(http://nccoe.nist.gov/sites/default/files/nccoe/NCCoE_ES_Identity_Access_Management.pdf).
Six security characteristics are listed, each of which is further classified by the Cybersecurity
Framework (CSF) categories and subcategories to which they map. The CSF subcategories
further map to specific sections of each standard and best practice cited in the CSF in reference
to that subcategory. Figure 21 depicts an example of the process.
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Figure 21. Example process for determining the security standards-based attributes for the example solution

We used the CSF subcategories to provide structure to the security assessment by consulting
the specific sections of each standard that are cited in reference to that subcategory. The cited
sections provide example solution validation points by listing specific traits that a solution that
orts the desired security characteristics should exhibit. Using the CSF subcategories as a
basis for organizing our analysis and consulting the specific sections of the security standards
that are cited with respect to each subcategory allowed us to systematically consider how well
the example solution supports the security characteristics identified in the use case description.

supp

The remainder of this subsection discusses how the example solution addresses the six desired

security characteristics that are listed in the use case description appendix:33

authentication for OT

access control for OT

authorization (provisioning) OT

centrally monitor use of accounts

protect exchange of identity and access information

provision, modify or revoke access throughout all federated entities

This section also discusses how the authentication, access control, and authorization
(provisioning) security characteristics are addressed for PACS.

% http://nccoe.nist.gov/sites/default/files/nccoe/NCCoE_ES_ldentity Access_Management.pdf
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594.1 Authentication, Access Control, and Authorization for OT

The implementation includes the capabilities that support these security characteristics. Section
5.6.7.1 describes the information flows for supporting authentication, access control, and
authorization (provisioning) on the OT network.

59.4.2 Centrally Monitor Use of Accounts

The example solution supports centralized accountability and tracking of user accounts, with
the IdAM identity, authorization, and workflow manager acting as the locus of this capability.

On the OT network, the console access manager, which acts as the gatekeeper to all ICS/SCADA
devices, monitors and logs all ICS/SCADA access requests and responses, as well as all user
interactions with the ICS/SCADA OT devices. These logs should be centrally monitored along
with other ICS/SCADA OT monitoring within the enterprise.

The network access control component also logs all access requests and responses received at
and generated by the IT network switch that controls access to the OT network from the IT
network. These logs should be centrally monitored along with other ICS/SCADA OT monitoring
within the enterprise.

On the PACS network, the PACS devices also report/log user access requests and responses to
the PACS server. These logs should be centrally monitored along with other ICS/SCADA OT
monitoring within the enterprise. In addition, the IdAM identity, authorization, and workflow
manager and the translator component log the PACS access change (add, delete, or change)
requests.

5.9.4.3 Protect Exchange of Identity and Access Information

All IdAM-related information exchange between IdAM components (as shown by the red lines
in Figures 17 — 20) should be performed in protected mode. In other words, at the least,
integrity checking mechanisms are performed on this communication so that tampering can be
detected. Preferably, these communications are encrypted. In particular, the following should
be in protected mode:

e allinformation exchange to/from the directory services in the IT, OT, and PACS networks

e all information exchanges between the console access manager (e.g., the ConsoleWorks
component in Figure 17) and the OT directory service

e allinformation exchange between the PACS server and the PACS translator component
(e.g., the AlertEnterprise component in Figures 18 and 19)

Because of time constraints, the laboratory builds of the example solution did not include
encryption or integrity assurance for every IdAM information exchange. Nevertheless, such
protection is strongly recommended when deploying the example solution.

NIST Cybersecurity Practice Guide SP 1800-2b



1212

1213
1214
1215
1216
1217
1218
1219
1220
1221
1222

1223
1224
1225
1226
1227
1228

1229
1230
1231
1232
1233
1234
1235

1236

1237
1238
1239
1240
1241
1242
1243
1244

1245
1246

DRAFT

5944 Provision, Modify, or Revoke Access

User authorizations for use of all IT, OT, and PACS network account assets, for ICS/SCADA
devices, and for physical access to rooms, facilities, and the like are provisioned, modified, and
revoked by modifying user authorization information in the central IdAM identity,
authorization, and workflow manager (CA Identity Manager or RSA IMG). These components, in
turn, propagate the changes to all entities used to make local authorization and access
determinations. Such information propagation ensures that all attempts to access IT, OT, and
PACS network assets, SCADA devices, and rooms and facilities are handled uniformly because
they are subject to the same updated access and authorization information when the silo
directory, console manager, PACS server, or other IdJAM device is consulted in response to the
access attempt.

5.9.5 Assessment of Reference Architecture

The IdAM example solution is not intended to encompass all aspects of electricity subsector
organization operations. It was designed to centralize management of authorization and access
in three disparate IdAM silos. Thus, our assessment considers the solution itself, not the
broader problem of providing general security to all aspects of electricity subsector
organization operations.

The example solution includes three network silos (OT, PACS, and IT,), plus an IdAM network
with numerous components that provide centralization, uniformity, and efficiency through the
use of IdAM workflows. All threats and vulnerabilities that are present on the IT, OT, and PACS
networks are also present in the example solution, so they will need to be addressed during
solution deployment. This evaluation assumes that the OT, PACS, and IT, networks are already
protected using physical access control and network security components such as firewalls and
intrusion detection devices that are configured according to best practices.

5.9.5.1 Threats, Vulnerabilities, and Assumptions

This evaluation concerns the IdAM network itself, its components, and their interaction with
IdAM components on the IT, OT, and PACS networks, which both provide the benefits afforded
by the example solution and introduce new attack surfaces and potential threats. For example,
each of the IT, OT, and PACS networks has directory services components that must be secured.
If the information in these directories is not safeguarded against tampering, the organization is
at risk. These directories must be safeguarded in both the existing three-silo architecture and
the example solution. The example solution, however, includes additional, related directory
components that must also be protected.?*

The identity, authorization, and workflow manager and the identity store on the IdAM network
must be protected from unauthorized access and their information safeguarded. All of the data

** Section 5.6 describes the components and products in each build of the reference solution.
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in the directory service components in the OT, PACS, and IT networks is accessible by the
identity, authorization, and workflow manager and the identity store. The ability to propagate
data from the IdAM network to the OT, PACS, and IT networks is the main strength as well as
the greatest vulnerability of the example solution. If the IdJAM identity store or the identity,
authorization, and workflow manager that has access to it were compromised, this would
equate to a compromise of each of the directory services in the IT, OT, and PACS networks. As a
result, controlling access to the IdAM network, controlling access to each IdAM component,
and securing communications among IdAM components is essential to securing the example
solution. Therefore, analysis of the security of the IdAM network, its components, and the
communications among IdAM components is central to the evaluation of the IJAM example
solution.

5.9.5.1.1. Controlling Access to the Identity, Authorization, and Workflow Manager®

The identity, authorization, and workflow manager on the IdAM network contains information
regarding actual users and accounts for the OT, PACS, and IT. It manages the identities and
credentials for the rest of the use case, but it does not manage them for itself. In other words,
the identity, authorization, and workflow manager component itself does not control user
access to the identity, authorization, and workflow manager. It has a separate set of user
accounts and passwords that are specific to this component and that IdAM administrators use
to log into it. This access must be strictly controlled so that only authorized IdAM
administrators can log into the identity, authorization, and workflow manager. Users or
authorized systems (such as HR or a work order management system) must log into the
identity, authorization, and workflow manager to provision all electricity subsector systems
(i.e., add identity information and authorization rules for new users, delete information for
former users, and modify information as user authorizations change).

There is no Active Directory running on the IdAM network. In the builds, access to the identity,
authorization, and workflow manager and to all other components of the IdJAM network is
granted by the use of username and credential, presented either via Web interface or via each
machine’s operating system (OS) console. An organization deploying the example solution
operationally would of course be free to implement alternative access control mechanisms.
While both privileged and unprivileged users may access the identity, authorization, and
workflow manager and other IdJAM components, only highly privileged users should be
permitted to create, delete, or modify accounts. Monitoring, logging, and auditing all activity
performed directly on IdAM components such as the identity, authorization, and workflow
manager or the identity store is essential to ensure that authorized users are not performing
unauthorized activities.

*> Section 4.3.2 describes the risks associated with access to the IdAM workflow.
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5.9.5.1.2. Logging Activity on IdJAM Components

Logging all activity performed on IdAM components is crucial for securing the example solution.
Ideally, access to all components on the IdAM network should be logged for the purpose of
auditing and accountability. The example solution is designed to allow logging of all user activity
on IdAM systems (e.g., identity, access, and authorization changes). The example solution
should also log all activity performed by administrators so that no activity is exempt from
monitoring, logging, and audit. Here is a closer look at three different types of IdAM system
users (in terms of the amount of privilege they have) and whether or not their activity should

be logged.

Unprivileged users, by definition, are not authorized to interact with any IdAM system. They
cannot create an account on the identity, authorization, and workflow manager or modify the
privileges of a user who already has an account. A user who works for HR, for example, who
needs to add a user identity or modify a user’s authorizations, would have an account on the
identity, authorization, and workflow manager (that was set up by a privileged user) that allows
him/her to add to or modify the information in the identity, authorization, and workflow
manager component via Web interface. Such a user would never be able to access the identity,
authorization, and workflow manager via its machine’s OS console. Console access would
enable the user to manage the operating system on which the component is running. All the
unprivileged user needs is the ability to use his/her own, unprivileged, user-level account on
the identity, authorization, and workflow manager’s machine. Because the example solution is
designed to monitor and log all activity that occurs over a Web interface, it will log all
unprivileged user activity.

Administrators, by definition, can access OS consoles and create user accounts on IdAM
machines such as the identity, authorization, and workflow manager. However, they are not
authorized to change the access control policies within the console access manager. As a result,
when administrators access the consoles of an IdAM system operating system, they must do so
via the console access manager. The console access manager will log and monitor all
administrator activity at any OS console.

Super-administrators, by definition, can not only access machine consoles and create user
accounts on IdAM machine operating systems; they can change the access control policies
within the console access manager. Therefore, the example solution cannot force them to use
the console access manager when accessing the consoles of IdJAM system machine operating
systems. If super-administrators do access the consoles of IdJAM system’s OS without doing so
via the console manager, their activity will not be logged or monitored. So, while super-
administrators should be strongly encouraged by policy to use the console access manager,
IdAM does not provide a technical mechanism to ensure that they will.

Access to the identity store on the IdAM network must also be strictly controlled, and the
identity store should be configured so that it will only perform addition, modification, and
deletion requests received from the identity, authorization, and workflow manager. If the
identity store were to accept updates or edits from another entity, the result could be

catastrophic. Any updates made by an administrator would have to be made via machine
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1323  console, so at least these would be logged. Updates made by a super-administrator could
1324  escape detection if the super-administrator were to defy organization policy and access the
1325 identity store console without going through the console access manager. We acknowledge
1326 insider threats but feel that mitigating the risk of insider threats presently relies more on
1327  organizational policy decisions rather than technology. Therefore, addressing insider threat is
1328 outside the scope of this project.

1329 5.9.5.1.3. Unauthorized Modification of Access and Authorization Information

1330 User identity and credential information is input into the identity, authorization, and workflow
1331  manager and then propagated to other IJAM components. If this information were deleted,
1332  modified, or falsified while in transit between components or while stored in a component, the
1333  result could be catastrophic. It is essential to protect access to each IJAM component so that
1334  adversaries cannot modify IdAM information stored in the components, and so IdAM

1335 information has at least its integrity and ideally its confidentiality protected when in transit
1336  between IdAM components.

1337 59.52 Mitigations: Essentials for Securing the IdAM Example Solution

1338 Based on the information flows for supporting OT authentication, OT access control, and OT
1339  authorization described in Section 5.6.7 securing the part of the IdJAM example solution that
1340  supports OT access control requires:

1341 e securing access to the

1342 o identity, authorization, and workflow manager, identity store, and network
1343 access control components on the IdJAM network (i.e., ensuring that only
1344 authorized users can access and add, modify, or delete information on these
1345 components)

1346 o directory service and console access manager components on the OT network
1347 (i.e., ensuring that only authorized users can access and add, modify, or delete
1348 information on these components)

1349 o IT network access control switch that serves as a gateway to the OT network
1350 from the IT network

1351 e protecting the integrity of the information exchanged between the

1352 o identity manager and the identity stores

1353 o identity store and the directory service on the OT network

1354 o directory service and the console access manager components on the OT
1355 network, as well as the network access control and policy enforcement system
1356 within the IT network

1357 o network access control component identity stores

1358 o network access control component on the IT network and the IT network access
1359 control switch that serves as a gateway to the OT network
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Based on the information flows for supporting PACS authentication, PACS access control, and
PACS authorization described in Section 5.6.7 securing the part of the IdJAM example solution
that supports PACS access control requires:

e securing access to the

o identity, authorization, and workflow manager; identity store; and IdAM
translator components on the IdAM network (i.e., ensuring that only authorized
users can access and add, modify, or delete information on these components)

o |dAM identity store and PACS directory service components on the PACS network
(i.e., ensuring that only authorized users can access and add, modify, or delete
information on these components)

e protecting the integrity of the information exchanged between the
o identity manager and identity stores

o identity store on the IdAM network and the PACS directory service on the PACS
network

o |dAM translator component on the IdAM network and the IdAM directory service
on the PACS network

o |dAM translator component on the IdAM network and the PACS management
server on the PACS network

5953 Trade-offs

As mentioned earlier, the very characteristics that are the main objectives of the example
solution, namely centralization and uniformity of the management of authorization and access,
are also its main vulnerabilities. A successful attack on the IdJAM network or its components
could result in a compromise of one or all of the OT, PACS, and IT networks. Organizations that
implement the example solution may incur additional costs to secure the IdAM network and its
components.

5.9.5.3.1 Benefits

The benefits of the IJAM example solution include consolidated management of identity and
access audit data; documented and repeatable business and security access decision processes
(workflows); approval/denial data logging; rapid provisioning and de-provisioning using
consistent, efficient, and automated processes; and better situational awareness through the
ability to track and audit all access requests and other IdAM activity across all four networks.
Other important benefits include greatly reduced time to implement access control changes
and highly automated identity synchronization across silos. For example, an OT, PACS, and/or IT
access change request can be implemented in minutes. These benefits directly reduce the cost
of the regulatory audit requirements imposed on the energy industry. They enable IdAM
processes to be handled efficiently, and with more granular, prompt, and cost-effective control.
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59.6 Security Recommendations

While the example solution provides a centralized IdAM security solution, the solution itself
provides a single attack vector that, if compromised, could have devastating consequences.
Therefore, an organization that implements the example solution must take great care to
secure the IdJAM example solution itself. When deploying their own implementations,
organizations should adhere to the following security recommendations:

e Conduct their own evaluations of their example solution implementation.

e Deploy all components on securely configured operating systems that use multifactor
authentication and are configured according to best practices.36

e Ensure that all operating systems on which example solution implementation
components are running are hardened, maintained, and kept up-to-date in terms of
patching, version control, and virus and malware detection.

e Putinto place a security infrastructure that will protect the example solution itself and
secure the communications among the components on the IdAM network and between
these components and the IdAM components on the other three networks, as described
in Section 5.9.5.2. Many of the remaining recommendations relate to providing such a
security infrastructure.

e Design the authorization and workflow policies that are enforced by the identity,
authorization, and workflow manager component to enforce the principle of least
privilege and separation of duties.

e Design the authorization and access control policies that govern user access to the IdAM
components themselves to enforce the principle of least privilege and separation of
duties.

e Segregate IdJAM components onto their own network, either physically or using private
VLANSs and port-based authentication or similar mechanisms.*’

e Deploy a security infrastructure to secure the IdJAM network and the IdAM platforms
themselves. This infrastructure must consist of a holistic set of components that work
together to prevent the IdAM network, components, and workflow from being used as
an attack vector.

e Protect the IdJAM network using security components such as firewalls and intrusion
detection devices that are configured according to best practices.

* The laboratory instantiation of the example solution builds did not implement every rule or guide in the STIGs
upon which the builds installations were based. Exceptions were made to allow for only the needed operation of
the solution. See the How-To section for details.

%7 |EEE 802.1X is a standard for Port-based Network Access Control that provides an authentication mechanism to
devices that are to be attached to a local area network.
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Protect each of the OT, PACS, and IT, networks using security components such as
firewalls and intrusion detection devices that are configured according to best practices.

Strictly control physical access to the OT, PACS, IT, and IdAM networks.

Configure firewalls to limit connections between the IdAM network and the production
(IT, OT, and PACS) networks, except for connections needed to support required
internetwork communications to specific IP address and port combinations in certain
directions. The primary required, authorized internetwork communications are user
authorization updates from the identity, authorization, and workflow manager
component to the directory services on the production networks, the OT console access
manager, and the PACS server, and logging information in the reverse direction.
Firewalls should block all incoming connections from the Internet and to limit outgoing
connections to the Internet, if any, to specific systems and required ports.

Perform all IdAM-related information exchanged between IdAM components (as shown
by the red lines in Figures 17 - 20) in protected mode, meaning that, at the least,
integrity checking mechanisms are performed on this communication so that tampering
can be detected. Preferably, these communications should be encrypted. In particular:

o Perform all information exchange to/from the directory services in each of the
OT, PACS, and IT, networks in protected mode.

o Perform all information exchange between the console access manager (i.e., the
ConsoleWorks component in Figure 17) and the OT directory service in protected
mode.

o Perform all information exchange between the network access control manager
(i.e., the Cisco ISE component in Figure 17) and the switch in the IT network that
controls access to the OT network in protected mode.

o Perform all information exchange between the PACS server and the PACS
translator component (e.g., the AlertEnterprise component in Figure 18 and 19
in protected mode.

In the case of IdAM exchanges with the silo directories, protected mode is defined as
the use of Start Transport Layer Security (TLS) (RFC 2830) rather than LDAPS, which uses
Secure Socket Layer and has been deprecated in favor of Start TLS.

Install, configure, and use each component of the example solution (e.g., the identity,
authorization, and workflow manager or the PAC server) according to the security
guidance provided by the component vendor.

Configure all IJAM components on the IdAM network so that it is impossible to access
them remotely.

Log all IdAM activity, for example direct access to IJAM components on the IdAM
network and all messages exchanged between IdAM components. Limit the number of
users able to control whether or not activity performed is logged.

Require super-administrators (i.e., users who are authorized to change the access
control policies within the console access manager) to use a console access manager
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when accessing the console of all devices on the IdAM network and never to access any
console directly. Use of a console access manger ensures that all activity performed via
the console is logged.

e Configure the console access manager to have an always-on connection to all devices on
the IdAM network so that it can monitor each device’s console port. This configuration
ensures that all activity performed over the console port will be logged. Configure the
console access manager to generate an alert if the always-on connection to any device is
disconnected. This configuration ensures that security auditors can be aware of any
times during which the console port of a device may have been accessed without the
activity being logged or monitored.

e Configure all devices on the IdJAM network so that they have only one console port (the
port to which the console access manager has an always-on connection). Alternatively
(where applicable), configure the devices on the IdAM network to allow only one
console connection or login at a time. This will ensure that the console access manager
will log all activity performed via the console of any of these devices.

5.9.7 Security Characteristics Evaluation Summary

Overall, the example solution and the workflow processes that it enforces succeed in
centralizing IdAM functions across the OT, PACS, and IT networks to provide an efficient,
uniform, and secure solution for authenticating and authorizing access across all systems and
facilities. The solution enables access control policies across all three networks to be enforced
consistently, quickly, and with a high degree of granularity, so that users are granted only
enough privilege necessary to complete their work for only the necessary amount of time. It
also enables a centralized, simplified audit capability for accountability and tracking. Such
benefits come with a cost. This cost is the requirement to secure and log all access to the IdAM
network, its components, and the information exchanged between these components and
IdAM components on the OT, PACS, and IT, networks.

We conducted a functional evaluation of the IdJAM example solution to verify that several
common key provisioning functions of the example solution, as implemented in our laboratory
build, worked as expected. The IdJAM workflow capability demonstrated the ability to centrally

e assign and provision access privileges to users based on a set of programmed business
rules in the OT, PACS, and IT, networks and systems
e create, activate, and deactivate users in the OT, PACS, and IT, networks and systems

e change an existing user’s access to the various networks and systems

Section 6.1 explains the functional test plan in more detail and lists the procedures used for
each of the functional tests.
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1503 6.1 IdAM Functional Test Plan

1504  This test plan includes the test cases necessary to conduct the functional evaluation of the
1505 IdAM use case. The IdAM implementation is currently deployed in a lab at the NCCoE. Section 5
1506  describes the test environment.

1507  Each test case consists of multiple fields that collectively identify the goal of the test, the
1508  specifics required to implement the test, and how to assess the results of the test. Table 6
1509 provides a template of a test case, including a description of each field in the test case.

1510 Table 6. Test Case Fields

Test Case Field Description

Parent requirement Identifies the top-level requirement or the series of top-level
requirements leading to the testable requirement.

Testable Drives the definition of the remainder of the test case fields. Specifies
requirement the capability to be evaluated.

Associated Security The NIST SP 800-53 rev 4 controls addressed by the test case.

Controls

Description Describes the objective of the test case.

Associated test In some instances a test case may be based on the outcome of another

cases test case(s). For example, analysis-based test cases produce a result
that is verifiable through various means such as log entries, reports,
and alerts.

Preconditions The starting state of the test case. Preconditions indicate various
starting state items, such as a specific capability configuration required
or specific protocol and content

Procedure The step-by-step actions required to implement the test case. A
procedure may consist of a single sequence of steps or multiple
sequences of steps (with delineation) to indicate variations in the test
procedure.

Expected results The specific expected results for each variation in the test procedure.

Actual results The actual observed results in comparison with the documented

expected results.
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Overall result The overall result of the test as pass/fail. In some test case instances,
the determination of the overall result may be more involved, such as
determining pass/fail based on a percentage of errors identified.

1511

1512 6.2 IdAM Use Case Requirements

1513  This section identifies the ES IdAM functional evaluation requirements that are addressed using
1514 this test plan. Table 7 lists those requirements and associated test cases.

1515 Table 7. IdAM Functional Requirements
Capability Parent Requirement Sub- Sub- Test Case
Requirement requirement requirement
(CR)ID 1 2
CR1 The IdAM system shall include an IdAM workflow

capability that assigns and provisions access
privileges to users based on a set of programmed
business rules in the following networks:

CR1.a IT

CR1la.1l Allow access IdAM-1
CR1l.a.2 Deny access IdAM-1
CR1.b oT

CR1.b.1 Allow access  IdAM-1
CR1.b.2 Deny access IdAM-1
CR1.c PACS

CR1l.c1 Allow access  IdAM-1
CR1.c.2 Deny access IdAM-1
CR2 The IdAM system shall include an IdAM workflow

capability that can create and activate new users in
the following networks and systems:

CR2.a IT IdAM-2
CR2.b oT IdAM-2
CR2.c PACS IdAM-2
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CR3 The IdAM system shall include an IdAM workflow
capability that can de-activate users in the following
networks and systems:

CR3.a

CR3.b

CR3.c

CR4 The IdAM system shall include a workflow capability
that can change an existing user access to the
various networks and systems.

CR4.a

CR4.a.1

CR4.a.2

CR4.b

CR4.b.1

CR4.b.2

CR4.c

CR4.c1

CR4.c.2
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PACS

oT

PACS

Allow to deny

Deny to allow

Allow to deny

Deny to allow

Allow to deny

Deny to allow

IdAM-2

IdAM-2

IdAM-2

IdAM-3

IdAM-3

IdAM-3

IdAM-3

IdAM-3

IdAM-3
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1518 6.3 Test Case: IdAM-1

1519 Table 8. Test Case ID: IdAM-1
Parent (CR 1) The IdAM system shall include an IdAM workflow capability that
requirement assigns and provisions access privileges to users based on a set of

programmed business rules in the following networks and systems:
(CR 1.a) IT, (CR 1.b) OT, (CR 1.c) PACS

Testable (CR1.a.1-2) IT, (CR 1.b.1-2) OT, (CR 1.c.1-2) PACS
requirement

Description Show that the IdAM solution can assign and provision access in the OT and IT
networks as well as in the PACS network and system, including allowing and
denying access.

Associated test
cases

Associated Security AC-2, AC-3, IA-2, PE-2, PE-3
Controls

Preconditions

=

HR representative .csv file is available.

2. IdAM example solution is implemented and operational in the lab
environment

3. Standard and privileged user sets are known to the testers.

4. A PACS system with a card reader and simulated door access
demonstration system is operational in the lab.

5. Asimulated OT network with an RTU and RTU emulator (Raspberry Pi) is
implemented in the lab.
Procedure 1. Activate IdAM workflow engine and run command to ingest the HR
.csv file.

2. At a workstation on the IT network, attempt to log in as a user known
to have access in the IT network.

3. At a workstation on the IT network, attempt to log in as a user known
to be denied in the IT network.

4. At a workstation on the OT network, attempt to log in as a user
known to have access in the OT network.

5. At a workstation on the IT network, attempt to access the Schweitzer
Engineering Laboratories (SEL) RTU administrative interface as a user
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known to have access to the SEL RTU.

6. At a workstation on the OT network, attempt to access the RTU
emulator administrative interface as a user known to have access to
the RTU emulator.

7. At a workstation on the IT network, attempt to access the SEL RTU
administrative interface as a user known to be denied access to the
SEL RTU.

8. At a workstation on the OT network, attempt to access the RTU
emulator administrative interface as a user known to be denied
access to the RTU emulator.

9. At a workstation on the OT network, attempt to log in as a user
known to be denied access in the OT network.

10. At the demonstration PACS card reader, attempt an “access” with a
card for a user known to have access allowed.

11. At the demonstration PACS card reader, attempt an “access” with a
card for a user known to not have access allowed.

Expected results Network Access Allowed

(pass)
Users with allowed access are able to log into a workstation on the IT

network.

Users with allowed access are able to log into a workstation on the OT
network as well as the SEL RTU and RTU emulator.

Users with allowed access are able to log into a workstation on the PACS
network.

Users with allowed access are authorized and allowed access by the PACS
card reader and door access demonstration system.

Network Access Denied

Users who are denied access to the IT network are unable to log into a
workstation on the IT network.

Users who are denied access to the OT network are unable to log into a
workstation on the OT network as well as the SEL RTU and RTU emulator.

Users who are denied access PACS network are unable to log into a
workstation on the PACS network.

Users without access are not authorized and not allowed access by the PACS
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Actual results

Overall result

1520

1521

card reader and door access demonstration system.

This test functioned appropriately and provided the expected results. User
that were denied access were unable to login to the OT and IT networks, and
denied access to PACS. Users granted access to each system were able to
access the OT and IT networks and granted access via PACS.

Pass
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6.4 Test Case IdAM-2

Parent
requirement

Testable
requirement

Description

Associated test
cases

Associated security
controls

Preconditions

Procedure

Table 9. Test Case ID: IdAM-2

(CR 2) The IdAM system shall include an IdAM workflow capability that can
create and activate new users in the following networks and systems: (OT,
PACS, IT,)

(CR 3) The IdAM system shall include an IdAM workflow capability that can
de-activate users in the following networks and systems: (IT, OT, PACS)

(CR 2.a) IT, (CR 2.b) OT, (CR 2.c) PACS
(CR 3.a) IT, (CR 3.b) OT, (CR 3.c) PACS

Show that the IdAM solution can create new users, assign access based on
business rules, and provision those users to the appropriate network and
system access control systems. New users are users without entries in the
authoritative identity store.

CR1

AC-2, AC-3, AC-5, AC-16, AU-12, IA-2, |A-4, IA-5, |A-6, PE-2, PE-3, PE-6

New HR .csv file created with new users included.

1. Demonstrate that the new users in the HR .csv file do not have access in
the OT, PACS, or IT, networks or systems using Test Case IdAM-1.

2. Perform procedure 1 of CR 1 with the new HR .csv file.

3. At a workstation on the IT network, attempt to log in as a new user
known to have access in the IT network.

4. At a workstation on the OT network, attempt to log in as a new user
known to have access in the OT network.

5. At a workstation on the IT network, attempt to access the SEL RTU
administrative interface as a new user known to have access to the SEL
RTU.

6. At a workstation on the IT network, attempt to access the RADiFlow
router administrative interface as a new user known to have access to
the RADiFlow router administrative interface.

7. At a workstation on the PACS network and system, attempt to log in as a
new user known to have access in the PACS network and demonstration
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system.

8. At a PACS card reader, attempt an “access” with a card for a new user
known to have access allowed.

9. Using the IdAM system, deactivate access for one or more users with
access to the OT, PACS, and IT, networks and systems. If one user has
access to all three, deactivating that user is sufficient.

10. At a workstation on the IT network, attempt to log in as a recently
deactivated user known to previously have access in the IT network.

11. At a workstation on the OT network, attempt to log in as a recently
deactivated user known to previously have access in the OT network.

12. At a workstation on the IT network, attempt to access the SEL RTU
administrative interface as a user known to previously have access to
the SEL RTU.

13. At a workstation on the OT network, attempt to access the RTU
emulator administrative interface as a user known to previously have
access to the RTU emulator.

Expected results (CR 2) Create and activate a new user.

(pass)
New users are created and access to the three networks and systems is
confirmed.
(CR2.a)IT

(CR 2.b) OT network, SEL RTU and RTU emulator

(CR 2.c) PACS network and demonstration card reader access system

(CR 3) Deactivate a user.

User is deactivated and access is denied to the network(s) and systems that
the user previously had allowed access.

(CR3.a)IT
(CR 3.b) OT network, SEL TRU, and RTU emulator
(CR 3.c) PACS network and demonstration card reader access system

Actual results This test was conducted with the expected results received. A CSV file with
users was successfully uploaded. Upon approval of the user access stated in
the file, the user accounts successfully logged into OT, PACS, and IT. User
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Overall result

access was deactivated and the deactivation approved. The users were no
longer able to access the OT, PACS, or IT.

Pass

6.5 Test Case IdAM-3

Parent
requirement

Testable
requirement

Description
Associated test

cases

Associated security
controls

Preconditions

Procedure

Table 10. Test Case ID: IdAM-3

(CR 4) The IdAM system shall include a workflow capability that can change
an existing user’s access to the various networks and systems.

(CR 4.a) IT, (CR 4.b) OT, (CR 4.c) PACS
(CR4.a.1,CR4.b.1, CR 4.c.1) Allow to deny
(CR4.a.2,CR4.b.2, CR 4.c.2) Deny to allow

Show that the IdAM solution can change user access for any network or
system.

CR 2

AC-2, AC-3, AC-5, AC-6, AC-16, AU-12, CM-7, IA-2, |1A-4, |A-5, |A-6, PE-2, PE-3,
PE-6

Reuse IdAM system in the state after IdAM-2 is completed.

1. Choose a set of users with known access and a set of users without
access for each of the OT, PACS, and IT networks and systems.

2. Use the IdAM workflow to deny access for the set of users with known
access chosen in 1 above.

3. Use the IdAM workflow to allow access for the set of users without
access chosen in 1 above.

4. At a workstation on the IT network, attempt to log in as a user whose
access had been changed from “allowed” to “denied”.

5. At a workstation on the IT network, attempt to log in as a user whose
access had been changed from denied to allowed.

6. At a workstation on the OT network, attempt to log in as a user whose
access had been changed from allowed to denied.

7. At a workstation on the OT network, attempt to log in as a user whose
access had been changed from denied to allowed.
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10.

11.

12

13.

14.

15.

16.

17.

At a workstation on the PACS network, attempt to log in as a user whose
access had been changed from allowed to denied.

At a workstation on the PACS network, attempt to log in as a user whose
access had been changed from denied to allowed.

At a PACS card reader, attempt an “access” with a card for a user whose
access had been changed from allowed to denied (card access denied in
the demo system).

At a PACS card reader, attempt an “access” with a card for a user whose
access had been changed from denied to allowed (card access allowed in
the demo system).

. At a workstation on the IT network, attempt to access the RADiFlow

router administrative interface as a user whose access had been changed
from allowed to denied.

At a workstation on the IT network, attempt to access the RADiFlow
router administrative interface as a user whose access had been changed
from denied to allowed.

At a workstation on the OT network, attempt to access the SEL RTU
administrative interface as a user whose access had been changed from
allowed to denied.

At a workstation on the OT network, attempt to access the SEL RTU
administrative interface as a user whose access had been changed from
denied to allowed.

At a workstation on the OT network, attempt to access the RTU emulator
administrative interface as a user whose access had been changed from
allowed to denied.

At a workstation on the OT network, attempt to access the RTU emulator
administrative interface as a user whose access had been changed from
denied to allowed.

Expected results (CR 4.) Change user access.

(pass)

(CR4.a) IT

(CR 4.a.1) Allow-to-deny changes are successfully provisioned.

(CR 4.a.2) Deny-to-allow changes are successfully provisioned.

(CR 4.b) OT
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(CR 4.b.1) Allow-to-deny changes are successfully provisioned.

(CR 4.b.2) Deny-to-allow changes are successfully provisioned.

(CR 4.c) PACS
(CR 4.c.1) Allow-to-deny changes are successfully provisioned.
(CR 4.c.2) Deny-to-allow changes are successfully provisioned.

Actual results The test provided the expected results with the impact of changes to user
access (allow to deny, deny to allow) and privilege levels (privileged to non-
privileged, non-privileged to privileged) verified.

Overall result Pass

1526
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Acronym Literal Translation

ABAC Attribute-Based Access Control

AD Active Directory

CA CA Technologies

CIP Critical Infrastructure Protection

CR Capability Requirement

CSF Cybersecurity Framework

.CSV Comma-Separated Value

DMZ Demilitarized Zone

EACMS Electronic Access Control and Monitoring System
EAP Electronic Access Point

EMS Energy Management System

ESP Electronic Security Perimeter

HR Human Resources

ICS Industrial Control System

ID Identity

IdAM Identity and Access Management

IDS Intrusion Detection System

IMG Identity Management and Governance
IP Internet Protocol

ISE Identity Services Engine

LDAPS Lightweight Directory Access Protocol Secure
MAG Mount Airey Group
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Acronym Literal Translation

NAESB North American Energy Standards Board

NAS Network Attached Storage

NCCoE National Cybersecurity Center of Excellence
NERC North American Electric Reliability Corporation
NIST National Institute of Standards and Technology
0sS Operating System

oT Operational Technology

PACS Physical Access Control System

PIV-I Personal Identity Verification Interoperable
PKI Private Key Infrastructure

RTU Remote Terminal Unit

SCADA Supervisory Control and Data Acquisition

sQL Structured Query Language

SSL Secure Socket Layer

STIG Security Technical Implementation Guideline
TLS Transport Layer Security

VLAN Virtual Local Area Network

VPN Virtual Private Network
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The Personal Profile Application (PPA) was developed by Mount Airey Group, Inc. in order to
demonstrate the functionality of the Ozone® Suite of products.

Ozone® implements atomic authorization for the protection of critical resources by
cryptographically binding credentials to specific authorizations, access rights, and/or explicit
privileges; as well as provides a privacy protecting mechanism that allows these authorizations
to be distributed across the enterprise — as close to the protected resource as necessary —
without concern for tampering, data mining, or compromise; and is meant to protect an
organizations most sensitive or highest risk resources. If an application relies on PKlI-based
smart cards and/or biometrics for authentication, then that system should implement the
congruent security for the authorization of users for access to that resource as is provided by
Ozone®.

In support of the National Cybersecurity Center of Excellence (NCCoE) Electricity Subsector
Identity & Access Management (IDAM) Use Case, the PPA was configured to incorporate digital
certificates that were generated by GlobalSign, Inc., to be compliant with the North American
Energy Standards Board (NAESB) certificate profile. Each certificate was provisioned within
Ozone® to have specific authorizations related to the PPA demonstration application.

This application has three main information groups for which actions can be authorized:
Personal Information, Credit Reports, and Criminal History. Based on the authorizations
associated with a credential, results pages are dynamically populated.

In order to bring up the demonstration application, the user must present a digital certificate to
the application. Upon inspection of the authorizations provisioned within Ozone® for the
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selected certificate, the application dynamically populates the table at the bottom of the first
screen with the results of the authorization queries. If the certificate has been authorized for a
specific action, then the results table will display “true” for that specific action. The information
identifying the certificate that was selected is also displayed above the table.

At that point, the user may either enter a name to search for in the search box on the right, or
simply hit the search button to display the Search Results page of the application. The search
will return a list of names as well as links to additional information about the people listed. The
links listed will vary depending upon the authorizations for which the user was authorized at
logon to the PPA. The available authorizations are:

e View Personal Information — View the personal information of the selected person.

e Edit Personal Information — Add or edit the personal information of people in the
application.

e View Criminal History — View the criminal history of the selected person.

e Edit Criminal History — Add or edit the criminal history of people in the application.

o View Credit Report — View the credit report of the selected person.

e Request a New Credit Report — Request an updated credit report for the selected
person.

Sample First Page Table:

Authorizations for: C=US, O=Blue Corp, OU=People, CN=Criminal History Editor

PPA Proof Authorized

Edit Criminal History true
Edit Personal Information false
Request Credit Report false
View Credit Report false
View Criminal History true
View Personal Information false

Sample Search Results Page Table:

95 | NIST Cybersecurity Practice Guide SP 1800-2b
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Search Results:

Name View Add View |[Request

CH CH CR CR
Hicks, Chick View Add View Request
McQueen, Lightning View Add View Request
Sullivan, James P View Add View Request
Waternoose, Henry J View Add View Request

Add a new entry...editPl.jsp

For the NCCoE Electricity Subsector IDAM Use Case, the following authorizations have been
configured for the NAESB certificates:

Jim McCarthy

Email Address = james.mccarthy@nist.gov, CN = James McCarthy, OU = GSUS, OU = NCCoE NIST
Energy IdAM test account, O = GMO GlobalSign Inc., L = Portsmouth, ST=NH, C=US

View Personal
Information

Edit Personal Information
View Criminal History
Edit Criminal History
View Credit Report
Request Credit Report

Donald Faatz

Email Address = donald.faatz@nist.gov, CN = Donald Faatz, OU = GSUS, OU = NCCoE NIST
Energy IdAM test account, O = GMO GlobalSign Inc., L = Portsmouth, ST=NH, C=US

View Criminal History
Edit Criminal History
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Harry Perper

Email Address = harry.perper@nist.gov, CN = Harry Perper, OU = GSUS, OU = NCCoE NIST
Energy IdAM test account, O = GMO GlobalSign Inc., L = Portsmouth, ST =NH, C= US

View Personal
Information

Edit Personal Information
View Criminal History
View Credit Report

John Wiltberger

Email Address = jwiltberger@mitre.org, CN=Johnathan Wiltberger, OU = GSUS, OU = NCCoE
NIST Energy IdAM test account, O = GMO GlobalSign Inc., L = Portsmouth, ST =NH, C = US

View Personal
Information

View Criminal History
View Credit Report
Request Credit Report
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The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards
and Technology (NIST) addresses businesses’ most pressing cybersecurity problems with
practical, standards-based solutions using commercially available technologies. The NCCoE
collaborates with industry, academic, and government experts to build modular, open, end-to-
end reference designs that are broadly applicable and repeatable. The center’s work results in
publicly available NIST Cybersecurity Practice Guides, Special Publication Series 1800, that
provide users with the materials lists, configuration files, and other information they need to
adopt a similar approach.

To learn more about the NCCoE, visit http://nccoe.nist.gov. To learn more about NIST, visit
http://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that
facilitate the adoption of standards-based approaches to cybersecurity. They show members of
the information security community how to implement example solutions that help them align
more easily with relevant standards and best practices.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. The documents in this series do not
describe regulations or mandatory practices, nor do they carry statutory authority.

To protect power generation, transmission, and distribution, energy companies need to control
physical and logical access to their resources, including buildings, equipment, information
technology, and industrial control systems. They must authenticate authorized individuals to the
devices and facilities to which they are giving access rights with a high degree of certainty. In
addition, they need to enforce access control policies (e.g., allow, deny, inquire further)
consistently, uniformly, and quickly across all of their resources. This project resulted from direct
dialogue among NCCoE staff and members of the electricity subsector, mainly from electric
power companies and those who provide equipment and/or services to them. The goal of this
project is to demonstrate a centralized, standards-based technical approach that unifies identity
and access management (IdAM) functions across operational technology (OT) networks,
physical access control systems (PACS), and information technology systems (IT). These
networks often operate independently, which can result in identity and access information
disparity, increased costs, inefficiencies, and loss of capacity and service delivery capability. This
guide describes our collaborative efforts with technology providers and electric company
stakeholders to address the security challenges energy providers face in the core function of
IdAM. It offers a technical approach to meeting the challenge, and also incorporates a business
value mind-set by identifying the strategic considerations involved in implementing new


http://172.16.33.88:9080/AlertEnterprise/
https://nistgov.sharepoint.com/sites/nccoe/Energy/Shared%20Documents/IdAM%20Practice%20Guide/Drafts/NIST_SP1800-2c_ES_IDAM-HowTo.docx
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technologies. This NIST Cybersecurity Practice Guide provides a modular, open, end-to-end
example solution that can be tailored and implemented by energy providers of varying sizes and
sophistication. It shows energy providers how we met the challenge using open source and
commercially available tools and technologies that are consistent with cybersecurity standards.
The use case scenario is based on a normal day-to-day business operational scenario that
provides the underlying impetus for the functionality presented in the guide. While the
reference solution was demonstrated with a certain suite of products, the guide does not
endorse these products in particular. Instead, it presents the characteristics and capabilities that
an organization’s security experts can use to identify similar standards-based products that can
be integrated quickly and cost-effectively with an energy provider’s existing tools and
infrastructure.

Cyber, physical, and operational security; cyber security; electricity subsector; energy sector;
identity and access management; information technology
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1.1 PRACTICE GUIDE STRUCTURE

This NIST Cybersecurity Practice Guide demonstrates a standards-based example solution and
provides users with the information they need to replicate this approach to identity and access
management (IdAM). The example solution is modular and can be deployed in whole or in
parts.

This guide contains three volumes:

o NIST SP 1800-2a: Executive Summary

e NIST SP 1800-2b: Approach, Architecture, and Security Characteristics — what we built
and why

e NIST SP 1800-2c: How To Guides — instructions - YOU ARE HERE

for building the example solution

The following instructions show IT professionals and security engineers how the National
Cybersecurity Center of Excellence (NCCoE) implemented example solutions to the challenge of
a centralized IdAM system. We developed two builds that conform to federal standards and best
practices, and address the challenge of providing a secure, centralized, uniform, and efficient
solution for managing authentication and authorization services, access control, and
provisioning across what are currently three independent and disparate corporate silos: IT,
operational technology (OT), and physical access control systems (PACS) networks.

This example solution is packaged as a “How To” guide. The guide demonstrates how to
implement standards-based, commercially available cybersecurity technologies in the real
world, based on risk analysis.

We cover all the products that we employed in this example solution. We do not recreate the
product manufacturer’s documentation, which is presumed to be widely available. Rather, these
guides show how we incorporated the products together in our environment.

These guides assume that the people using this document have experience implementing
information technology security products (including systems integration and administration of
networked Windows and Linux systems, firewalls, routers, etc.) in an electricity subsector
organization. While we have used the commercially available products described here, we
assume that you have the knowledge and expertise to choose other products that might better
fit your IT systems and business processes.” If you use substitute products, we hope you'll seek

! Certain commercial entities, equipment, or materials may be identified in this document in order to describe an
experimental procedure or concept adequately. Such identification is not intended to imply recommendation or
endorsement by NIST or NCCoE, nor is it intended to imply that the entities, materials, or equipment are

necessarily the best available for the purpose.
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products that are congruent with standards and best practices, as we have. Refer to NIST SP
1800-2b: Approach, Architecture, and Security Characteristics, Section 4.5, Table 2, for a list of
the products that we used, mapped to the cybersecurity controls provided by this example
solution, to understand the characteristics you should seek in alternate products. Section 4.4
Security Characteristics and Controls Mapping, of that document describes how we arrived at
this list of controls.

The security characteristics in our access management platform are informed by guidance and
best practices from standards organizations, including the North American Electric Reliability
Corporation’s (NERC) Critical Infrastructure Protection (CIP) standards. In addition, this
document was reviewed by the NERC ES-ISAC to ensure that the approach was informed by
standards and NERC regulations.

While we have used a suite of commercial products to address this challenge, this guide does
not endorse these particular products, nor does it guarantee regulatory compliance. Your
utility’s information security experts should identify the standards-based products that will best
integrate with your existing tools and IT system infrastructure. Your company can adopt this
solution or one that adheres to these guidelines in whole, or you can use this guide as a starting
point for tailoring and implementing parts of a solution. This NIST Cybersecurity Practice Guide
does not describe “the” solution, but a possible solution. This is a draft version. We are seeking
feedback on its contents and welcome your input. Comments and suggestions will improve
subsequent versions of this guide. Please contribute your thoughts to energy_nccoe@nist.gov,
and join the discussion at http://nccoe.nist.gov/forums/energy.

1.2 CONVENTIONS

Filenames, pathnames, partitions, URLs, and program names are in italic text:
filename.conf
.../folder/filename.conf
http.//nccoe.nist.gov

Commands and status codes are in Courier:
mkdir

Code that a user inputs is in Garamond bold:

service sshd start

NIST Cybersecurity Practice Guide SP 1800-2c
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The NCCoE constructed the IdAM build infrastructure using off-the-shelf hardware and
software. The infrastructure was built on Dell model PowerEdge R620 server hardware. The
server operating system was VMware vSphere virtualization operating environment. In addition,
a 6-terabyte Dell EquallLogic network attached storage (NAS) product was used for storage, Dell
model PowerConnect 7024 and Cisco Catalyst 3650 and 3550 physical switches were used to
interconnect the server hardware, external network components, and the NAS.

The lab network was accessible from the public Internet via a virtual private network (VPN)
appliance and firewall to enable secure Internet and remote access. The lab network was not
connected to the NIST enterprise network. Table 1 lists which software and hardware
components were used in the builds, the specific function each component contributes, and
whether the product was installed within the virtual environment or as physical device.

Product Vendor

Dell

Dell

Dell

VMware

Microsoft

Microsoft

Windows

Windows

Table 1. Build Implementation Component List (including security controls)

Component
PowerEdge R620
PowerConnect 7024
Equallogic

vSphere vCenter Server
version 5.5

Windows Server 2012
r2
Active Directory Server

Windows 7

Windows Server 2012
r2
DNS Server

SQL Server

NIST Cybersecurity Practice Guide SP 1800-2c

Function
Server hardware
Network switch

Network attached
storage

Virtual server and
workstation
environment

Authentication and
authority

Information
management

Domain name system

Database

Implementation
(physical device or
virtual environment)

Physical device
Physical device

Physical device

Virtual environment

Virtual environment

Virtual environment

Virtual environment

Virtual environment
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Product Vendor

AlertEnterprise

CA Technologies

Cisco

Cisco

Cisco

GlobalSign

Mount Airey
Group

Mount Airey
Group

Mount Airey
Group

Mount Airey
Group

RADiFlow

4 | NIST Cybersecurity Practice Guide SP 1800-2c

Component

Enterprise Guardian

Identity Manager
Rel 12.6.05 Build
06109.28

ISE Network Server
3415

Catalyst 3550

Catalyst 3650

SSL Certificate

Ozone Authority

Ozone Console

Ozone Envoy

Ozone Server

Industrial Service
Management Tool
(iSIm)

Function

Interface and translation
between IdAM central
store and the PACS
management server

Identity and access
automation
management
application, IdAM
provisioning

Network access
controller

Network switch

TrustSec-enabled
physical network switch

Cloud certificate and
registration authority

Central attribute
management system

Ozone administrative
management console

Enterprise identity store
interface

Ozone centralized
attribute based
authorization server

Supervisory control and
data acquisition (SCADA)
router management
application

Implementation
(physical device or
virtual environment)

Virtual environment

Virtual environment

Virtual environment

Physical device

Physical device

Virtual environment

Virtual environment

Virtual environment

Virtual environment

Virtual environment

Physical device
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Product Vendor

RADiFlow

RSA

RSA

TDi Technologies

RS2 Technologies

Schweitzer
Electronics
Laboratory

Schneider
Electric

XTEC

Component

SCADA Router
RF-3180S

Adaptive Directory
Version 7.1.5

IMG
Version 6.9
Build 74968

ConsoleWorks

AccessIT! Universal
Release 4.1.15

Physical access control
components

SEL-2411

Tofino Firewall model
number
TCSEFEA23F3F20

Xnode

2.1 BUILD IMPLEMENTATION OVERVIEW

Function

Router/firewall for
SCADA network

Central identity store,
IdAM provisioning

Central IdAM system
(workflow management)

User access controller,
monitor, and logging
system

Configures and monitors
the PACS devices (e.g.,
card readers, keypads)

Remote Terminal Unit
(RTU)

Ethernet/IP firewall

Remote access control
and management

Implementation
(physical device or
virtual environment)

Physical device

Virtual environment

Virtual environment

Virtual environment

Virtual environment
server and physical
device card reader

Physical device

Physical device

Physical device

The build implementation consists of multiple networks implemented to mirror the
infrastructure of a typical energy industry corporation. The networks include a management
network and a production network, Figure 1. The management network was implemented to
facilitate the implementation, configuration, and management of the underlying infrastructure,
including the physical servers, vSphere infrastructure, and monitoring. The production network,

Figure 1, consists of

e the demilitarized zone (DMZ)
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e Identity and Access Management - IdAM

e [T - business management system

e OT - ICS/SCADA industrial control system and energy management system (EMS)
e PACS — physical access control system networks

These networks were implemented separately to match a typical electric utility enterprise
infrastructure. Firewalls are configured to route traffic and limit access among the production
networks to block all traffic except required inter-network communications. The primary inter-
network communications are the user access and authorization updates from the central IdAM
systems to and from the directories and PACS, IT, and OT networks. The DMZ provides a
protected neutral network space that the other networks of the production network can use to
route traffic to and from the Internet or each other.

NIST Cybersecurity Practice Guide SP 1800-2c



97
98

99

DRAFT

Figure 1. Management and production networks
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Figure 2. IdAM build implementation production network

The IdAM network represents the proposed centralized/converged IdAM network/system. This
network was separated to highlight the unique IdAM components proposed to address the use
case requirements.

The IT network represents the business management network that typically supports corporate
email, file sharing, printing, and Internet access for general business-purpose computing and
communications.

The OT network represents the network used to support the energy management systems
(EMS)s and industrial control systems (ICS)/supervisory control and data acquisition (SCADA)
systems. Typically, this network is either not connected to the enterprise IT network or is
connected with a data diode (a one-way communication device from the OT network to the IT
network). Two-way traffic is allowed per NERC-CIP and is enabled via the OT firewall only for
specific ports and protocols between specific systems identified by IP address.

The PACS network represents the network used to support the physical access control systems
across the enterprise. Typically, this network uses the enterprise IT network and is segmented
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from the user networks via virtual local area networks (VLANSs). In our architecture, a firewall is
configured to allow limited access to and from the PACS network to facilitate the
communication of access and authorization information. Technically, this communication
consists of user role and responsibility directory updates originating in the IdJAM system.

The public Internet is accessible by the lab environment to facilitate both cloud services and
access for vendors and NCCoE administrators.

The VPN firewall was the access control point for vendors to support the installation and
configuration of their components of the architecture. The NCCoE also used this access to
facilitate product training. This firewall also blocked unauthorized traffic from the public
Internet to the production networks. Additional firewalls are used to secure the multiple
domain networks (IT, OT, IdAM, and PACS) explained below.

Switching in the implementation is executed using a series of physical and hypervisor soft
switches. VLAN switching functions are handled by physical Dell switches and the virtual
environment. Routing was accomplished using the firewalls.

2.2  BUILD IMPLEMENTATION DESCRIPTIONS

Figure 3 depicts the build network comprising the management, VendorNet, IdAM, DMZ, IT, OT,
and PACS subnetworks. VendorNet provides remote access for vendors to access, configure,
demonstrate, and provide training for each of the implemented products. The IdAM network
contains the central IJAM components of the build (described below). The IT, OT, and PACS
networks contain the representative components of a typical electric utility enterprise, as
described below.
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137

138
139

140 Figure 3. Build Network

141  The IdAM network (Figure 4 and Figure 5) contains the central IdJAM components for Build #1
142 and Build #2. The IdAM components are placed into a separate network to highlight the
143  importance of protecting these assets and to simplify the demonstration of their capabilities.

NIST Cybersecurity Practice Guide SP 1800-2c



DRAFT

144

145 Figure 4. Build #1 IdAM Network

146  Build #1 uses the CA Identity Manager product for the IdAM system and identity store.
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147

148 Figure 5. Build #2 IdAM Network
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Build #2 uses the RSA IMG and Adaptive Directory products for the IdAM system and identity
store.

The IT network (Figure 6) contains the components common in the business operations IT
networks/systems in all organizations.

Figure 6. IT Network

The OT network (Figure 7) contains the OT components, which include representative
components found in electric utility OT networks/systems. These components were chosen to
demonstrate the integration capabilities of the central IdJAM capability. The lab did not attempt
to replicate a fully operational OT network or set of systems. Because we had a limited number
of remote terminal units (RTUs) available, we used Raspberry Pi on the network to emulate an
RTU.
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161

162 Figure 7 OT Network
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163  The PACS network (Figure 8) contains the PACS components, which include representative
164  components found in electric utility physical access control systems. These components were
165 chosen to demonstrate the integration capabilities of the central IdAM capability.

166

167 Figure 8 PACS Network
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168 2.3

169 Table 2 includes the IP address assignments used for the builds.

IP NETWORK ADDRESS ASSIGNMENTS

170 Table 2 Build IP Address Assignments
DMz System Vendor Access System IdAM Mgmt System
Network IP Network IP Network IP
10.32.2.0/25 | Subnet 10.32.2.128/25 | Subnet 172.16.4.0/24 | Subnet
10.32.2.1 NCCoE 10.32.2.129 NCCoE 172.16.4.1 IdAM FW
FW/Gateway FW/Gateway LAN
10.32.2.10 Vcenter 10.32.2.130 Vendor AD 172.16.4.2 RSA IMG
10.32.2.11 ESXi #1 10.32.2.131 Vendor RDS §172.16.4.3 RSA
Adaptive
Directory
10.32.2.12 ESXi #2 10.32.2.132 RSA/SCE 172.16.4.5 AlertEnter
prise
10.32.2.22 Border FW 10.32.2.133 AlertEnt 172.16.4.9 Ozone
WAN Console
10.32.2.50 RS1 FTP 10.32.2.134 CA 172.16.4.10 Ozone
Synology Server
10.32.2.X Veam Backup J 10.32.2.135 RADiFlow 172.16.4.11 Ozone
Server Authority
10.32.2.136 MAG 172.16.4.12 Ozone
Envoy
10.32.2.137 TDi 172.16.4.13 Ozone PPA
10.32.2.232 Border FW 172.16.4.15 CA IM
OPT1
172.16.4.22 Microsoft
sQL
172.16.4.253 CentOS
DNS
171
172
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173 Table 2. (cont.) Build IP Address Assignments
IT Network System PAC Network System OT Network System
IP IP IP
172.16.5.0/ subnet 172.16.7.0/25 Subnet 172.16.6.0/25 Subnet
24
172.16.5.1 IT FW LAN 172.16.7.1 PACS FW 172.16.6.1 OT FW LAN
LAN
172.16.5.2 IT AD, DNS, 172.16.7.2 PACS AD, 172.16.6.2 OT AD, DNS,
CA DNS, CA CA
172.16.5.6 | Workstation 172.16.7.5 n/a 172.16.6.4 RADiFlow
FW/SW
172.16.5.7 | Workstation 172.16.7.6 | XTEC XNode 172.16.6.5 Schneider
Firewall
172.16.7.11 PACS 172.16.6.6 Workstation
Console
172.16.7.15 PACS 172.16.6.8 TDi
Workstation ConsoleWorks
172.16.7.101 LAB Door 172.16.6.100 RADiFlow
Controller Terminal
Server for SEL
172.16.6.202 RADiFlow
Vendor Host
174
175
176 3.1 OPERATING SYSTEMS
177  All machines used in the build had one of the following operating systems (OS) installed:
178 e Windows 7 enterprise
179 e Windows server 2008 R2
180 e Windows server 2012 R2
181 e MicroFocus SUSE Linux Enterprise Server 11
182 e (CentOS7.
183 3.1.1 Windows Installation and Hardening Details
184  The NCCoE Windows OS images are derived from the Department of Defense (DoD) Security
185  Technical Implementation Guide (STIG) images. The Windows systems were installed using
186 installation files provided by the Defense Information Systems Agency (DISA). These images
187  were chosen because they are standardized, hardened, and fully documented. The STIG
188  guidelines are available on-line at http://iase.disa.mil/stigs/os/Pages/index.aspx.
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Modifications to the STIG compliant OS configurations were required for each product to enable
its operation. The compliance results in Section 17 identify the specific OS configuration
modifications (noncompliant configuration items) needed in each case.

3.1.2  SUSE Linux Enterprise Server 11 Installation and Hardening Details

The SUSE OS was included as part of the virtual appliance image provided by RSA for the IMG
product. The center did not make any OS configuration changes. The OS was not configured to
meet the DoD CentOS 6 STIG. The STIG guidelines are available on-line at
http://iase.disa.mil/stigs/os/Pages/index.aspx. The OS configurations for SUSE Linux
implementation are listed in Section 17. The compliance results report for SUSE Linux is
included for illustration purposes, Section 20.2.

3.1.3 Base Linux Installation and Hardening Details

The NCCoE base Linux OS used in the build is CentOS 7. This OS is available as an open source
image. The OS was configured to meet the DoD CentOS 6 STIG, because no CentOS 7 STIG was
available at the time the build was implemented. The STIG guidelines are available on-line at
http://iase.disa.mil/stigs/os/Pages/index.aspx. The OS configurations for each Linux
implementation are listed in section 17. The compliance results reports identify the
configuration items that do not conform to the STIG configuration guide.

3.2 FIREWALL CONFIGURATIONS

The firewalls were deployed to minimize the allowed traffic among the silo networks as well as
to minimize traffic received from the DMZ and the public Internet. The goal was to limit the
cross-network traffic/connections to only those required to support the use case.

The following firewall configurations include the rules that were implemented in each of the
firewalls for the build implementation. These configurations are provided to enable the reader
to reproduce the traffic filtering/blocking that was achieved in the build implementation.
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Table 3. Border Firewall Rules

Aliases

Name Values Description

Virtuallnfra 10.32.2.10-12 Virtualization Systems for Build

VPNserver 172.16.7.253 VPN Server

WAN Interface

Allow/Deny Protocol Source Port Destination Port | Description

Allow IPv4 — All 10.32.2.0/25 Any Any Any Allow all management
network traffic

Allow IPv4 — All 10.255.2.0/25 Any Any Any Center VPN to all
systems

Allow IPv4 — TCP Any Any WAN Address 80 Allow access to
WebGUI pfSense

Allow IPv4 —TCP 10.255.2.0/25 Any 172.16.4.8 5176 | Center VPN to
Consoleworks

Allow IPv4 — TCP 10.255.2.0/25 Any 172.16.4.8 443 Center VPN to
Consoleworks HTTPS

Deny IPv4 — TCP Any Any WAN Address Any Block All access to
pfSense

Allow IPv4 — TCP Any Any 172.16.7.110 3389 | RDP to Lab-PCon
PACS (Backups)
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Table 4. Border Firewall Rules (continued)

LAN Interface

Allow/Deny Protocol Source Port Destination | Port | Description

Allow IPv4 — All 172.16.7.135 Any Virtuallnfra | Any | Lab laptop to
Virtualization

Deny IPv4 — All Any Any Virtuallnfra | Any | Block all to
Virtualization

Deny IPv4 — TCP 172.16.8.0/24 Any 10.32.2.0/25 | Any | Block Vendor VPN from
Management

Deny IPv4 —TCP 10.32.2.128/25 | Any 10.32.2.0/25 | Any | Block Vendor VPN from
Management

Allow IPv4 — All LAN Net Any Any Any | Default Allow Any LAN

Allow IPv6 — All LAN Net Any Any Any | Default Allow Any LAN

Allow IPv4 —TCP 172.16.7.128/25 | Any 10.32.2.117 | 3389 | RDP to 117

Allow IPv4 — UDP 172.16.7.128/25 | Any 10.32.2.117 | 3389 | RDP to 117

Deny IPv4 — All Any Any Any Any | Block IPv4

Deny IPv6 — All Any Any Any Any | Block IPv6
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Table 5. IdAM Firewall Rules

Aliases

Name Values Description

AD_DCs_All | 172.16.{5,6,7},2 All DCs in

Infrastructure
LinuxSystems | 172.16.4.{2,3,8,1 Used for SSH
0,11,12,253}
MAG_Linux | 172.16.4.{10,11, Systems for MAG
12}
WAN Interface

Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All 10.32.2.0/25 | Any Any Any Allow all management network traffic
Allow IPv4 — All 10.255.2.0/25 | Any Any Any Center VPN to all systems
Allow IPv4 — TCP 172.16.7.133 | Any Any Any IT to IdAm
Allow IPv4 — TCP Any Any LinuxSystems IMG Allow SSH to Linux
Allow IPv4 — All Any Any 172.16.4.8 161,162,514 Allow SNMP, Syslog, default to TDi

,5176
Allow IPv4 — All AD_DCs_All Any 172.16.4.15 Any AD DCs to IdAM-CA
Allow IPv4 — All 172.16.8.50 Any | 172.16.4.15,22 Any CA to CA_srvl2, CA_SQL srv12
Allow IPv4 — TCP Any Any 172.16.4.2 5900-5910 VNC to IMG
Allow IPv4 — TCP 172.16.7.2 Any 172.16.4.2 Any PACS AD to IMG
Allow IPv4 — TCP 172.16.7.2 Any 172.16.4.3 Any PACS AD to Adaptive Directory
Allow IPv4 — TCP 10.32.2.0/25 Any 172.16.4.8 517, 6443 MGMT to TDi Consoleworks
LAN Interface

Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All LAN Net Any Any Any Default Allow Any LAN
Allow IPv6 — All LAN Net Any Any Any Default Allow Any LAN

Table 6. IT Firewall Rules
Aliases
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Name Values Description
Alert_Enterprise 172.16.4.5 AlertEnterprise
CA 172.16.4.15 CA
CA_RSA _Alert | 172.16.4.{2,3,5,15}, | CA, RSA, Alert
172.16.7.132
ConsoleWorks 172.15.4.8 Console Works
IT_Network 172.16.7.132 IT network
LinuxSystems 172.16.5.4 All Linux on IT
Ozone 172.16.4.10-12 Ozone products
RSA 172.16.4.2-3 IMG, Adaptive
Dir
WAN Interface
Allow/Deny Protocol Source Port | Destination Port Description
Allow IPv4 — All 10.32.2.0/25 Any Any Any Allow all management network traffic
Allow IPv4 — TCP 172.16.7.132 Any Any Any I[dAM to IT
Allow IPv4 — TCP Any Any | LinuxSystems 22 Allow SSH to Linux
Allow IPv4 — All Any Any 172.16.5.2 53 Allow DNS
Allow IPv4 — TCP IT_Network Any 172.16.5.4 25443 Alert to ITEMAIL
Allow IPv4 — TCP ConsoleWorks Any LAN net 22,161-162 TDI to IT-Net
Allow IPv4 — TCP CA_RSA_Alert Any 172.16.5.2 389, 636 LDAP/LDAPS to AD
LAN Interface
Allow/Deny Protocol Source Port | Destination Port Description
Allow IPv4 — All LAN Net Any Any Any Default Allow Any LAN
Allow IPv6 — All LAN Net Any Any Any Default Allow Any LAN
Table 7. OT Firewall Rules
Aliases
Name Values Description
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LinuxSystems 172.16.6.7 All Linux on OT
RADiFlow 172.16.6.{4,6,202} | All RADiFlow IPs
WAN Interface

Allow/Deny Protocol Source Port Destination Port Description

Allow IPv4 — All 10.32.2.0/25 Any Any Any Allow all management network
traffic
Allow IPv4 — TCP Any Any 172.16.6.10 22 SSH to RPi RTU
Allow IPv4 — TCP Any Any LinuxSystems 22 Allow SSH to Linux
Allow IPv4 — All Any Any 172.16.6.2 53 Allow DNS
Allow IPv4 — All 172.16.4.8 Any LAN net 22,161- TDI to OT-Net
162
Allow IPv4 —TCP Any Any 172.16.6.2 389, 636 Any LDAP to AD
Allow IPv4 — TCP 172.16.4.{2,3,15} | Any 172.16.6.2 Any AdaptiveDir, IMG, CA IM to AD
Allow IPv4 — TCP Any Any 172.16.6.100 2001- Telnet Access through RADiFlow
2101
LAN Interface

Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All LAN Net Any Any Any Default Allow Any LAN
Allow IPv6 — All LAN Net Any Any Any Default Allow Any LAN

221
222
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Table 8. PACS Firewall Rules

Aliases
Name Values Description
Virtuallnfra 10.32.2.10-12 Virtualization Systems
for Build
WAN Interface
Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All 10.32.2.0/25 Any Any Any Allow all management network
traffic
Allow IPv4 — All 172.16.7.132 Any | 172.16.7.{2,11} Any IdAM to PACS-Console, PACSDC
Allow IPv4 — TCP Any Any 172.16.7.2 389, 636 Any LDAP to AD
Allow IPv4 — All Any Any 172.16.7.2 53 Allow DNS
Allow IPv4 — All 172.16.4.8 Any LAN net 22,161- TDI to PACS-Net
162
Allow IPv4 — TCP 172.16.4.{2,3,15} | Any 172.16.7.2 Any AdaptiveDir, IMG, CA IM to AD
Allow IPv4 — TCP Any Any | 172.16.7.110 3389 MRDP Nat to LAB Machine PACS
LAN Interface
Allow/Deny Protocol Source Port Destination Port Description
Allow IPv4 — All LAN Net Any Any Any Default Allow Any LAN
Allow IPv6 — All LAN Net Any Any Any Default Allow Any LAN
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225 3.3 NETWORK SERVICES

226  Microsoft Active Directory was used to provide directory services in each silo networks (OT,
227  PACS, IT). Linux CentOS 7 was used to provide DNS services in the IdAM network. Microsoft
228  Windows Server was used to provide certificate authority services in each network.

229 3.3.1 IT Network — Network Services (AD and Certificate Authority) Installation and Configuration Settings
230 3.3.1.1 Active Directory

231  Use these basic domain controller configuration settings:

232 e Hostname: ITDC
233 e Domain: ES-IDAM-B1.TEST
234 e |P:172.16.5.2

235  Step-by-step instructions:

236 1. Launch Server Manager.

237 2. From the dashboard, select Option 2, Add Roles and Features.

238 3. Select Role-based or Feature-based installation.

239 4. From the server pool, select the local server named ITDC.

240 5. Select Active Directory Domain Service and DNS Server.

241 6. When prompted to add features, select Add Features for each role.

242 7. Wait for Server Manager to finishes installing,

243 8. Select Post-Deployment Configuration for Active Directory from the Task menu.

244 9. After Active Directory Domain Services Configuration Wizard automatically launches.
245 e Select Add a New Forest deployment operation.

246 e Specify ES-IDAM-B1.TEST root domain, then select Next >.

247 e Select Windows Server 2012 R2 for both the Forest Functional Level and the
248 Domain Functional Level,

249 e Under Domain Controller Capabilities:

250 o Check both DNS server and Global Catalog.

251 o Uncheck read-only domain controller.

252 o Specify a password for DSRM and select Next >.

253 e Continue through the Wizard without modifying any options.

254 e Select Install on the next window. After installation, the server automatically
255 reboots.

256  3.3.1.2 Certificate Authority Role
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e Use these basic certificate authority configuration settings: CA Setup Type:
Enterprise CA

e CAType: Root CA

e Cryptographic options: RSA 2048 and SHA1
e CN:IT-ES-IDAM-B1-IDAM-ITDC

e DN suffix: DC=IT-ES-IDAM-B1, DC=TEST

Step-by-step instructions:

From the Server Manager dashboard, select Option 2, Add Roles and Features.

Select Role-based or Feature-based installation (this is a single option to choose).

From the server pool, select the local server named OTDC.

When prompted to add features, select Add Features.

1.

2.

3

4. Select Active Directory Certificate Services.

5

6. When prompted to select roles services, check Certificate Authority.
7

After the Server Manager finishes installing, select Post-deployment Configuration for

Certificate Services from the Task menu.
8. When prompted to specify setup type, select Enterprise CA.
9. When prompted to specify CA type, select Root CA.

10. When prompted to specify private key, select Create a new private key.

11. When prompted to specify cryptographic options, select RSA with a key length of 2048

and select SHA1 for the hash algorithm.

12. Leave the CN and DN suffix, which should be based on the computers hostname and

domain.
13. Select 5 years for certificate validity period.
14. Leave the default options for the certificate database and log location.

15. After configuration is complete, restart the server.

3.3.2  OT Network — Network Services (AD, DNS Server, and Certificate Authority) Installation and
Configuration Settings

3.3.2.1 Active Directory Domain Services and DNS Server

e Use these basic certificate authority configuration settings:Hostname: OTDC
e Domain: OT-ES-IDAM-B1.TEST
e [P:172.16.6.2

Step-by-step instructions:

1. Launch Server Manager.
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N o u kW N

From the dashboard, select Option 2, Add Roles and Features.
Select Role-based or Feature-based installation.

From the server pool, select the local server named OTDC.
Select Active Directory Domain Service and DNS Server.

When prompted to add features, select Add Features for each role.

After the Server Manager finishes installing, select Post-deployment Configuration for

Active Directory from the Task menu.
The Active Directory Domain Services Configuration Wizard launches:
e Forthe deployment operation, select Add a New Forest.

e For the root domain, specify OT-ES-IDAM-B1.TEST, then select Next >.

e For both the Forest Functional Level and the Domain Functional Level, select

Windows Server 2012 R2.
e Under Domain Controller Capabilities:
o Check both DNS server and Global Catalog.
o Uncheck read-only domain controller.
o Specify a password for DSRM and select Next >.

e Continue through the wizard without modifying any options.

On the last page, select Install. After installation, the server automatically
reboots.

3.3.2.2 Certificate Authority Role

Use these basic certificate authority configuration settings:CA Setup Type:
Enterprise CA

CA Type: Root CA

Cryptographic options: RSA 2048 and SHA1
CN: OT-ES-IDAM-B1-IDAM-QOTDC

DN suffix: DC=0T-ES-IDAM-B1, DC=TEST

Step-by-step instructions:

1.
2
3
4.
5
6

Ensure the domain controller installation has been completed before proceeding.
From the Server Manager dashboard, select Option 2, Add Roles and Features.
Select Role-based or Feature-based installation (this is a single option to choose)
From the server pool, select the local server named OTDC.

Select Active Directory Certificate Services.

When prompted to add features, select Add Features.
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9.

10.

11

13.

14.
15.
16.

333

When prompted to select roles services, check Certificate Authority.

After the Server Manager finishes installing, select Post-deployment Configuration for
Certificate Services from the Task menu.

When prompted to specify setup type, select Enterprise CA.
When prompted to specify CA type, select Root CA.

. When prompted to specify a private key, select Create a new private key.

12.

When prompted to specify cryptographic options, select RSA with a key length of 2048
and select SHA1 for the hash algorithm.

Leave the CN and DN suffix, which should be based on the computer’s hostname and
domain.

Select 5 years for certificate validity period.
Leave the default options for the certificate database and log location.

After configuration is complete, restart the server.

PACS Network — Network Services: AD, DNS Server, and Certificate Authority Installation and
Configuration Setting

3.3.3.1 Active Directory Domain Services and DNS Server

Use these basic domain controller configuration settings:

e Hostname: PACSDC
e Domain: PACS-ES-IDAM-B1.TEST
e |P:172.16.7.2

Step-by-step instructions:

1.
2.
3.

4
5.
6
7

Launch Server Manager.

From the dashboard, select Option 2, Add Roles and Features.

Select Role-based or Feature-based installation (this is a single option to choose).
From the server pools, select the local server named PACSDC.

Select Active Directory Domain Service and DNS Server.

When prompted to add features, select Add Features for each role.

After the Server Manager finishes installing, select Post-deployment Configuration for
Active Directory from the Task menu.

The Active Directory Domain Services Configuration Wizard launches:

e Select Add a new forest for the deployment operation. Specify PACS-ES-IDAM-
B1.TEST for the root domain, then select Next.
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3.3.3.2

e Select Windows Server 2012 R2 for both the forest functional level and the
domain functional level.

e Under domain controller capabilities:
o Check both DNS server and Global Catalog.
o Uncheck read-only domain controller.
o Specify a password for DSRM and select Next >.

e Continue through the Wizard without modifying any options.

On the last page, select Install. After installation, the server automatically
reboots.

Installation of Certificate Authority Role on the PACS network

Use these basic domain controller configuration settings:

CA Setup Type: Enterprise CA

CA Type: Root CA

Cryptographic options: RSA 2048 and SHA1
CN: PACS-ES-IDAM-B1-IDAM-PACSDC

DN suffix: DC=PACS-ES-IDAM-B1, DC=TEST

Step-by-step instructions:

N o u kr w N

0o

10.
11.

12.

13.

From the Server Manager dashboard, select the Option 2, Add Roles and Features.
Select Role-based or Feature-based installation.

From the server pools, select the local server named OTDC.

Select Active Directory Certificate Services.

When prompted to add features, select Add Features.

When prompted to select roles services, check Certificate Authority.

After the Server Manager finishes installing, select Post-deployment Configuration for
Certificate Services from the Task menu.

When prompted to specify setup type, select Enterprise CA.
When prompted to specify CA type, select Root CA.
When prompted to specify private key, select Create a new private key.

When prompted to specify cryptographic options, select RSA with a key length of 2048
and select SHA1 for the hash algorithm.

Leave the CN and DN suffix, which should be based on the computer’s hostname and
domain.

Select 5 years for certificate validity period.

NIST Cybersecurity Practice Guide SP 1800-2c



388
389

390
391

392

393
394
395
396
397
398
399
400
401

402

403
404
405
406
407
408

409
410

411
412
413
414
415
416
417
418
419
420

DRAFT

14. Leave the default options for the certificate database and log location.
15. After configuration is complete, restart the server.

3.3.3.3 Modify the AD Lightweight Directory Access Protocol (LDAP) schema with custom PACS
attributes.

Custom attribute details:

e Common Name: pacsAllDoors

e X.5000ID:1.3.6.1.4.1.4203.666.1
e Syntax: Boolean

e Common Name: pacsHomeAccess

e X.5000ID:1.3.6.1.4.1.4203.666.2
e Syntax: Boolean

e Common Name: pacsWorkAccess

e X.5000ID:1.3.6.1.4.1.4203.666.3
e Syntax: Boolean

Step-by-step instructions:

1. Launch Command Prompt as an administrator.
2. Runthe command: regsvr32 schmgmt.dll

3. Launch the Microsoft Management Console.

4. Select File > Add/Remove Snap-in.

5. From the Snap-in menu, select Active Directory Schema, then select OK.

6. Expand the Active Directory Schema, then select Attributes.

7. To create an attribute for the all doors access level, right-click on Attributes, then select
Create Attribute.

8. Select OK when prompted with the Schema Object Creation Warning.

9. Enter the following fields:
e Common Name: pacsAllDoors
e LDAP Display Name: pacsAllDoors
e Unique X500 ObjectID:1.3.6.1.4.1.4203.666.1
e Syntax: Boolean
10. Select OK when finished.
11. Create an attribute for the home access level by entering the following fields:
e Common Name: pacsHomeAccess

e LDAP Display Name: pacsHomeAccess
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e Unigue X500 ObjectID:1.3.6.1.4.1.4203.666.2
e Syntax: Boolean
12. Create an attribute for the work access level by entering the following fields:
e Common Name: pacsWorkAccess
e LDAP Display Name: pacsWorkAccess
e Unigue X500 ObjectID:1.3.6.1.4.1.4203.666.3
e Syntax: Boolean

13. After creating custom attributes, add the attributes to the user class so that every user
contains the attribute:

e Select the Classes drop-down under Active Directory Schema.
e Right-click on User, then select Properties.
e Select the Attributes tab, then select Add.

e Select the attribute you want to add to the user class. Then select OK. Do this for
the pacsAllDoors, pacsHomeAccess and pacsWorkAccess attributes.

e Then select Apply and OK.

e Restart the server.

3.3.4 |dAM Network — Network Services (DNS Server) Installation and Configuration Settings
A Linux CentOS 7 DNS server was established on the IdAM network to provide DNS services to
the IdAM components. No other network service was installed in the IdAM network.

System Environment Settings

e (CentOS7

e VM with 4 CPU Quad Core 2.199GHz.

e VM with 16384MB of memory.

e Virtual Hard Disk containing 98GB of storage.

Linux CentOS DNS Configuration

Basic DNS configuration settings are specified using three different system files that are located
in the /etc and /var subdirectories of the root directory as follows.

3.3.4.1 System file 1 — named.conf in the /etc subdirectory

//

// named.conf

//
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// Provided by Red Hat bind package to configure the ISC BIND named(8) DNS
// server as a caching only nameserver (as a localhost DNS resolver only).

//

// See /ust/share/doc/bind*/sample/ for example named configuration files.

//

options {
listen-on port 53 { 127.0.0.1; 172.16.4.253; };
#listen-on-v6 port 53 { ::1; };
#listen-on-v6 { none; };
directory " /var/named";
forwarders  { 8.8.8.8; 8.8.4.4; };
dump-file " /var/named/data/cache_dump.db';
statistics-file "' /var/named/data/named_stats.txt";
memstatistics-file " /var/named/data/named_mem_stats.txt";
allow-query { localhost; 172.16.4.0/22; };
allow-transfer { localhost; 172.16.4.0/22; };

/*
- If you are building an AUTHORITATIVE DNS server, do NOT enable
recursion.

- If you are building a RECURSIVE (caching) DNS server, you need to
enable

recursion.

- If your recursive DNS server has a public IP address, you MUST enable
access

control to limit queries to your legitimate users. Failing to do so will
cause your server to become part of large scale DNS amplification
attacks. Implementing BCP38 within your network would greatly
reduce such attack surface

*/

recursion yes;

dnssec-enable yes;
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};

dnssec-validation yes;

dnssec-lookaside auto;

/* Path to ISC DLV key */
bindkeys-file " /etc/named.iscdlv.key';

managed-keys-directory " /var/named/dynamic";

pid-file "' /run/named/named.pid";

session-keyfile "' /run/named/session.key";

logging {
channel default_debug {

file "data/named.run";

severity dynamic;

b5
b5
zone "." IN {
type hint;
file "named.ca'";
b5

zone "idam-es-idam-b1.test" IN {
type mastet;

file "idam-es-idam-b1.test";
allow-update { none; } ;

};

zone "4.16.172.in-addr.arpa" IN {
type master;
file "'4.16.172.db"";

allow-update { none; };
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};

zone "ot-es-idam-bl.test" IN {

type slave;

masters {

172.16.6.2;
¥

forwarders {};

};

zone "'pacs-es-idam-bl.test" IN {

type slave;

masters {
172.16.7.2;
};

forwarders {};

};

zone "es-idam-bl.test" IN {

type slave;

masters {

172.16.5.2;
¥

forwarders {};

};

include " /etc/named.rfc1912.zones";

include " /etc/named.root.key";

$TTL 86400

@ IN SOA idam-dns.idam-es-idam-bl.test.

2011071001 ;Serial
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552 3600 ;Refresh

553 1800  ;Retry

554 604800 ;Expire

555 86400 ;Minimum TTL

556 )

557 @ IN NS idam-dns.idam-es-idam-b1.test.

558 @ IN PTR idam-es-idam-b1.test.

559 idam-dns INA 172.16.4.253

560

561

562 101 IN PTR idam-dns.idam-es-idam-bl.test.
563 System file — idam-es-idam-bl.test in the /etc subdirectory
564

565 $TTL 86400

566 @ IN SOA idam-dns.idam-es-idam-bl.test. root.idam-es-idam-b1.test. (
567 2011071001 ;Serial

568 3600 ;Refresh

569 1800  ;Retry

570 604800 ;Expire

571 86400 ;Minimum TTL

572 )

573

574 @ IN NS idam-dns.idam-es-idam-b1.test.
575 @ IN A 172.16.4.253

576 idam-dns IN A 172.16.4.253

577 idam-ca IN A 172.16.4.15

578 idam-sql IN A 172.16.4.22

579 adaptivedir IN A 172.16.4.3

580 img IN A 172.16.4.2

581 consoleworks IN A 172.16.4.8

582 ozoneserver IN A 172.16.4.10

583 ozoneenvoy  IN A 172.16.4.12

584 ozoneauthority IN A 172.16.4.11

585 alertentIN A 172.16.4.5

586 WIN-IPERGL2ELUD IN A 172.16.4.5
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Remote terminal units (RTU) provide the cyberspace to physical interface. Remote terminal
units are used to collect data such as voltage, current and phase from substation equipment.
They are also used to deliver commands via contact closures or output voltage to change device
operations such as switches, circuit breakers or capacitors.

4.1 TCP/IPRTU

The TCP/IP RTU in this build is emulated with a RaspberryPi 2 system. The system was
developed to simulate a Modbus protocol programmable logic controller (PLC).

4.2 SERIALRTU

The serial RTU in this build is a Schweitzer Engineering Laboratory SEL-2411 programmable
automation controller configured to support the Modbus protocol. It is connected to the
RADiFlow ICS Firewall via serial interface.

Cisco Identity Services Engine (ISE) controls the ability of devices to connect over the network.
ISE expands on basic network address-based control to include the identity of the person using
a device. ISE is used in the builds to provide a gateway function between IT and OT, limiting
which users and devices are allowed to connect from IT to resources in OT.

The Cisco ISE component should be installed in a virtual machine (VM) on the IT network. This
ISE component will be used in conjunction with the TrustSec switch that is located on the IT
network to control access from the IT network to the OT network.

5.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Category: PR.PT-3: Access to systems and assets is controlled,
incorporating the principle of least functionality

NIST 800-53 rev 4 Security Controls: AC-3, CM-7

5.2  PRE-INSTALLATION TASK

1. Obtain OVA file from Cisco for Cisco ISE 1.4.

2. Place OVA file in Datastore for vSphere installation.

3. Ensure that the user domain has a security group (the build used OTAccess) for
determining access to the OT network.
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INSTALL AND CONFIGURE

Follow the guide located at: http://www.cisco.com/c/en/us/td/docs/security/ise/1-
4/installation quide/b ise InstallationGuidel4/b ise InstallationGuidel4 chapter 010
0.html
e This is the Cisco ldentity Services Engine Hardware Installation Guide, Release
1.4, section on Installing ISE on a VMware Virtual Machine.
o To deploy the OVA file, follow the instructions at the heading “Installing Cisco ISE
on Virtual Machines.”
e After OVA is deployed, follow instructions at heading “Installing Cisco ISE
Software on a VMware System.”
After the system is installed, type setup at the prompt.
The following are prompts and build responses:
Enter hostname: ise
Enter IP address[]: 172.16.4.77
Enter IP netmask[]: 255.255.255.0
Enter IP default gateway[]: 172.16.4.1
Enter default DNS domain[]: idam-es-idam-bl.test
Enter primary nameserver[]: 172.16.4.253
Add secondary nameserver? Y/N[N]: <blank>
Enter NTP server[time.nist.gov]: 172.16.4.1
Add another NTP server? Y/N[N]: <blank>
Enter system time zone[UTC]: EST
Enable SSH service? Y/N [N]: Y
Enter username [admin]: admin
Enter password: <password>

Enter password again: <password>

After ISE finishes the installation, connect to ISE through the web browser using the IP
address specified during the setup phase.

Begin the Setup Assistant.

Select Wired for setup access services, and select the Enforce radio button. For subnets
to protect, type the target network (in build, the OT network: 172.16.6.0/24). Press
Next.

Uncheck Cisco Unified IP Phone box

Select AD group : es-idam-bl.test/Builtin/Users

Leave the default checked boxes as is.

Select Yes for authenticate users using Cisco ISE, select Join the Active Directory domain,
and add domain credentials (in build, we used es-idam-b1l. test for domain and the
domain admin credentials to connect). Fill in the Employee Switched VLAN Interface box
with: 172.16.5.0 /24. Press Next.
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9. Select switch (build used Cisco Catalyst 3560 Series Switches), fill in pertinent

information for switch. For Employee VLAN ID, build used 104. Select a RADIUS Shared
Secret (build used password). Press Next.

10. Confirm all settings are correct, then select Confirm Configuration Settings.

TrustSec switch configuration information: Taken from the Network Device Configuration tab in
the Setup Assistant Review section, the recommended configurations to be set globally on the
TrustSec-enabled switch are as follows:

aaa
|
aaa
aaa
aaa
aaa
aaa
aaa
aaa
aaa

new-model

authentication dotlx default group radius
authorization network default group radius
authorization auth-proxy default group radius
accounting delay-start all

accounting auth-proxy default start-stop group radius
accounting dotlx default start-stop group radius
accounting network default start-stop group radius

server radius dynamic-author

client 172.16.4.77 server-key 7 15020A1F173D24362C

aaa

session-id common

switch 1 provision ws-c3650-48ps

authentication mac-move permit

ip routing

ip device tracking

ip dhcp snooping vlan 102

no ip dhcp snooping information option

ip dhcp snooping

dotlx system-auth-control

!

diagnostic bootup level minimal

spanning-tree mode pvst

spanning-tree extend system-id

!

redundancy

mode Sso

!

ip ssh version 2
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class-map match-any non-client-nrt-class
match non-client-nrt

!
policy-map port child policy

class non-client-nrt-class

bandwidth remaining ratio 10

snmp trap mac-notification change added
spanning-tree portfast

!

ip access-list extended ACL-DEFAULT
remark Allow DHCP

permit udp any eq bootpc any eq bootps
remark Allow DNS

permit udp any any eq domain

permit icmp any any

permit tcp any host 172.16.4.77 eq 8443
permit tcp any host 172.16.4.77 eq 443
permit tcp any host 172.16.4.77 eq www
permit tcp any host 172.16.4.77 eq 8905
permit tcp any host 172.16.4.77 eqg 8909
permit udp any host 172.16.4.77 eq 8905
permit udp any host 172.16.4.77 eqg 8909

deny ip any any

ip access-1list extended ACL-WEBAUTH-REDIRECT
permit tcp any any eq www

permit tcp any any eq 443

deny ip any any

!

logging origin-id ip

logging source-interface GigabitEthernetl/0/48
!

radius-server attribute 6 on-for-login-auth
radius-server attribute 6 support-multiple
radius-server attribute 8 include-in-access-req

radius-server dead-criteria time 5 tries 3

radius-server host 172.16.4.77 auth-port 1812 acct-port 1813 key 7

140713181F13253920
!

radius server host
|

wsma agent exec
profile httplistener
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profile httpslistener
wsma agent config

profile httplistener

profile httpslistener
wsma agent filesys

profile httplistener

profile httpslistener
wsma agent notify

profile httplistener

profile httpslistener

!
wsma profile listener httplistener
transport http

!
wsma profile listener httpslistener
transport https

ap group default-group

end

For each interface that is to be controlled, the recommended configurations are as follows:

interface GigabitEthernetl1/0/10

switchport access vlan 101

switchport mode access

switchport block unicast

switchport voice vlan 105

ip arp inspection limit rate 2000

ip access-group ACL-DEFAULT in

authentication event fail action next-method
authentication event server dead action authorize vlan 101
authentication event server alive action reinitialize
authentication host-mode multi-auth

authentication open

authentication order dotlx mab

authentication priority dotlx mab

authentication port-control auto

authentication periodic

authentication timer reauthenticate server
authentication timer inactivity 180

authentication violation restrict

mab
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dotlx pae authenticator

dotlx timeout tx-period 10

spanning-tree portfast

spanning-tree bpduguard enable

ip dhcp snooping limit rate 2048

11.

12.

13.

14.

15.

16.

Go to the top tabs and click Administration > System > Deployment. (If a warning that
says “This node is standby mode. To register other...Role to Primary” click OK.) Under
the Deployment Nodes — Hostnames click on the ise link. Then click Profiling
Configuration, and ensure that Netflow, Radius, DNS, SNMPQUERY, and SNMPTRAP are
selected. If they are not selected, select them. Then click Save.
Select Administration > Identity Management > External Identity Sources. In the frame
on the left choose Active Directory, then choose ise.idam-es-idam-b1.test. Click
Connections tab, select the checkbox next to the domain es-idam-bl.test. Check
to see if there is a green check in the Status column. If yes click Save.
If not, Click Join, and type in the AD Credentials and click Save. A green check
should appear in the Status column.
Select Administration > Identity Management > External Identity Sources > Groups tab.
Click Add > Select Group From Directory. Click retrieve groups. Check the es-idam-
bl.test/Users/Domain Users box and the es-idam-b1.test/Builtin/Users box and the es-
idam-b1.test/Users/OTAccess box. These items are specified for protected access (the
build used OTAccess). Then Click OK. Then click Save. Relogin as directed.
Select Administration > System > Settings. Click on Policy Sets in the frame at the left of
the screen, and click enabled (if it is not already clicked). Click Save if needed.
Select Policy > Policy Elements > Results. In the frame at the left of the screen, left
column, click Authorization, then Downloadable ACL List. Create the following (all IP
addresses are pertinent to the current build.; these addresses will need to be replaced
with IP addressing that is appropriate to the target environment):
o All_But_OT-Access-DACL
= Name:All But OT-Access-DACL
=  DACL Content:
deny ip any 172.16.6.0 0.0.0.255
permit ip any any

Click Save
In the left column, select Authorization Profiles and click Add to create the
following:
o All_and_OT
* Name:All and OT
= Access Type: ACCESS ACCEPT
=  Check DACL Name: PERMIT ALL TRAFFIC
Click Submit
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o All_But_OT_Access
= Name:All But OT Access
= Access Type: ACCESS ACCEPT
* Check DACL Name: A11 But OT-Access-DACL
Click Submit
o DenyAccess
= Name: DenyAccess
= Access Type: ACCESS REJECT
Click Submit
17. Select Policy > Policy Elements > Conditions. In the left column, select Authorization,
then Simple Conditions. Click Add to create the following:

o NotOTAccess

= Name:NotOTAccess

= Attribute: Select the domain (build uses es-idam-bl.test)>
ExternalGroups

= QOperator: Not Equals

= Value: Select the Security Group (build uses es-idam-
bl.test/Users/OTAccess)

Click Submit

o IT_DomainUsers

* Name:IT DomainUsers
= Attribute: Select the domain (build uses es-idam-bl.test)>
ExternalGroups
= QOperator: Equals
= Value: Select domain users group (build uses es-idam-
bl.test/Users/Domain Users)
Click Submit
18. Select Policy > Policy Sets. Select Default and configure policies. Choose the arrow next
to Authorization to expand the section. Choose the top rule and click the option arrow
to the right of the Edit link within the policy. Click New rule above.

o Rule 1: Click the plus sign in the Conditions box. Select Create New Condition
(Advanced Option). Select Attribute > es.idam-b1.test > External Groups. Leave
equals Select Attributes > es-idam-b1.test/Users/OTAccess. Click the plus sign in
the Permissions box. Select item drop down choose Standard > All_and_OT. Click
Done button on right.

Click the arrow to the right of the Edit link within the top policy (new policy
created above) Click Insert Below.

o Rule 2: Click the plus sign in the Conditions box. Select Existing Condition from
Library. Select arrow to choose simple conditions > NotOTAccess. Select arrow
next to the gear icon (on right). Select Add Condition from Library. Select Arrow
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to choose Simple conditions > IT_DomainUsers. Click on the Permissions input
box. Click the plus sign in the Permissions box. Click the arrow and choose
standard > All_But_OT_Access. Click Done. Click Save.

CA Identity Manager implements the central IdJAM workflow in Build #1. It receives input from
an HR system in the form of .csv files. The access and authorization for each user is based on the
business and security rules implemented in workflows within Identity Manager. The workflows
include management approval chains as well as approval/denial data logging. Once Identity
Manager has processed the access and authority request, the updated user access and
authorization data is pushed to the central ID store. The central ID store contains the
distribution mechanism for updating the various downstream (synchronized) directories with
user access and authorization data. This process applies to new users, terminated users
(disabled or deleted users), and any changes to a user profile. Changes include promotions, job
responsibility changes, and any other change that would affect the systems a user needs to
access.

6.1  SECURITY CHARACTERISTICS
Cybersecurity Framework Categories:

e PR.AC-1: Identities and credentials are managed for authorized devices and users
e PR.AC-4: Access permissions are managed, incorporating the principles of least privilege
and separation of duties

NIST 800-53 rev 4 Security Controls: AC-2, AC-3, AC-5, AC-6, AC-16, |IA Family

CA Identity Manager is installed on the IdAM network on a VM running the Windows Server
2012 R2 OS.

Important: The following instructions are for a single server demo environment and are not
intended to be used for a production deployment.

This guide walks you through a basic installation of CA Identity Manager on JBoss, on a single
Windows server. For comprehensive instructions for installing CA Identity Manager, refer to the
CA Identity Manager Installation Guide for JBoss at https://support.ca.com.

6.2  INSTALLATION PREREQUISITES

The following steps are required prior to the CA Identity Manager installation. (For supported
versions of all software, review the CA Identity Manager Support Matrix at
https://support.ca.com.)

1. Use a server with a supported OS (e.g., Windows 2012 R2).
2. |Install a supported version of the JDK. (e.g., 1.7.0_71).
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6.3

6.4

N

L ® N o U kW

Install a supported version of JBoss. (e.g., jboss-eap-6.3).

To install JBoss as a Windows service, follow the instructions at the following link:
https.//access.redhat.com/documentation/en-

US/JBoss Enterprise Application Platform/6.3/html/Installation Guide/Install JBoss En
terprise Application Platform 6 Microsoft Windows Service.html

Create a Database and associated user with DBA permissions on a supported database
(e.g., MSSQL 2012).

Download and unzip CA Identity Manager software from https://support.ca.com.

INSTALL CA DIRECTORY
From the unzipped location, go to CADirectory x64\dxserver\windows and execute
dxsetup.exe.
Select Typical installation.
Uncheck “DXmanager will manage...”

Accept all other defaults.

INSTALL CA IDENTITY MANAGER

From the unzipped location, execute ca-im-12.6.XX-win32.exe

Select Components: deselect “Connect to Existing SiteMinder Policy Server” and
“Extensions for Siteminder...”. Leave the rest of the checkboxes checked.

Deployment Size: compact

Provisioning Server Hostnames: Just click Next

Provisioning Directory Information: enter a shared secret and confirmation.
Destination Location: accept default

FIPS Information: accept default

Application Server Information: JBoss

JBoss Application Server Information: Choose and locate the folder where JBoss is
installed. Enter the fully qualified URL and Port for JBoss. Leave the Cluster fields blank.

10. Select Java Virtual Machine: Click “Search for Others”. Select jdk1.7.0_71\bin\java.exe.

11. Key Encryption Information: accept default

12. Select Database Type: Select SQL 2005, 2008, or 2012

13. Database Connection Information: Enter hostname, database and credentials as created

in the prerequisites above.

14. Login Information: Enter a username and password to be used for the Management

Console. Leave the Enable Secure Login for Management Console checked
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6.5

15. HTTP Proxy Settings: Leave blank
16. Review Settings: Click Install

17. After the installation completes, start JBoss by executing jboss-eap-

6.3\bin\standalone.bat.

18. Review the log file to verify that JBoss started without error: jboss-eap-

6.3\standalone\log\server.log

19. If you receive a timeout error such as “Timeout after [300] seconds waiting for service

container stability...”, increase the timeout by modifying standalone.bat, adding the
following attribute to the startup script:
-Djboss.as.management.blocking.timeout=900

CREATE THE SAMPLE NETEAUTO DIRECTORY

Open a command prompt as the administrator user
cd to “C:\Program Files (x86)\CA\ldentity Manager\IAM Suite\ldentity
Manager\tools\samples\NeteAuto\Organization”

o You will see several sample files. For this example, we will use neteauto.ldif
Execute the following commands:

dxnewdsa -s500 neteauto 3895 "dc=security,dc=com"
dxserver install neteauto

dxserver stop neteauto

dxloaddb -v -s neteauto neteauto.ldif

dxserver start neteauto

To log in to the IM Management Console, navigate to
http://<ServerName>:8080/iam/immanage and log in using the credentials you supplied
in Login Information above.
From Directories, select “Create or Update from XML”.
Browse to C:\Program Files (x86)\CA\ldentity Manager\IAM Suite\ldentity
Manager\tools\samples\NeteAuto\Organization.
Select directory.xml. Click Next.
Supply values for the fields in this window as follows:
e Name - NeteAuto
e Description - (Optional)
e Connection Object Name - neteauto
e Host - the machine name where you ran the dxserver commands above
e Port-3895
e Username/User DN - uid=NeteAuto
Administrator,ou=People,ou=Employee,ou=NeteAuto,dc=security,dc=com
e Password/Confirm Password - test
e Secure Connection - Unchecked
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963 9. Click Next, then Finish.

964 6.6  CREATE THE PROVISIONING DIRECTORY

965 1. From Directories, select “Create or Update from XML”".

966 2. Browse to C:\Program Files (x86)\CA\ldentity Manager\IAM Suite\ldentity
967 Manager\tools\directoryTemplates\ProvisioningServer.

968 3. Select directory.xml. Click Next.

969 4. Supply values for the fields in this window as follows:

970 e Name - Provisioning

971 e Description - (Optional)

972 e Connection Object Name - provisioning

973 e Host - the machine name where IM is installed

974 e Provisioning Domain - im

975 e Username - the username you supplied in Login Information above
976 e Password/Confirm Password - the password you supplied in Login Information
977 above

978 5. Click Next, then Finish.

979 6.7 CREATE THE NETEAUTO ENVIRONMENT

980 1. From Environments, select “New”.
981 2. Supply the following information:
982 e Environment name - NeteAuto
983 e Description - (Optional)
984 e URL alias - neteauto
985 e Base URL — accept the default (make sure it is a fully qualified host name in the
986 URL)
987 3. Click Next.
988 4. Select the “NeteAuto” directory. Click Next.
989 5. Select the “Provisioning” directory. Click Next.
990 e URL alias used to reference public tasks — neteauto_pub
991 e User for anonomous authentication — SelfRegUser
992 6. Click Validate. Then click Next.
993 7. Select “Create Default Roles”. Click Next.
994 8. Select the Checkbox for Active Directory.
995 9. Scroll down and click the Browse button.
996 10. Select the NIST_PXPolicies.xml file provided with this guide. (Download the file from
997 https://nccoe.nist.qov/sites/default/files/nccoe/NIST PXPolicies.zipx and unzip it.)
998 11. Click Next.
999 e System Manager — SuperAdmin
1000 12. Click Add. Then click Next.
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e Inbound Administrator — SuperAdmin
13. Click Next.
e Password/Confirm Password - the password you supplied in Login Information
above
14. Click Next.
15. Review the settings, then click Finish.
16. Allow a few minutes for the Environment to deploy.
17. When finished with “0 error(s)”, click Continue.
18. Click “NeteAuto”.
19. Click “Advanced Settings”, then “Workflow”. Enable both check boxes and click Save.
20. Click the “Restart Environment” button.
21. Verify that you can login to the environment by going to the environment URL and
logging in:
e http://<FullyQualifiedServerName>:8080/iam/im/<ProtectedAlias>
e Username: SuperAdmin
e Password: test

6.8 CONFIGURE CONNECTION TO ALERTENTERPRISES DATABASE

Generate the encrypted password for the Alert Database as follows:

1. From a command prompt, cd to C:\Program Files (x86)\CA\Identity
Manager\IAM Suitel\Identity Manager\tools\PasswordTool

e Execute the following command: pwdtools -JSAFE -p
<AlertDBPassword>

e The result displays the Encrypted value with a prefix of {PBES}.
e Copy this encrypted password to be used below for EncryptedALERTDBPassword.

2. From the JBoss installation directory, create the following folder structure:
jboss-eap-6.3\modules\com\mysgl\main
e Download Connector/ J from http://dev.mysql.com/downloads/connector/

e Select Platform Independent, Compressed Zip Archive. Download.

e Unzip and copy the mysgl-connector-java-5.1.35-bin.jar to the mysgl\main folder
you created above.

e Under the same folder, create a text file named module.xml. Paste the
following text into the file:

<?xml version="1.0" encoding="UTF-8"?>
<module xmlns="urn:jboss:module:1.1" name="com.mysqgl">
<resources>

<resource-root path="mysgl-connector-java-5.1.35-
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1038 bin.jar"/>

1039 </resources>

1040 <dependencies>

1041 <module name="javax.api"/>

1042 </dependencies>

1043 </module>

1044 3. From jboss-eap-6.3\standalone\configuration edit standalone-full.xml

1045 4. In the “<drivers>” section, add:

1046 <driver name="mysqgl" module="com.mysqgl">

1047 <driver-class>com.mysqgl.jdbc.Driver</driver-class>
1048 </driver>

1049 5. Just above the “<drivers>”" section, add a new data source:

1050 <datasource Jjndi-name="java:/iam/im/jdbc/jdbc/AlertDB"
1051 pool-name="MySQLPool" use-java-context="true">

1052 <connection-url>

1053 Jdbc:mysqgl://ALERTDBServerName:3306/ALERTDBName

1054 </connection-url>

1055 <driver>

1056 mysql

1057 </driver>

1058 <pool>

1059 <max-pool-size>30</max-pool-size>

1060 </pool>

1061 <security>

1062 <security-domain>mysqgldb</security-domain>

1063 </security>

1064 </datasource>

1065 6. In the “<security-domains>”" section, add the following security domain:

1066 <security-domain name="mysqgldb">

1067 <authentication>

1068 <login-module

1069 code="com.netegrity.jboss.datasource.PicketBoxPasswordEncry
1070 ptedLogin" flag="required" module="com.ca.iam.idmutils">
1071 <module-option name="userName"

1072 value="ALERTDBUserName" />

1073 <module-option name="password" value="

1074 EncryptedALERTDBPassword " />

1075 <module-option name="managedConnectionFactoryName"
1076 value="jboss.jca:name=iam/im/jdbc/jdbc/WPDS, service=LocalTx
1077 CM" />

1078 </login-module>

1079 </authentication>

1080 </security-domain>
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7. Restart the JBoss service

8. Review the log file to verify that JBoss started without error: jboss-eap-
6.3\standalone\log\server.log

6.9 PoLicy XPRESS PoLicYy REVIEW

1. Login to the NeteAuto Environment that you created above by navigating to
http://<FullyQualifiedServerName>:8080/iam/im/<ProtectedAlias>

2. For NeteAuto the username/password is superadmin/test.

3. Navigate to Policies > Policy Xpress > Modify Policy Xpress Policy, and click Search.

4. Select the desired Policy to review and modify as desired.

Check for Duplicates on Create: Stops the task with a message to the user if
duplicates are detected for the CardNumber or the UserID on the Alert Database

Check for Duplicates on Modify: Stops the task with a message to the user if the
CardNumber is already used by another user on the Alert Database.

Check for Numeric on Create and Modify: Stops the task with a message to the
user if the PIN, FacilityCode, or CardNumber is not an integer.

Check PACs fields on Create and Modify: Stops the task with a message to the
user if none of the PACs checkboxes are selected. At least one must be selected.

Create AE User: Creates User on the Alert Database if all above checks pass.
Provisions user to Active Directory.

Disable AE User: Disables User on the Alert Database, by setting the UserStatus
to “Inactive”

Enable AE User: Enables User on the Alert Database, by setting the UserStatus to
“Active”

Modify AE User: Modifies User on the Alert Database if all above checks pass.

6.10 UPDATE CREATE USER AND MODIFY USER SCREENS

L L

From Roles and Tasks > Admin Tasks > Modify Admin Task, search and select Create User.
Go to the Tabs tab and click the edit pencil next to Profile.

Click Browse Next to the Create User Profile.

Select the Default User Profile, and click the Edit button.

Click the edit pencil next to each of the following fields:

Office: Change Name to PIN

Postal Code: Change Name to Facility Code. Change Permission to
Read/Write Required.

Cell Phone: Change Name to Home Phone.
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10.
11.
12.

13.
14.

e Business Phone: Change Name to Work Phone.

e State: Change Nameto Pacs All Door. Change Style to Checkbox. Set Check
value to 1. Set Unchecked Value to O.

e City: Change Name to Pacs Work Access. Change Style to Checkbox. Set
Check value to 1. Set Unchecked Value to 0.

e Address: Change Name to Pacs Home Access. Change Style to Checkbox. Set
Check value to 1. Set Unchecked Value to 0.

e Employee Number: Change Name to Card Number. Change Permission to
Read/Write Required.

e For any non-required fields that you don’t want to display: Change Style to
Hidden.

Click OK.
Select the Create User Profile, and click the Edit button.
Repeat Step 5 for this profile. When finished, click OK.

Navigate to Users >Manage Users >Create User, and click “Yes” for the warning message
about losing changes.

Select Create New User, and click OK.
Verify that the fields you updated are changed as desired.

Navigate to Users >Manage Users >Modify User, and click “Yes” for the warning message
about losing changes.

Select Create Modify User, and click OK.
Verify that the fields you updated are changed as desired.

6.11 INSTALL ACTIVITY DIRECtORY CERTIFICATE

2.
3.
4.

Obtain the Active Directory certificate(s) from the domain controller(s) you want to
connect to and copy them to the Identity Manager server.

Double-click on the certificate, and click Install Certificate.

Select Local Machine, then Place all Certificates in the following store. Click Browse.
Select Trusted Root Certification Authorities. Click OK twice.

6.12 ACQUIRE ACTIVITY DIRECTORY ENDPOINT

1.

From Endpoints >Manage Endpoints >Create Endpoint, select Create a new endpoint of
Endpoint type ActiveDirectory. Click OK.

e Endpoint: Give your endpoint a name

¢ Hostname: Fully qualified host name for the Active
Directory Domain Controller
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2.
3.

e UserID:Fully qualified User 1ID,for example: domain\userid.
e Password/Confirm Password: Password for the AD User

Click the Security tab. Check the “Use LDAP — SSL Encryption” checkbox.

Click Submit.

6.13 EXPLORE AND CORRELATE ACTIVE DIRECTORY

L ® N o U A~ W

13.
14.

From Endpoints >Explore and Correlate Definitions >Create Explore and Correlate
Definition, select Create a New Object of Type Explore and Correlate and click OK.

Explore and Correlate Name: Give it a name such as “Explore AD <domain
controller name>"

Select the Explore endpoint... checkbox. Uncheck the rest of the checkboxes.
Click the Select Container/Endpoint/Explore Method button.

Select Active Directory and click Search.

Select the endpoint you created above. Click Select.

Click Search.

Select the containers that you want to be connected to Identity Manager.

Click Select, then Submit.

. From Endpoints > Execute Explore and Correlate, select Execute Now and click Next.
11.
12.

Browse for the Explore and Correlate Definition you just created, then click Finish.

Repeat the steps above to create and execute a Correlate Definition, with only one
difference: On the step Explore endpoint step, uncheck Explore endpoint, and check
Update User Fields, Correlate Accounts to Users, and Create Users as needed.

From System > View Submitted tasks, click Search.

Verify that both the Explore and Correlate definitions completed successfully.

6.14 CREATE THE ACTIVE DIRECTORY ACCOUNT TEMPLATE AND PROVISIONING ROLE

From Endpoints > Account Templates > Create Account Template, select Create a new
Account Template of Endpoint Type “Active Directory”. Click OK.

Give the Account Template a name, such as “<domain controller name> Account
Template”.

From the Endpoints tab, add the Active Directory Endpoint you created above.
From the Groups tab, add the Active Directory groups you want to provision to the user.

When finished, click Submit.
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1180 6. From Roles >Provisioning Roles >Create Provisioning Role, select Create a new

1181 provisioning role, click OK.

1182 7. Give the Provisioning Role a name such as “<domain controller name> Provisioning
1183 Role”

1184 8. From the Account Templates tab, add the Account Template you just created above.
1185 9. From the Administrators tab, select a user, or group of users that you want to be the
1186 Administrators of this role. For example, to make the members of a certain Admin role
1187 the administrators of this provisioning role:

1188 e C(Click Add.

1189 e From the Users drop-down select a group of users, such as Users who are
1190 members of <role-rule>, then admin role.

1191 e Browse, search, and select the Admin Role you want to add.

1192 e From the Owners tab, select a user, or group of users that you want to be the
1193 Owners of this role, using the same process as used for the Administrators tab.
1194 e Click Submit.

1195 6.15 MODIFY CREATE AE USER POLICY to INCLUDE THE NEW PROVISIONING ROLE

1196 1. From Policies >Policy Xpress >Modify Policy Xpress Policy, search and select the Create
1197 AE User policy.

1198 2. From the Action Rules tab, click the edit pencil next to Create User

1199 3. Click the edit pencil next to Add otdc. Click the Browse “...” button next to the

1200 Provisioning Role Name. Select the Provisioning Role you just created.

1201 4. Click Select, OK, OK, Submit.

1202 6.16 ADD WORKFLOW CONTROL OVER CREATE USER AND ANY OTHER TASK AS DESIRED

1203 1. From Roles and Tasks >Admin Tasks >Modify Admin Task, search and select Create User.

1204 2. From the Events tab, click the edit pencil next to the CreateUserEvent workflow process.
1205 3. Select the Non-Policy Based workflow process “SingleStepApproval.”

1206 4. For the approval, select “Approve Create User” *

1207 5. For the Participant resolver select the type of members you want to assign. For example,
1208 Admin Role Members. *

1209 6. Click Add Admin Roles. Search and select the Admin Roles you want to have approve this
1210 workflow. *

1211 7. Repeat the above 3 steps with * for the Primary Approver.

1212 8. When finished with both approvers, click OK, then Submit.
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The above steps can be used for the Modify User and Enable/Disable User tasks (or any
other task).

6.17 TEST CREATION OF A USER MANUALLY

From Users >Manage Users > Create User, select Create a New User, click OK.

Fill out the fields as desired for the new user, keeping in mind the policy rules explained
above. For example, PIN, Facility Code, and Card Number must be integers, and at least
one Pacs access checkbox must be checked.

Click Submit, then OK.

From Home > View My Worklist, select and approve the workflow for the Create User
task *

From System >View Submitted tasks, click Search. Verify that the Create User task
completed successfully. *

Connect to the AE Database. Verify that the user was created successfully. *

Connect to the Active Directory Domain Controller. Verify that the user was created
successfully. *

Repeat all the steps above for Modify User, Enable User, and Disable User.

6.18 TEST CREATION OF A USER WITH A CSV FILE

3
4
5
6.
7
8
9

Download the file HRBulkUsers4.csv from
https://nccoe.nist.gov/sites/default/files/nccoe/HRBulkUsers4.csv.

Modify the CSV file to enter the desired values for the new users to be created. Keep in
mind the policy rules that must be followed as described above.

From System > Bulk Loader, Browse for the CSV file.

What field represents the action to perform on the object: action.
What field will be used to uniquely identify the object: uid.

Click Next.

What is the Primary Object: USER.

Select a task to execute for action 'create': Create User

Click Finish.

Repeat the steps from Section 9.17 (above) with an asterisk (*) to approve the users and
verify that they were successfully created.
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RSA IMG implements the central IdAM workflow in Build #2. It receives input from an HR system
in the form of .csv files. The access and authorization for each user is based on the business and
security rules implemented in workflows within RSA IMG. The workflows include management
approval chains as well as approval/denial data logging. Once IMG has processed the access and
authority request, the updated user access and authorization data is pushed to the central ID
store. The central ID store contains the distribution mechanism for updating the various
downstream (synchronized) directories with user access and authorization data. This process
applies to new users, terminated users (disabled or deleted users), and any changes to a user
profile. Changes may include promotions, job responsibility changes, and any other change that
would affect the systems a user needs to access.

7.1  SECURITY CHARACTERISTICS
Cybersecurity Framework Categories:

e PR.AC-1: Identities and credentials are managed for authorized devices and users
e PR.AC-4: Access permissions are managed, incorporating the principles of least privilege
and separation of duties

NIST 800-53 rev 4 Security Controls: AC-2, AC-3, AC-5, AC-6, AC-16, |IA Family
7.2 IMG INSTALLATION

Install IMG using the included installation guide on a server running SUSE Linux OS or from an
IMG virtual appliance image. The RSA Installation guide is available for licensed customers at
http://www.emc.com/domains/rsa/index.htm.

7.3 IMG CONFIGURATION AND INTEGRATION WITH DIRECTORIES

After install, open a web browser and point it to the IP Address or DNS name of the RSA IMG
server. The following instructions are provided along with screenshots depicting each step.
Unless stated otherwise the settings are included in each screenshot.

Log in with the default credentials:

Username: AveksaAdmin (case sensitive)
Password: aveksal23

Change the password when prompted to change.

7.3.1  Set Up Custom Attributes
1. Navigate to ‘Admin’ then ‘Attributes’:
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Figure 9. IMG Attributes Window

1. Click on ‘User’ then ‘Edit’ as shown in Figure 10.
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1279 2. Modify your attributes to match Figures 11-13.

Figure 11. IMG Attributes Examples
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Figure 12. IMG Attributes Examples

Figure 13. IMG Attributes Examples

3. Click on OK.
4. Click on ‘Account’ then ‘Edit’ as shown in Figure 14.

Figure 14. IMG Edit Attributes

5. Modify your attributes to match those shown in Figure 15. IMG Attribute Example.
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1290

1291 Figure 15. IMG Attribute Example
1292 6. Click on ‘OK..

1293  7.3.2 Set up Organization Users

1294  The next step is to set up the organization’s existing users. In the example solution, we used a
1295  CSV file that contains all the users in the organization. This CSV file needs to be copied to a
1296  convenient location on the IMG server. You can get a sample CSV file, HR_Data_Move.csv at
1297  https://nccoe.nist.gov/sites/default/files/nccoe/HR_Data_Move.csv.

1298 1. Once the CSV file is copied to the server, perform the following actions:
1299 2. Navigate to ‘Resources’ and under resources, select ‘Directories’ as shown in Figure 16.
1300
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1301 Figure 16. IMG Resources Directories

1302 3. Click ‘Create Directory’ as shown in Figure 17.

1303

1304 Figure 17. IMG Create Directory

1305 4. Select ‘Other Directory’ and click ‘Next” as shown in Figure 18.

1307

1308 Figure 18. IMG Create Directory

1309

1310 5. Enter ‘HR’ in the ‘Directory Raw Name’ field. Click ‘Finish” as shown in Figure 19 .
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Figure 19. IMG Directory Information

You have now created your first directory which will serve as a repository for all the HR Data for
the organization.

6. Repeat the above steps, creating a second directory. This one will be named ‘RSA
Adaptive Directory’. This container will be used to pull AD accounts from the Adaptive
Directory server. In this case be sure to select the two options as shown in Figure 20.
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Figure 20. IMG Create Directory
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7.3.3  Populate the HR Directory
The next step is to populate the HR directory with users.

1. Click on ‘Resources’ and ‘Directories’ again as shown in Figure 21.

Figure 21. IMG Directories

2. Click on your new HR directory you just created as shown in Figure 22.

Figure 22. IMG Directories
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3. Click on ‘Collectors’ then click ‘Create Identity Collector’ as shown in Figure 23Figure 23.
IMG Create Identity Collector.

Figure 23. IMG Create Identity Collector

4. Enter details as below as shown in Figure 24.
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1337 Figure 24. IMG HR Identities

1338 5. Click ‘Next’, and enter details as below as shown in Figure 25.

1339

1340 Figure 25. IMG HR Identities (cont.)

1341 6. Use the same username and password you use to log into the IMG management web
1342 page.

1343  The URL will point to the folder that the CSV file is located in. In this example, the full field is:

1344  jdbc:csv://///home/oracle/database/SampleData/Demo/HR/?_CSV_Header=true;tmpdir=/hom
1345 e/oracle

1346  The CSV file is located in home/oracle/database/SampleData/Demo/HR

1347 7. Click ‘Next’.
1348 8. Leave ‘Users’ selected and click ‘Next’ as shown in Figure 26.
1349
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Figure 26. IMG HR Identities - Users

1. Enter details as shown in Figure 27 and Figure 28 , below. The full text of the ‘User Data
Query’ is as follows:

select fname, lname, case when substr(lname,1,2) = 'IT' then
'it' when substr (lname,1,2) = 'OT' then 'ot' else 'pacs' end as
OU, login, email as sAMAccountName, email, location, bu,
department, title, supervisor, Jjob level, job status, login as
SR, 1s terminated, previous manager, Jjobcode, previous manager
as backjp supervisor, job family,concat (lname,', ', fname)as
fullname, is manager, email as UniquelID from HR Data Move

The highlighted section is specific to this example, based off of our sample data, the OU that the
user needs to be provisioned in is based off of the last name. Basically, when the 1° two letters
of the last name = IT, the user will have ‘it’ set to the OU attribute, if it’s OT, then ‘ot’ is set as
the OU attribute, any other scenario the OU attribute is set to ‘pacs’.
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1365

1366 Figure 27. IMG HR Identities

1367
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Figure 28. IMG HR Identities (cont.)
9. Click ‘Finish’

7.3.4  Configure Adaptive Directory Container
The next step is to configure the Adaptive Directory Container with ldentity and Account
collectors.

1. Navigate to the Adaptive Directory Container as shown in Figure 29.
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Figure 29. IMG Adaptive Directory Container

This identity collector will tie together user identities in Adaptive Directory to user identities in
the HR CSV file.

2. Click on ‘Collectors’ and ‘Create Identity Collector’ as shown in Figure 30.
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1383 Figure 30. IMG Identity Collector

1384 3. Create the ID collector as follows, clicking ‘Next’ between each screen shown in Figure
1385 31, Figure 32, Figure 33, Figure 34 and Figure 35.

1386

1387 Figure 31. IMG AD Identity Collector

1388
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Figure 32. IMG AD Identity Collector

Figure 33. IMG AD Identity Collector
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1395

1396 Figure 34. IMG AD Identity Collector

1397
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Figure 35. IMG AD Identity Collector

4. Click Finish

7.3.5 Create an Account Collector
The next step is to create an account collector which pulls all relevant attributes from Adaptive
Directory.

1. Click on ‘Collectors’ and ‘Create Account Collector’ as shown in Figure 36.
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Figure 36. IMG AD Create Account Collector

2. Create the Account collector as follows, clicking ‘Next’” between each screenshot, Figure
37 through Figure 46 below.
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Figure 37. IMG Edit Collector

Figure 38. IMG Edit Collector

Figure 39. IMG Edit Collector
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1418
1419 Figure 40. IMG Edit Collector
1420
1421
1422 Figure 41. IMG Edit Collector
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1423

1424 Figure 42. IMG Edit Collector

1425

1426
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Figure 43. IMG Edit Collector

Figure 44. IMG Edit Collector

Figure 45. IMG Edit Collector

Figure 46. IMG Edit Collector
3. Click ‘Finish’
A Test button is provided with each account collector and identity collector.

4. Test each account collector you created using the test button. This action verifies that
IMG can retrieve the account information for each directory added as shown in Figure
47 below.
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Figure 47. IMG Account Test

A successful test will look something like Figure 48.

’ Test Collector: RSA AD Directory Accounts

<tns:account-data is-data-encoded="true" xsi:schemalLocation="http://wuw.aveksa

<account id="CMN=DoD_Admin,cu=it,dc=master,dc=test">

<attributes userAccountControl="512" lastlLogon="138791218124985148" sAMAcc
<faccount>
<account id="CM=xGuest,ou=it,dc=master,dc=test">

<attributes userAccountControl="514" lastlLogeon="8" sAMAccounthame="xGuest"
</account>
<account id="CMN=krbtgt,cu=it,dc=master,dc=test">

<attributes userfAccountControl="514" lastLogon="&" sAMAccountName="krbtgt"
</account>
caccount id="CN=IdAM,ou=it,dc=master,dc=test":>

<attributes userfAccountControl="66048" displayMName="Ida&M" lastLogon="1387%
<faccount>
<account id="CN=Tony2ITInfrUser,cu=it,dc=master,dc=test">

<attributes userfccountControl="512" lastlogon="8" sAMAccountMame="Tony2IT
</account>
<account id="CMN=DoD_Admin,cu=ot,dc=master,dc=test"»

<attributes userAccountControl="512" lastlLogon="13879@259983919639" sAMAcc
</account>
<account id="CM=xGuest,ou=ot,dc=master,dc=test">

<attributes userAccountControl="514" lastlLogeon="8" sAMAccountName="xGuest"
<faccount>
<account id="CM=krbtgt,cu=ot,dc=master,dc=test">

<attributes userfAccountControl="514" lastLogon="@" sAMAccountName="krbtgt"
</account>
caccount id="CN=IdAM,ou=ot,dc=master,dc=test">

<attributes userdccountControl="66@48" displayMame="IdaM™ lastLogon="8" sAl ™

4

| Cancel

Figure 48. IMG Successful Test Example
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7.3.6  Edit the Unification Configuration Participating Collectors
The next step is to configure Unification — this is the process of joining Identities from the HR
CSV and the Adaptive Directory collectors.

1. Click on ‘Collectors’ and ‘Unification Config’ as shown in Figure 49.

Figure 49. IMG Unification Configuration

2. Choose the Participating Collectors tab. Click on Edit as shown in Figure 50.

Figure 50. IMG Participating Collectors

3. Configure as shown in Figure 51 and Figure 52. Click Next on each screen.
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Figure 51. IMG Edit Participating Collectors

Figure 52. IMG Edit Participating Collectors

In the above example, we have HR Identities at the top. This indicates that HR Identities is
authoritative source — if there are any discrepancies between the data between the two, then
the one at the top will win by default, but this can be overridden, which we will see later.

4. Click Finish.

7.3.7  Edit Unification Configuration Attribute Source
The next step is to change the default behavior of the authoritative source for the necessary
attributes.

1. Choose the Attribute Sources tab. Click on Edit as shown in Figure 53.
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1469 Figure 53. IMG Unification Configuration Attribute Sources

1470 2. Edit the Attributes shown in Figure 54 and Figure 55. Leave alone any attribute shown as
1471 ‘Not Set’. These attributes will use the default behavior:

1472
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1473 Figure 54. IMG Edit User Attribute Mapping
1474

1475 Figure 55. IMG Edit User Attribute Mapping
1476 3. Click on OK.

1477  7.3.8 Edit Unification Configuration Attribute Source
1478  The next step is to configure which attribute to use from each directory so IMG knows how to
1479  tie users together.

1480 1. Choose the Joins tab. Click on Edit as shown in Figure 56.

1481
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Figure 56. IMG Unification Configuration Joins

2. Choose the HR Identities from the Primary Identity Collector dropdown box as shown in
Figure 57.

Figure 57. IMG Edit Joins
3. Click ‘Finish’.

7.3.9  Start Data Collection
The next step is to start collecting identity data.

1. From the home page choose the Resources > Directories tab. Click Collect Data (all)
button as shown in Figure 58.
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Figure 58. IMG Start Data Collection

2. Click OK on the next window as shown in Figure 59.

Figure 59. IMG Collect Data

3. The process will take 30 seconds or so to complete. You can check the progress under
‘Admin’ and ‘Monitoring’ as shown in Figure 60.
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Figure 60. IMG Data Collection Monitoring

You will see all the processes change to ‘Complete’ when done.

7.3.10 Review Data Collected
Now you can look at this data by going to ‘Users’ then ‘Users’ and ‘Groups’.

1. From the home page choose the Users > Groups tab as shown in Figure 61 to review the
data collected.
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Figure 61. IMG Data Collection Review

7.3.11 Configure Business Rules
The next step is to configure Business Roles.

1. Click on Roles > Roles as shown in Figure.

Figure 62. IMG Roles

2. Click on ‘Create / Discover’ and ‘Discover Roles’ as shown in Figure 63.
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1517

1518 Figure 63. IMG Discover Roles
1519 3. Configure as follows as shown in Figure 64 through Figure 66.
1520
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1521 Figure 64. IMG Discover Roles
1522
1523 Figure 65. IMG Discover Roles

Discover Roles

Role Information Expressions

What expressions should be used to generate role information?

Mame | ${User.Job Code} - ${User.Title} | v

Last Reviewed Date | | v
Risk | | v

1524

1525 Figure 66. IMG Discover Roles

1526 4. Notice how there are some duplicates — the job codes are the same, but the descriptions
1527 are slightly different. You can combine these rolls into one as shown in Figure 67:
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Discover Roles

Figure 67. IMG Discover Roles

5. When you are done combining duplicates, click Finish.

7.3.12 Create Automated Rules

Role Creation
For each row in the table below a new role will be created. The selection checkboxes are used to identify roles for use with the button bar below the table o
[ | Role Mame 4 | Members
00701 - Managing Director 1
U 00702 - Executive Assistant Ur-
U 00703 - Business Startegist 1
Q 10100 - Chief Executive Office 1
10101 - AM Department Mar 1
10101 - IT Department Mana 1
L' 10102 - Lead Infr Admin 1
L' (10102 - sr Infr Admin 3
ltems 1 - 50 of 66 | 2 selected EJ Page 12 1 i]
| Remove | | ComﬁRemove Users | | Remave Entitlements |
[ Hide Entitlernents That Are Already Used In Committed Roles
[ Hide Entitlernents That Are Already Used In New Uncommitted Roles
Suggest entitlements that —@ 12 % of members have | Refresh | | Show More |

The next step is to create rules for automatically detecting and invoking work flows for new

users and terminations.

1. Click on ‘Rules’ and ‘Definitions’ as shown in Figure 68.
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1536 Figure 68. IMG Roles Definitions

1537 2. Click on ‘Create Rule’ and configure as shown in Figure 69 and Figure 70 for New Users.

Edit Rule: New User

Rule Mame* : | Mew User |

Description :

Owner® ;. AveksaAdmin, @

Control URL ;

Control Description :

Type” ‘ Provisioning - Joiner/Mover [l
Status” : ‘ Active EI
RuleSet”: ® Exjsting rule set| Default Rule Set v

) Mew rule set named | |

Condition
[« Trigger when new users are detected (joiners)

[]Trigger when users change categories (movers)

Actions

Assign provisioning request form Default Provisioning Form?

Provisioned entitlements®:

Entitlernent Suggestion Modeling®

For these users: All

Categorize them based on: Job Code

Consider the following entitlements when making suggestions: All
1538 Suggested entitlements that 0% of members have

1539 Figure 69. IMG New User

1540
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Optional entitlements that 0% of members have
Allow arbitrary entitlements
Allow selection from AllR

Allow user comparisons
Assignee™:

® Supervisor

O Specified by target user attribute
O Selected user

[ For movers also generate a review using review definition:

Processing Schedule/Trigger

® Use global configuration O Define for this rule

Scheduled : Mo

Triggered : Run after identity unification

Figure 70. IMG New User

3. Click on ‘Create Rule’ and configure as shown in Figure 71 and Figure 72 for User
Terminations.
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Edit Rule: Termination

Rule Mame® |Termination |

Description ;

Owner* ;  AveksaAadmin, @

Control URL ;

Control Description

Type" ! | Provisioning - Termination |
Status” ; | Active hd
Rule Set”: @ Existing rule Set| Default Rule Set VI

© Mew rule set named | |

Condition

Condition* : For terminated users matching the following condition

IT Users™®
Actions
Each action will submit a separate change request
[] Disable accounts (excludes shared and service accounts)
[v] Delete accounts (excludes shared and service accounts)
For particular accounts All®
Perform this action
® Immediately O After | | days
1545
1546 Figure 71. IMG User Termination
[0 Revoke user entitiements (excludes shared and service accounts)
[ Shared Accounts
[ Service Accounts
Processing Schedule/Trigger
® Use global configuration O Define for this rule
Scheduled: ) ves (2 No
1547 Triggered ; [/|Run after identity unification

92 | NIST Cybersecurity Practice Guide SP 1800-2c



DRAFT

1548 Figure 72. IMG User Termination
1549
1550 4. Click ‘OK’.

1551  7.3.13 Create Provisioning Template
1552  The next step is to create a template that IMG uses when provisioning accounts in Adaptive
1553  Directory:

1554 1. Click on ‘Requests’, ‘Configuration’, ‘Account Template’ tab, then ‘Create Account
1555 Template’ as shown in Figure 73 .
1556
1557 Figure 73. IMG Request Configuration
1558 2. Enter a name, and click OK as shown in Figure 74.
Account Template f‘j'

Mame*: | Account Template

Description @
Is Service Account: () Yes  (® Mo
Account Creation : Mone®
Farm
| oK | | Cancel | | Help

1559 4
1560 Figure 74. IMG Account Template
1561 3. Click on the name of the account template you just created and add parameters as
1562 shown in Figure 75.
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Account Template: IT Account Template
MName: [T Account Template
Is Service Account:  No

Template Parameters

|:| | Action | Name

Add Parameter

| Default Value Submission Field

Table Options

CN

sn
sAMAccountMame
rmail

Account
userPrincipalMame
Password

givenhame

@
=
Fi
3
B

[=]
o

T

m

Pending Account Parameters

|:| | Action | Name

${User.Login_ID}
S{User.Last_Mame}
${User.Login_ID}
${User.Email_Address}
${User.Login_ID}
§{User.Email_Address}
§{GeneratedPassword}

§{User.First_Name}

| Add Pending Account Parameter

| Default Value Submission Field

Table Options

MName
1 It;renlete
1563
1564

CN=5{User.Login_ID} ou=5{User.OU}, dc=master dc=test

Figure 75. IMG IT Account Template

>

<

1565  Next configure the IMG AFX module which will allow IMG to provision to Adaptive Directory:

1566 4. Click on ‘AFX’ and ‘Connectors’ as shown in Figure 76.
1567
1568 Figure 76. IMG AFX Connectors

1569 5. Click on ‘Create Connector’ as shown in Figure 77.
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Figure 77. IMG Create Connector

6. Configure the ‘General’ tab as shown in Figure 78.

Figure 78. IMG AD Connector AFX Server

7. Configure the ‘Settings’ tab as shown in Figure 79 through Figure 81.
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Edit Connector: RSA Adaptive Directory Connector IT

e | Seings | copis |

Connection Details

Host': [h72.164.3

Port” : [1636

Uze Secure !
Connection v

Login Distinguished

Nare® : |cn=D|'rect0r_'.r Manager |

*
Password™ |------------------------------------------- |

Timeout (seconds)” | 10

Distinguished Name

Account DN Prefix : | CN |

Account DM Suffix : | dc=master,dc=test |

Group DN Prefix : |y |

Group DM Suffix . | dc=master,dc=test |

DM Suffix Mappings . |
1576

96 | NIST Cybersecurity Practice Guide SP 1800-2c



DRAFT

1577 Figure 79. IMG AD Connector AFX Server

Edit Connector: RSA Adaptive Directory Connector IT

e | Setings | Capais |

Connection Details

Host": |172,16.4.3

Port* : | 1636

Use Secure :
Connection v

Legin Distinguished

Narme® : |cn=D|'rectory Manager |

L
Password™ : |------------------------------------------- |

Timeout (seconds)® | 10

Distinguished Name

Account DN Prefix : |' CN .|

Account DN Suffix | dc=master,dc=test |

Group DN Prefix : |y |

Group DN Suffix ; | dc=master,dc=test |

DM Suffix Mappings -
1578 |
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1579 Figure 80. IMG AD Connector AFX Server

Object Creation

LDAP object classes to

create account* ' | ‘top','person’,'organizationalPerson’,'user’

LDAP ohject classes to

create group® | | top’, group’
Group
ot member
AccountLockUnlock

Account Lockout :
Threshold attribute | 10

value®
Miscellaneous
Dependent Exchange
1580 Connector
1581 Figure 81. IMG AD Connector AFX Server
1582 8. Configure the ‘Capabilities’ tab as shown in Figure 82.

Edit Connector: RSA Adaptive Directory Connector IT

[ General N Settings ” Capabilities h

Account
[w] Create an Account on an AD server

[v] Delete an Account from an AD server
[+]Reset an Account's password
[w] Add Account to AD Group
[v] FRemove Account from AD Group
[w]Enable an Account
[v] Disable an Account
[+]Update an Account
[w]Move an Account
[+]Lock an Account
[w]Unlock an Account

Group
[v] Create a Group on an AD server
[w] Delete a Group from an AD server
[w] Update a Group

1583
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Figure 82. IMG AD Connector IT

9. Check all capabilities needed for to the connector. Once all are selected, click on the
capability name one by one and configure as shown in Figure 83 through Figure 96.
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1588

1589 Figure 83. IMG AD Connector IT Capability Configuration

1590
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Figure 84. IMG AD Connector IT Capability Configuration

1591

1592

1593 Figure 85. IMG AD Connector IT Capability Configuration
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Figure 86. IMG AD Connector IT Capability Configuration

1594
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Figure 87. IMG AD Connector IT Capability Configuration

Figure 88. IMG AD Connector IT Capability Configuration

Figure 89. IMG AD Connector IT Capability Configuration
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Figure 90. IMG AD Connector IT Capability Configuration

Figure 91. IMG AD Connector IT Capability Configuration
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Figure 92. IMG AD Connector IT Capability Configuration

Figure 93. IMG AD Connector IT Capability Configuration
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1613 Figure 94. IMG AD Connector IT Capability Configuration

1614
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10. Click OK.
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Figure 95. IMG AD Connector IT Capability Configuration

Figure 96. IMG AD Connector IT Capability Configuration
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7.3.14 Configure Adaptive Directory to Use AFX Connector
The next step is to configure the RSA Adaptive Directory ‘Directory’ to use the new AFX
Connector.

1. Click on Resources > Directories tab as shown in Figure 97 and select HR and click OK.

Figure 97. IMG Resources Directories

2. Thenin the next window choose the AFX Connector Binding tab as shown in Figure 98.
3. Click the Edit Connector Binding as shown in Figure 98.
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1630 Figure 98. IMG AD Accounts

1631

1632 Figure 99. IMG AD AFX Connector Binding
1633 4. Click OK as shown in Figure 99.

1634  Now the system is ready.

1635 7.4 UsING RSA IMG

1636 7.4.1 Adding a New User

1637 1. Openthe HR CSV file and add a user.
1638 2. Go to ‘Resources’, ‘Directories’ and click ‘Collect Data (all)’ as shown in Figure 100.
1639
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Figure 100. IMG Resources Directories

1. Click ‘OK’ as shown in Figure 101.

Collect Data

This will collect data from
all directories

Collection will run as a background process. Total execution time will depend on the velume of
data.

Collect ldentity And Run Unification

Collect Accounts

'4

| OK || Cancel | | Help

Figure 101. IMG Collect Data

2. After about 30 seconds go to ‘Requests’, ‘Activities’ and click ‘Perform’ next to the

request to add a new user as shown in Figure 102.
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Figure 102. IMG Requests Activities

3. Select a group you would like to add the user to, Click ‘Next’, then ‘Accepted’ as shown in
Figure 103.

Figure 103. IMG Accepted Access Request

4. Enter a description if you wish, and click ‘Finish’.
5. Go to ‘Requests’, and click ‘Requests’. Click the name of the request as shown in Figure
104.
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1656

1657 Figure 104. IMG Requests

1658

1659 6. After about 30 seconds, your new user will be provisioned to AD and added to the group

1660 you selected as shown in Figure 105.

| Overall Status: 50%

1/2 (Fulfillment Phase)

Name: 00068
Requested By: AveksaAdmin, " on 3/24/15 1:53 PM
Notes: --
Workflow Jobs:  Processing Workflow
Email Log: Email Log
AFXLog: AFXLog®

Additional Information

D Default Provisioning Form ™ (For [TInfrlser, Test31 )
AccountTemplate.Account:  Test51ITInfrUser
AccountTemplate.CN:  Test31(TInfrUser

AccountTemplate.givenName:  Test51
AccountTemplate.mail:  Test31TInfrUser@ES-ldAM-B1.TEST

Attachments

Ne file selected. Upload Attachment

Status

Details: Fulfillment: 50% 1/2 Changes Fulfilled (0/0 Activities)

¥«

[® & Approval Phase

& Fulfillment Phase
[ & IT AFX Fulfillment
) Changes processed by AFX handler

AccountTemplate sAMAccountName:  Test51TInfrUser

AccountTemplatesn:  [TinfrUser

AccountTemplate.userPrincipalName:  Test31ITInfrUser@ES-IdAM-B1.TEST

() Verified
Account Changes i~
Search: P Table Options
Status Action Account Entitlement Type Business Source Entitlement State A
y = Create CN=Test31TInfrUser,ou=it,dc  Owner RSA Adaptive Directory ITInfrUser, Test31 Completed “

1661 =master,dc=test
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Figure 105. IMG New User Provisioned

Note: The state of the group add will remain pending, and the overall status will remain at 50%
until you recollect data from the Directories page so that IMG can detect that the user has been
added to the group successfully as shown in Figure 106.

7.4.2

Figure 106. IMG Successful User Add

Moving a User

Open your CSV file and change the attribute that defines the OU that the userisinto a
different OU.

Collect data again.

The OU change is detected, and IMG deletes the user from the original OU and adds the
user to the new OU.

Go to ‘Requests’ and ‘Activities’ and click ‘Perform’ as shown in Figure 107.
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7.
8.
9.

1
1
1

Figure 107. IMG Requests Activities

Select the group you would like the moved user to have access to, click ‘Next’ and
‘Accepted’, then ‘Finish’ on the final screen. As you did before for adding a new user.
Collect data again so IMG can confirm that the user is added to the appropriate group in
the new OU.

Terminating a user

Delete the user from the HR CSV file.

Collect data again.

0. The user is automatically removed.

1. Collect data again, so IMG can confirm the user is no longer in Adaptive Directory.

2. Check the Status in ‘Requests’, and ‘Requests’ as shown in Figure 108.
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Figure 108. IMG Request Status

RSA Adaptive Directory implements the central IdAM ID store in Build #2. It receives input from
central IdAM system (RSA IMG). The central ID store contains the distribution mechanism for
updating the various downstream (synchronized) directories with user access and authorization
data. This process applies to new users, terminated users (disabled or deleted users), and any
changes to a user profile. Changes include promotions, job responsibility changes, and any
other change that would affect the systems a user needs to access.

8.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for
authorized devices and users

NIST 800-53 rev 4 Security Controls: AC-2, IA Family

8.2 RSA ADAPTIVE DIRECTORY IS INSTALLED ON THE IDAM NETWORK, ON A VM THAT IS RUNNING

CENTOS 7

The following lines detail the command line installation procedure for RSA Adaptive Directory,
including displayed responses:
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[root@localhost ~]# 1s
anaconda-ks.cfg reports xml
[root@localhost ~]# cd
[root@localhost /]# 1s
bin dev home lib64 mnt proc run srv tmp var
boot etc lib media opt root sbin sys usr
[root@localhost /]# cd media
[root@localhost medial# 1s
cdrom
[root@localhost media]# cd cdrom
[root@localhost cdrom]# 1s
Documentation rsa_7.1.5_linux_64.bin rsa_7.1.5_windows_64.exe
[root@localhost cdrom]# su root ./rsa 7.1.5 linux 64.bin
Preparing to install...
WARNING: /tmp does not have enough disk space!
Attempting to use /root for install base and tmp dir.
Extracting the JRE from the installer archive...
Unpacking the JRE...
Extracting the installation resources from the installer archive...
Configuring the installer for this system's environment...

Launching installer...

Graphical installers are not supported by the VM. The console mode will be used instead...

RSA Adaptive Directory 7.1.5  (created with InstallAnywhere)

Preparing CONSOLE Mode Installation...

Please read the following License Agreement carefully.
LICENSE AGREEMENT
**% IMPORTANT INFORMATION - PLEASE READ CAREFULLY ***
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(...Lic agreement text omitted...)
DO YOU ACCEPT THE TERMS OF THIS LICENSE AGREEMENT? (Y/N): Y

Choose Install Folder

Please choose a destination folder for this installation

Where would you like to install?

Default Install Folder: /root/rsa/adaptivedirectory

ENTER AN ABSOLUTE PATH, OR PRESS <ENTER> TO ACCEPT THE DEFAULT: Enter

Please choose the Install Set to be installed by this installer.
>1- RSA Adaptive Directory New Cluster / Standalone

2- RSA Adaptive Directory Cluster Node

3- Customize...

ENTER THE NUMBER FOR THE INSTALL SET, OR PRESS <ENTER> TO ACCEPT THE DEFAULT:
Enter

New Cluster settings

Enter information below about the new cluster to create:
- The cluster name

- The ZooKeeper ports that will be used

Cluster name: (DEFAULT: clusterl): clusterl
ZooKeeper Ensemble Port: (DEFAULT: 2888): 2888
ZooKeeper Leader Election Port: (DEFAULT: 3888): 3888
ZooKeeper Client Port: (DEFAULT: 2181): 2181

Please provide the administrator name:

Admin User Name (DEFAULT: cn=Directory Manager): Directory Manager
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Server administrator password

Please provide a password for the administrator user :
Password (DEFAULT: ): secretsecret

Confirm Password (DEFAULT: ): secretsecret

Adaptive Directory port numbers

Please enter port numbers for Adaptive Directory:
Adaptive Directory Port (DEFAULT: 2389): 2389
Scheduler Port (DEFAULT: 1099): 1099

Adaptive Directory SSL Port: (DEFAULT: 1636): 1636

Adaptive Directory HTTP port numbers

Please enter port numbers for Adaptive Directory HTTP services:

Adaptive Directory HTTP Port (DEFAULT: 8089): 8089
Adaptive Directory HTTPS Port (DEFAULT: 8090): 8090

Certificate configuration

Use an existing certificate (Y/N)? (DEFAULT: N): N
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Application Server Configuration

Enter information below to configure the Application Server

- Administrator user name for initial server instance.

- Administrator password for initial server instance (must be at least 8
characters in length).

- Administration server port number for initial server instance.
- HTTP/HTTPS port number for initial server instance.

- JMX port number for initial server instance.

Admin User (DEFAULT: admin): admin

Password (DEFAULT: ): secretsecret

Confirm Password (DEFAULT: ): secretsecret

Admin Port (DEFAULT: 4848): 4848

HTTP Port (DEFAULT: 9090): 9090

HTTPS Port (DEFAULT: 9191): 9191

JMX Port (DEFAULT: 8686): 8686

Control Panel Configuration

These are the settings for the Web Server hosting the Control Panel.

Enter the HTTP/HTTPS ports to configure the Web Server on the main instance:
These are the settings for the Web Server hosting the Control Panel.

HTTP Port (DEFAULT: 7070): 7070

Enter the HTTP/HTTPS ports to configure the Web Server on the main instance:
HTTPS Port (DEFAULT: 7171): 7171

Port validation failed

Control Panel HTTP port These are the settings for the Web Server hosting the
Control Panel. is invalid.

Please select a new one.

PRESS <ENTER> TO ACCEPT THE FOLLOWING (OK): Enter
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Control Panel Configuration

These are the settings for the Web Server hosting the Control Panel.

Enter the HTTP/HTTPS ports to configure the Web Server on the main instance:
HTTP Port (DEFAULT: 7070): 7070

HTTPS Port (DEFAULT: 7171): 7171

Pre-Installation Summary

Please Review the Following Before Continuing:

Product Name: RSA Adaptive Directory 7.1.5

Install Folder: /root/rsa/adaptivedirectory

Install Set: RSA Adaptive Directory New Cluster / Standalone
Product Features: Application, Sample Data

Java VM Installation Folder: /root/rsa/adaptivedirectory/jdk
Administrator User: cn=Directory Manager

Adaptive Directory Ports: 2389 8089 8090

Scheduler Port: 1099

SSL Configuration: 1636

Start TLS Configuration: TLS is disabled.

Certificate Configuration: Self signed certificate.

App Server Configration: 4848 9090 9191 8686

Web Server Configuration: 7070 7171

Disk Space Information (for Installation Target):

Required: 1,164.03 MegaBytes

Available: 49,030.86 MegaBytes

PRESS <ENTER> TO CONTINUE: Enter
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1879

1880  ============ ==== ====
1881 Installation Complete

1882
1883  Congratulations. RSA Adaptive Directory 7.1.5 has been successfully installed to:

1884  /root/rsa/adaptivedirectory In order to start working with RSA Adaptive Directory 7.1.5, please
1885  follow these steps:

1886 - LOG OFF
1887 Then
1888 - LOG IN

1889 - Copy and paste your license key when prompted after running RSA Adaptive
1890 Directory 7.1.5

1891 -Run /root/rsa/adaptivedirectory/bin/openControlPanel.sh
1892  PRESS <ENTER> TO EXIT THE INSTALLER: Enter

1893 8.3 ADDITIONAL STEPS REQUIRED AFTER INSTALLATION IS COMPLETE

1894 Then you need to install netstat: yum install net-tools
1895 Copy the license.lic file to: /root/rsa/adaptivedirectory/vds_server

1896  Open all relevant firewall ports on the CentOS server

1897 Run /root/rsa/adaptivedirectory/bin/openControlPanel.sh
1898 Run /root/rsa/adaptivedirectory/bin/runContextBuilder.sh
1899  From a web browser go to: http:IPADDRESS:7070

1900  Start the server by clicking the Start button.

1901  Click on Tools menu item, and start the Application Server.

1902

1903  Configuration Procedure:

1904  From a web browser, connect to the Adaptive Directory server and log in (Note the URL with
1905 port number) using the following credentials: (Default credentials) See Figure 109.

1906 Username:cn=Directory Manager
1907 Password: secretsecret

1908
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Figure 109. Adaptive Directory Login Page

On the main page, Figure 110, start the Adaptive Directory server:

Figure 110. Adaptive Directory Main Page

On the Tools tab, Figure 111, click Start it to start the Persistent Cache service:
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1915

1916 Figure 111. Adaptive Directory Tools Page

1917 Now go to the Settings tab, Figure 112 and click Server Backend Settings and then click LDAP
1918  Data Sources.

1919
1920 Figure 112. Adaptive Directory Server Backend Settings

1921  Click Add.
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Figure 113. Adaptive Directory LDAP Data Source

Enter details for your “backend AD” as shown in Figure 113. Click the Test Connection button to
be sure your settings are correct. Repeat this process for all the AD clusters, i.e., for the backend
ADs on the IT, OT, and PACS networks. You can Clone your first connection to make repeat
additions easier.

Now click on Directory, click on Configuration, right-click on Root Naming Contexts, and select
Naming context as shown in Figure 114.
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1930

1931 Figure 114. Adaptive Directory Configuration of Naming Context

1932  You are presented with this screen, Figure 115:

1933

1934 Figure 115. Adaptive Directory New Naming Context

1935  Enter the “name” you would like your new Virtual LDAP directory to be configured with. Select
1936  Virtual Tree and click Next.
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Figure 116. Adaptive Directory Configure Virtual Tree

Leave the defaults selected as shown in Figure 116, and click OK. You will see the following
screen, Figure 117.

Figure 117. Adaptive Directory Virtual Tree

You now have a virtual directory naming context created, and the next step is to configure this
virtual directory to include all the backend AD clusters.

Right-click on your newly created Virtual Directory and select New Level as shown in Figure 118:
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Figure 118. Adaptive Directory Create New Level

Enter a “name” for this LDAP backend mapping. This name will be an OU in the Virtual
Directory as shown in Figure 119.

Figure 119. Adaptive Directory New Level Name

Right-click this new OU in your Virtual Directory and select Backend Mapping as shown in Figure
120.
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1954

1955 Figure 120. Adaptive Directory Backend Mapping

1956 Leave LDAP Backend selected and click Next as shown in Figure 121.

128 | NIST Cybersecurity Practice Guide SP 1800-2c



1957
1958

1959
1960

1961
1962

1963
1964

1965

DRAFT

Figure 121. Adaptive Directory Backend Mapping

Now select one of your backend AD clusters we configured earlier and click OK as shown in
Figure 122.

Figure 122. Adaptive Directory Configure LDAP Backend

Repeat this procedure for all your backend AD clusters (i.e., for the backend ADs on the IT, OT,
and PACS networks).

By default, the Adaptive Directory server will return default AD attributes.
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8.4 CusTOM ATTRIBUTE CONFIGURATION
Custom attributes are required and are configured as follows:

Click on Directory, then Configuration, and then expand the virtual directory you are working
with and select the backend mapping to AD to which you want to make changes. Then click the
Attributes tab and Add as shown in Figure 123.

Figure 123. Adaptive Directory Addition Attributes

Find the attribute you would like to add in the top drop-down list, and enter a “name” (it could
be the same or different) for the attribute you want Adaptive Directory to return. Then select
DN Remapping and click OK as shown in Figure 124.

Figure 124. Adaptive Directory Add/Edit Main Attribute

Complete this procedure for any additional custom attributes that are required and for any
additional AD backends to which you may need to add attributes.
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Your Adaptive Directory virtual directory is now complete and can be accessed from RSA IMG /
Aveksa or any other application that can access LDAP directories.

You can address this virtual directory by configuring the connecting application with the IP
address or DNS name of the Adaptive Directory server and using port 2389. For the base DN,
you would use the name of your virtual directory—in the above example, ‘dc=master,dc=test’
and the relevant OU (backend AD cluster) you want to access. You would use the same
username (cn=Directory Manager) and password you use to log in to the application.

For example, Figure 125 and Figure 126 show the connection information from RSA IMG to
Adaptive Directory.

Figure 125. Adaptive Directory Edit Collector

Search Configuration for Accounts
Accounts will be created by the User Account Mapping, unless the Accounts opticn is selected in this collector.

Account Base DN* ;| He=master,dc=test X

Account Search :
Subtree |V
Scope™ J

Account Search @ | (&(objectCategory=person){objectClass=user)(sAMAccountName=*})
Filter*

Figure 126. Adaptive Directory Search Configuration for Accounts

8.5 RSA AD OPTIMIZATION AND TUNING

8.5.1 Disable Referral Chasing
Referral chasing should be disabled for performance reasons. Check the Disable Referral Chasing
option when you define the LDAP data source.
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8.5.2  Limit Attributes Requested from the LDAP Backend

Whenever RSA Adaptive Directory queries a backend LDAP, the default behavior is to ask for all
attributes (although only the attributes requested in the query will be returned to the client).
This default behavior of RSA Adaptive Directory is for the following reasons:

¢ Joins have been configured and the filter in the search request involves attributes from
both the primary and secondary sources (i.e., the query filter contains conditions on
both primary and secondary objects).

* Interception scripts may involve logic based on attributes from the backend and so
require these attributes. These attributes may not be specifically requested or searched
for by the client. However, RSA Adaptive Directory must retrieve them from the backend
in order for the script logic to be valid.

e Access Control List (ACL) checking. You can set up ACLs based on attribute/values of an
entry (e.g., mystatus=hidden), so RSA Adaptive Directory may need the whole entry to
check the authorization.

e For entry caching. The entire entry needs to be in the entry cache.

If your virtual view does not require all attributes to be requested for any of the conditions
mentioned above, you can enable the option to limit the attributes that are requested for
better performance. If this option is enabled, RSA Adaptive Directory will query the backend
server only for attributes requested from the client in addition to attributes set as Always
Requested on the Attributes tab.

8.5.3  Process Joins and Computed Attributes Only When Necessary

The default behavior of RSA Adaptive Directory is to process associated joins and build
computed attributes whenever a virtual object is reached from a query regardless of whether
the attributes requested come from a secondary source or computation. If you enable the
option to process joins and computed attributes only when necessary, RSA Adaptive Directory
will not perform joins or computations when a client requests or searches for attributes from a
primary object only. If a client requests or searches for attributes from secondary objects or
computed attributes, RSA Adaptive Directory will process the join(s) and computations
accordingly. Use caution when enabling this option if you have interception scripts defined on
these objects or if access controls based on filters are being used (both of which may require
other attributes returned from secondary sources or computations regardless of whether or not
the client requested or searched for them).

8.5.4  Use the Client Sizelimit Value to Query the Backend

Whenever Adaptive Directory queries a backend LDAP, the default behavior is to ask for all
entries (sizelimit=0) even if the client to Adaptive Directory indicates a sizelimit. This is the
default behavior because the entries returned by the backend are possible candidates but may
not be retained for the final result that is sent to the client. For example, if an ACL has been
defined in Adaptive Directory, not all entries from the backend may be authorized for the user
(who is connected to Adaptive Directory) to access. As another example, when joins or
interception scripts are involved with the virtual view, they may also alter the entries that match
the client's search. To limit the number of entries from the backend, using paging is the
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recommended approach. If the backend supports paging, Adaptive Directory will not get all the
results at once; rather, it will get only one page at a time (pagesize is indicated in the
configuration). In this case, if Adaptive Directory has returned to the client the sizelimit
required, Adaptive Directory will not go to the next page.

If your virtual view does not involve any of the conditions mentioned above (joins,
interceptions, ACL), and using paging between Adaptive Directory and the backend is not
possible, you can enable the Client Sizelimit value option to limit the number of entries
requested from the backend. If this option is enabled, Adaptive Directory will use the sizelimit
specified by the client instead of using sizelimit=0 when querying the backend.

AlertEnterprise Guardian is installed on the IdAM network, in a VM running the Windows Server
2012 R2 OS. Guardian is used to control privileged user access to the components located on
the network OT systems. Guardian collects user authorization information from the AD located
within the OT network. There are three parts to the AlertEnterprise Guardian How-To guide,
each of which is provided in the subsections below: Subsection 12.2 provides general product
installation and set-up information. Subsection 12.3 provides the AlertEnterprise configuration
information as configured in the RSA build. Subsection 12.4 provides the AlertEnterprise
configuration information as configured in the CA build.

9.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for
authorized devices and users

NIST 800-53 rev 4 Security Controls: AC-2, IA Family

9.2  INSTALLATION ON TOMCAT AND WINDOWS

This section describes the detailed procedure of installing AlertEnterprise products on Tomcat
on a Windows platform. It lists the hardware and software pre-requisites as well as the steps to
install and use the AlertEnterprise suite of applications.

When copying text from this guide, it is recommended that you first paste text to a Notepad file
and then copy it from there to use it for running scripts. You should use the “Notepad++”
application for this purpose.

Installation Prerequisites

The AlertEnterprise Suite is delivered as a WAR (Web application Archive) file that needs to be
deployed on the client’s application server. Before you actually start deploying on your
application server, you must check for the pre-requisites. Refer to AlertEnterprise Systems
Requirements document included in the installation package.

Pre-Installation Verification
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2073  Before you start installing AlertEnterprise product, verify the proper functioning of the
2074  underlying software systems. Verify that:

2075 e Your system meets all the software and hardware prerequisites as described in Systems
2076 Requirement Specification document.

2077 e Compatible version of Java Runtime Environment (JRE) is installed and working on the
2078 system.

2079 e Compatible version of the web server is installed and running.

2080 e Compatible version of the database server is installed and running.

2081 e Supported Internet Browser (for example, Microsoft Internet Explorer) is working

2082 properly.

2083  Zip extracting software is required. You can download WinZip from
2084  www.winzip.com/downwz.com.

2085 Installing Mandatory Software Applications

2086 Before deploying the AlertEnterprise application, install JRE and a Web Application Server (for
2087 example, Tomcat). You must also install the latest version of Adobe Flash Player to enable the
2088 Internet browser you will be using to access the AlertEnterprise application.

2089 Installing JRE
2090 Toinstall JRE:

2091 1. Download the application server-compatible JRE.
2092 2. Double-click the setup launcher to start the installation process.

2093  Setting Java Home

2094 1. Make sure that JAVA_HOME variable is set to the folder where Java is installed and
2095 $JAVA HOME$/bin isinthe system’s path.

2096 2. Open the Command Prompt in Administrator Mode (Right Click > Run As Administrator)
2097 and issue:

2098

2099 Set JAVA_HOME=<PATH OF JDK/JRE>

2100

2101 Where <PATH OF JDK/JRE> is the path where Java is installed, for example,

2102 C:\Program Files\Java\JDK1.6

2103

2104 3. Setting Path:

2105

2106 PATH= C:\Program Files\Java\JDK1l.6.0-21\bin; $PATHS

2107

2108 4. Checking JAVA_HOME and PATH:

2109

2110 Echo %JAVA_HOME%
2111 Echo %PATH%

NIST Cybersecurity Practice Guide SP 1800-2c



2112

2113
2114
2115
2116
2117
2118
2119
2120
2121

2122
2123

2124
2125

2126
2127
2128
2129
2130
2131
2132
2133
2134
2135

DRAFT

Checking JAVA Version: Java -version

Running ActiveMQ as Windows Service
After extracting the folder, the folder name appears as “apache-activemq” at the specified
location.

1. Gotothe folder apache-activemg and move to bin/win32 in Windows
Explorer and right-click on TnstallService.bat file and select Run as
Administrator. Refer to .

2. Once the above batch file gets executed, verify that the ActiveMQ is added as Windows
Services.

3. Goto Run command and enter services.msc. The Services window appears. Refer
to the following screen shot.

" Services

File Action View Help

& |[EEa= Hs »nn

£ Services (Local) . Services (Local)

ActiveMQ Name Description Status Startup Type Log On As

Stop the sence o Activex Installer (.. Provides Us.. Manual Local Syste...

Restart the service

- " Adaptive Brightness Monitors a... Manual Local Service
i Adobe Flash Playe... This service ... Manual Local Syste...

DES_“iF'tiU”: i Apache Tomcat Apache To... Manual Local Syste...

ActiveMQ Broker i Apache Tomcaté  Apache To.. Automatic Local Syste...
. Application Experi... Processesa.. Started Manual Local Syste...

- Annlication Identity  Determines . IManual Local Service

Figure 127. Adaptive Directory Search Configuration for Accounts

4. The Apache ActiveMQ service has an administrative console. To check if the service is

running correctly, you simply need to connect to the admin console.
URL: <IP address of the server where Active MQ is
installed>:8161/admin

5. Perform the following if Active MQ is on a server other than AlertEnterprise server:
e Search for the URL that starts with TCP ://<IP Address>:61616 in
activemqg.log located in Apache ActiveMQ home directory/data folder.
Refer to the following screen shot:
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Figure 128. Guardian ActiveMQ Home/Data Directory

e Copy the URL and update the context.xml fileinthe <Tomcat
Home>/conf and appContextDB.properties filelocatedin
<Tomcat Home/webapps/AlertEnterprise/WEB-INF/classes>.

Steps for Failure Case:
If the system throws an error message while executing the bat file or the ActiveMQ Services
screen does not appear, follow these steps:

1. Navigate to the folder <ActiveMQ home directory>\bin\win32.

2. Openthe InstallService.bat filein alocal text editor.

3. Modify the bottom part of the script to look like the following. Note that your
JAVA_HOME environment variable needs to already be set and also need to pass it as a
variable to the wrapper.

:conf

set WRAPPER CONF="$ACTIVEMQ HOME$\bin\win32\wrapper.conf"
set ACTIVEMQ HOME="set.ACTIVEMQ HOME=%ACTIVEMQ HOMES$"

set ACTIVEMQ_BASE="Set.ACTIVEMQ_BASE=%ACTIVEMQ_BASE%"

set JAVA HOME="set.JAVA HOME=%JAVA HOMES%"

rem

rem Install the Wrapper as an NT service.

Rem

:startup

"$ACTIVEMQ HOME$\bin\win32\wrapper.exe" -i $ WRAPPER CONF%
$ ACTIVEMQO HOME$ $ ACTIVEMQ BASE$ % JAVA HOMES$

if not errorlevel 1 goto :eof
pause

4. Openthe <ActiveMQ home directory>\bin\win32\wrapper.conf ina
local text editor and change this:

# Java Application
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wrapper.java.command=java

to this:
# Java Application

wrapper.java.command=%JAVA HOMES$\bin\java.exe

After you have performed these steps, you should be able to run the TnstallService.bat
successfully.

5. Toalsousethe UninstallService.bat file, open itand hard-code the path to
the wrapper:

rem
rem Uninstall the Wrapper as an NT service.

rem

:startup

"$ACTIVEMQ HOME$\bin\win32\wrapper.exe" -r % WRAPPER CONF$%
if not error level 1 goto : eof

pause

After executingthe InstallService.bat file, you can see the ActiveMQ in Services.
6. If the ActiveMQ server is not up and the system throws the following error:

| WARN | tmpdir | org.eclipse.jetty.util.log | WrapperSimpleAppMainjava.io.|lOException: The
system cannot find the path specified

at java.io.WinNTFileSystem.create File Exclusively (Native Method)
at java.io.File.check And Create (File.java:1343)

at java.io.File.create Temp File (File.java:1431)

Solution:
You must manually create two folders: <ActiveMQ home directory>/work and
<ActiveMQ home directory>/temp.

To check whether ActiveMQ is started, access the following link as shown in Figure 129.
http://<Server IP Address>:8161/admin/
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Figure 129. Guardian ActiveMQ

Installing Apache Tomcat
You must install hardware and operating system versions specific to Apache Tomcat:

Double-click the setup launcher to start the setup. It will start the installation process.
Click Next to start the installation process.

1.
2
3. Click | Agree to accept the license terms. It displays the Choose Components screen.
4. Select Custom as install type and uncheck the Examples option.

5

Click Next to specify the Destination Folder for installation. We strictly recommend using
D:\AlertEnterprise\Tomcat location.

Click Next to specify configuration parameters.
Enter the desired port in the Connector Port text area. 8080 is the default port.

Specify the User Name and Password in the respective fields.

L ® N O

Click Next to select the path of JRE installed on the system.

10. Select the path of JDK/JRE you just installed. For example, C: \ Program
Files\Java\jrel.6.

11. Click Install to start the file copying process. Uncheck Run Apache Tomcat and Show
Readme options in the final dialog box.

12. Click Finish to finish the installation.

Apache Tomcat Configuration
You need to specify Tomcat configuration as specified in the following steps:
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1. Click Start > Programs > Apache Tomcat > Configure Tomcat option.
2. Click Java tab in the Apache Tomcat Properties dialog box.
3. Enter the following settings:

e Initial memory pool: 1024

e Maximum memory pool: 1024

e Thread stack size: 300

Note: These settings may vary with the volume of random access memory (RAM) in
the server.

4. Click Apply and OK to close the dialog box.

Configuring Database Server

You need to perform some configurations in the database server to install AlertEnterprise
applications. You must perform these configurations through the database administrator login.
The current version of AlertEnterprise products supports Oracle and MS SQL Server databases.
The NCCoE build also supports MySQL server database.

To configure the database server:

1. Create a schema/SID as per your naming convention in the database server. The steps to
create schema can be different with different database management systems. Refer to
the administrators guide for the database management system installed at your
landscape.

2. Create a new user with full access to the created schema.

3. Runtheincluded SQL files AlertReport471.ddl or AlertReport471.sql
and AlertQuartz.sqgl onthe new schema created. This step should be performed
while installing the AlertEnterprise application for the first time.

Avoiding Case-sensitivity Issues in Alert DB

To avoid case-sensitivity issues while using the search and sort functionalities in the
AlertEnterprise applications, enable “Case Insensitiveness” search in the database. By default, it
is set as case-sensitive.

Follow these steps to avoid case-sensitivity issues:
1. Create a trigger to support case insensitiveness.

/***********/

create or replace
trigger set nls onlogon
AFTER LOGON ON SCHEMA
DECLARE
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BEGIN
EXECUTE IMMEDIATE 'ALTER SESSION SET NLS SORT="BINARY CI"';
EXECUTE IMMEDIATE 'ALTER SESSION SET NLS COMP="LINGUISTIC"';

END set nls onlogon;
/************/

2. Restart the AlertEnterprise Application server.

The effect may not be visible in some client tools like SQL Developer. To see the effect in the
SQL Developer tool: :
1. Open SQL Developer and click Tools > Preferences.

2. Click Database > NLS and do the following:
e Setthe Sort option to BINARY CI.

e Set the Comparison option to LINGUISTIC.

Enabling Support for International Characters
Storage of character data is controlled by character-set setting at database level. It is
recommended to have the following database settings to support international characters:

For Oracle:
NLS CHARACTERSET = AL32UTFS8

NLS NCHAR CHARACTERSET = AL16UTF16

For SQL Server:
e Server Collation = SQL Latinl General CP1 CI AS

Deploying the Application

After you have successfully configured the database, proceed to deploy the AlertEnterprise
product on your web application server. The following deployment steps are required for the
Tomcat 6.0 version:

1. Stop the Tomcat server from the Windows services if it is already running. Click Start >
Run and type services.msc then click OK. Select the Apache Tomcat and click the
Stop Service icon to stop the service.

2. Copythe AlertEnterprise.war, AccessMap.war (if you possess Alertinsight
license), and AlertEnterpriseHelp.war, and jasperserver—-pro.war files
to <Tomcat installation folder>\webapps\ path.

3. You need to copy password management war file ATPM. war to <Tomcat
installation folder>/webapps if you possess license for the Password
Management application.

4. Create anew folder AlertCommonLib and AlertExternalLib under
<Tomcat Installation Folder>.
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5. Extract AlertCommonLib.zip under AlertCommonLib folder.You will see
many new files in this folder.

6. Editthe <Tomcat Installation Folder>\conf\catalina.properties
using any editor and add append the following to the common . loader as described
below:
common.loader=${catalina.base}/lib,5{catalina.base}/lib/*.jar,${catalina.home}/lib,${cat
alina.home}/lib/*.jar,${catalina.home}/AlertCommonLib/*.jar,${catalina.home}/AlertExt
ernalLib/*.jar (bold path added). Save the file and close the editor.

7. Add Database Connection. Add a new <resource> entry as below with name
"idbc/alntdb" in < Tomcat installation folder>\conf\context.xml.
Replace the code in <> with relevant information.

For MY-SQL Server:

<Resource

description="DB Connection"

name="jdbc/alntdb" auth="Container"
type="com.mchange.v2.c3p0.ComboPooledDataSource"
factory="org.apache.naming.factory.BeanFactory"

user="username"

password="password"

jdbcUrl="jdbc:mysqgl://<IP of DB Server>:3306/<DB Instance Name>"
driverClass="com.mysqgl.jdbc.Driver"

maxPoolSize="100" minPoolSize="5" acquirelIncrement="5"

numHelperThreads="20" maxIdleTime="600"
maxIdleTimeExcessConnections="300"

debugUnreturnedConnectionStackTraces="true"
unreturnedConnectionTimeout="900"

/>

For repository setting in same context . xml, add the following entry:

<Resourcelink name="AlertEnterpriseRepo" global="AlertEnterpriseRepo"
type="javax.jcr.Repository" />

For ActiveMQ settings in same context.xml, add the following entry:

<Resource name="jms/connectionFactory"
auth="Container"
type="org.apache.activemg.ActiveMQConnectionFactory"
description="JMS Connection Factory"
factory="org.apache.activemqg. jndi.JNDIReferenceFactory"
brokerURL="tcp://localhost:61616"
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brokerName="LocalActiveMQBroker"
useEmbeddedBroker="false"/>

<Resource name="jms/requestSubmissionQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue requestSubmissionQueue"
factory="org.apache.activemqg.jndi.JNDIReferenceFactory"
physicalName="requestSubmissionQueue"/>

<Resource name="jms/requestApprovalQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue requestApprovalQueue"
factory="org.apache.activemqg. jndi.JNDIReferenceFactory"
physicalName="requestApprovalQueue"/>

<Resource name="jms/autoApprovalQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue autoApprovalQueue"
factory="org.apache.activemqg.jndi.JNDIReferenceFactory"
physicalName="autoApprovalQueue"/>

<Resource name="jms/queue/taskSubmissionQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue taskSubmissionQueue"
factory="org.apache.activemqg. jndi.JNDIReferenceFactory"
physicalName="taskSubmissionQueue"/>

<Resource name="jms/queue/taskRejectionQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue taskRejectionQueue"
factory="org.apache.activemqg.jndi.JIJNDIReferenceFactory"
physicalName="taskRejectionQueue"/>

<Resource name="jms/queue/projectCancelQueue"

auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue projectCancelQueue"
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factory="org.apache.activemqg. jndi.JNDIReferenceFactory"

physicalName="projectCancelQueue"/>

<Resource name="jms/queue/projectCompleteQueue"
auth="Container"
type="org.apache.activemqg.command.ActiveMQQueue"
description="JMS Queue projectCompleteQueue"

factory="org.apache.activemqg. jndi.JNDIReferenceFactory"

physicalName="projectCompleteQueue"/>

<Resource name="jms/eventRequestQueue"
auth="Container"

type="org.apache.activemqg.command.ActiveMQQueue"

description="JMS Queue eventRequestQueue"

factory="org.apache.activemqg. jndi.JNDIReferenceFactory"

physicalName="eventRequestQueue" />

<Resource auth="Container" description="my Queue"
factory="org.apache.activemqg. jndi.JNDIReferenceFactory"
name="jms/regQueue" physicalName="requestQueue"
type="org.apache.activemqg.command.ActiveMQQueue" />

<Resource auth="Container" description="my Queue"
factory="org.apache.activemqg.jndi.JNDIReferenceFactory"
name="jms/resQueue" physicalName="responseQueue"
type="org.apache.activemqg.command.ActiveMQQueue"/>

8. Edit <Tomcat installation folder>\conf\server.xml.Replacethe

code in <> with relevant information:

<GlobalNamingResources>
<! -- Editable user database that can also be used by
UserDatabaseRealm to authenticate users
->
<Resource auth="Container"
configFile="/AlertEnterpriseRepo/repository.xml"
description="AlertEnterprise Repository"

factory="com.alnt.repository.jndi.JackrabbitRepositoryFactory"

homeDir="/AlertEnterpriseRepo" name="AlertEnterpriseRepo"
type="javax.jcr.Repository"/>

<Resource auth="Container" description="Rule Engine Service"

factory="com.sae.ruleengine.jndi.RuleEngineFactory"
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name="Sedna" password="MANAGER" type="com.sae.rulekEngine.RuleEngine"
username="SYSTEM" />

<Resource name="UserDatabase" auth="Container"
type="org.apache.catalina.UserDatabase"

description="User database that can be updated and saved"
factory="org.apache.catalina.users.MemoryUserDatabaseFactory"
pathname="conf/tomcat-users.xml"/>

</GlobalNamingResources>

9. Open <Webserver installation folder>\bin location and double-click tomcat5w.exe. Click
Java tab and under Java options add the following lines at the end:

-XX:PermSize=512m
-XX:MaxPermSize=512m
-Xms1024m

-Xmx1024m

-Djs.license.directory=C:\AlertApplication\Tomcat
6.0\webapps\jasperserver-pro

-Dcom.alnt.fabric.loadInitData=force
-Dalert.db.update=update

Note: These settings may vary with the volume of RAM in the server.

10. Start the Tomcat server.

11. Start the AlertEnterprise application by using the address, which is of the form
http://<Server IP Address>:8080/AlertEnterprise.
Note: The name and contents of the init script will vary depending on the database
management system of the organization. 8080 is the default port on local host. If you
want to change it, then change it in the sever.xml.

12. Log on to the application by using admin credentials. You should be able to view Home
screen of the application.

9.3  ALERTENTERPRISE APPLICATION CONFIGURATIONS FOR THE RSA BUILD
Systems/Connectors

9.3.1 System Type Import of DB Connector:
1. Login to Application.
2. Go to Setup tab > Manual Configuration > Import/Export.

3. Check System Types and click on Import.
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4. Select the .csv files, which are there in the software build package under connector

\ALNTDbconnector\InitDataFiles folder.

5. After selecting all the files, click on the Upload button.

6. Refresh page until it shows as success or failed.

7. Restart the server if required.

9.3.2  System Types Param of DB Connector:

1. Login to Application.

2. Go to Setup tab >Manual Configuration >Systems > System Types.

W

Click on Next button.

b

Search for Connector named “DBConnector” and click on Modify button.

Add the following attributes one by one and click on the ADD button —

The following fields need to be provided under Name field and Label can be any user-

friendly name see Figure 130.

CREATE USERO
UPDATE_USERO
LOCK_USERO
UNLOCK_USERO
DELIMIT USERO
USER_PROVISIONEDO
ADD_ROLESO
DEPROVE ROLESO
CREATE_USER1

LOCK USERI1
Name Label Parameter Level
jndiMame Indi Mame Mandatary
DATE_TIME_FORMAT Date and Time Forma... tMandatary
DATE_TIME Date Format Mandatory
passwordColumnkame Passwrd Column Mame Mandatary
userldColumnMarne Userld Caolurmn Marne Mandatary
EXTERMAL_USER_ID_AT... External Userld Att.., Mandatory
MODIFIED_ENTITLEMEN. .. Fetch User Entitlem... Mandatory
GET_aLL_USERSO GET_ALL_USERSO Mandatory
GET_INCREMEMTAL_USE... GET_INCREMEMTAL_USE. .. Mandatory
CREATE_USERD Create CardHolder 3., Mandatory
UPDATE_USERD Update CardHaolder Q... Mandatory
LOCK_USERD Lock CardHolder Que... Mandatory
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UMLOCK_USERD Unlock Card Holder ... Mandatary
DELIMIT_WSERD Change CardHalder ... Mandatary
USER_PROVISIOMEDO Check Card Holder P... Mandatary
ADD_ROLESO Assign Raoles ta Car... Mandatary
DEPROWE_ROLESO Femove Roles From C... IMandatary
GET_GEMERATED_USERI... Retrieve User Id Qu... IMandatary
driverMame driverMame Mandatary
url LREL IMandatory
LserMame userMarme Mandatary
passwaord password Mandatory

Figure 130. Guardian DB Connector Attributes

CONFIGURATION: Create “PACS AD” System

1. Setup > Manual Configuration > Systems > System.

2. Click on New to create a new system.

3. Definition...Enter the following:

e System Type— LDAP from drop-down

e Connector Name - PACS AD

e Connector Description - PACS AD

e Connector Long Description - PACS AD

e Connector Type — LDAP (default)

4. Click on Next.

5. Parameters...Enter the following:

Table 9. Guardian PACS AD Parameters

System Param Name

System Param Value

bindPass 060yplUQT3I0gHMbuRWeuw==
useSSL FALSE

baseDns DC=pacs-es-idam-b1,DC=test
groupBaseDn DC=pacs-es-idam-b1,DC=test
reconBaseDN

getincrementGrpChanges

FALSE
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System Param Name

System Param Value

wsdlURL

wsUserName

wsPwd

rootLevelDomain

cookielLocation

adUserName

SYS_CON_ATTR_POST_CREATE_SCRIPT

SYS_CON_ATTR_POST_CREATE_SCRIPT_PARAMS

objectClass User
Skipprovisioning Yes
lastModifiedColumnRole whenChanged
lastModifiedColumn whenChanged
host 172.16.7.2
port 389
CN=AlertEnterprise,
bindDn CN=Users,DC=pacs-es-idam-b1,DC=test

6. Click on Next.
7. Attributes...Enter the following:

e Application — Alert Access

e Check the following boxes — Provisioning, Role Management, Offline System.

e Leave Connector Category as Production.

e Time Zone — Greenwich Mean Time from drop-down

8. Click on Next.

9. Click on Save.

CONFIGURATION: Create “Identity DB” System
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1. Setup > Manual Configuration > Systems > System.

2. Click on New to create a new system.

3. Definition...Enter the following:

System Type — Database (JDBC J2EE) from drop-down

Connector Name — IDENTITYDB

Connector Description - IDENTITYDB

Connector Long Description - IDENTITYDB

Connector Type — Database (JDBC J2EE) (default)

4. Click on Next.

5. Parameters...Enter the following:

Table 10. Guardian Identity DB Parameters

System Param Name

System Param Value

driverName

url

userName

password

whereClause

jndiName

java:comp/env/jdbc/alntdb

6. Click on Next.

7. Attributes...Enter the following:

Application — All

Check the following boxes — Provisioning, Certification, Identity Provider, Allow
Modify Role and Allow Time Change.

Leave Connector Category as Production.

Time Zone — Eastern Daylight Time from drop-down

8. Click on Next.

9. Click on Save.

CONFIGURATION: Create “ACCESSIT PACS” System
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2544 1. Setup > Manual Configuration > Systems > System.
2545 2. Click on New to create a new system.

2546 3. Definition...Enter the following:

2547 e System Type — DBConnector from drop-down
2548 ¢ Connector Name — ACCESSIT PACS

2549 e Connector Description - ACCESSIT PACS

2550 e Connector Long Description - ACCESSIT PACS
2551 e Connector Type — DBConnector (default)
2552 4. Click on Next.

2553 5. Parameters...Enter the following:

2554 Table 11. Guardian ACCESSIT PACS Parameters

System Param Name

System Param Value

driverName

URL jdbc:sqlserver://<HOST_NAME>:<PORT>;databaseName=Al
Universal

userName DB User Name

password DB User Password

Date and Time Format

CardholderID

External Userld Attribute

CardholderID

Create CardHolder Query

INSERT INTO
[AlUniversal].[dbo].[Cardholders]([CardholderID],[LastName],[FirstName],[Middlelnitial],[C
ompanylID],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[CreatedByUser],
MemberOfAllSites],[UserText1],[UserText2],[UserText3],[UserText4],[UserText5],[UserText6
1,[UserText7],[UserText8],[UserText9],[UserText10],[UserText11],[UserText12],[UserText13],
[UserText14],[UserText15],[UserText16],[UserText17],[UserText18],[UserText19],[UserText2
0],[Department],[UserDatel],[UserDate2],[UserDate3],[UserDate4],[UserDate5],[UserNum
ericl],[UserNumeric2],[UserNumeric3],[UserNumeric4],[UserNumeric5],[CardholderStatus
],[CardholderActiveDate],[CardholderExpireDate]) VALUES
(NEWID(),SLastName,SFirstName,SMiddlelnitial, SCompanylD,SNotes,GetUTCDate(),'alerte
nt',GetUTCDate(),'alertent’,'1',SUserText1,SUserText2,SUserText3,SUserText4,SUserText5,$
UserText6,SUserText7,SUserText8,SUserText9,SUserText_10,SUserText_11,SUserText_12,$
UserText_13,SUserText_14,SUserText_15,SUserText_16,SUserText_17,SUserText_18,SUser
Text_19,SUserText_20,SDepartment,SUserDatel,SUserDate2,SUserDate3,SUserDate4,SUs
erDate5,SUserNumericl,SUserNumeric2,SUserNumeric3,SUserNumeric4,SUserNumeric5,'
1',SCardholderActiveDate,SCardholderExpireDate)

Update CardHolder Query

update [dbo].[Cardholders] set LastModified=GetUTCDate() where
CardholderID=$CardholderID
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System Param Name

System Param Value

Lock CardHolder Query

update [dbo].[Cardholders] set CardholderStatus='0' where CardholderID=$CardholderlD

Unlock Card Holder Query

update [dbo].[Cardholders] set CardholderStatus='1' where CardholderID=$Cardholder|D

Check Card Holder Provisioned
Query

select CardholderlID from [dbo].[Cardholders] where CardholderID =$CardholderiD

Assign Roles to Card Holder Query

INSERT INTO [dbo].[CardholderAccessLevels] ( [CardholderAccessLevellD],
[CardholderID], [AccessLevellD],[LastModified],[ActivateDate],[ DeactivateDate]) VALUES (
NEWID(), SCardholderID,(select AccessLevellD from [dbo].[AccessLevels] where
AccessLevelName=SROLE_NAME),GetUTCDate(), NULL, NULL)

Remove Roles From Card Holder
Query

delete from [dbo].[CardholderAccessLevels] where CardholderID=$CardholderID and
AccessLevellD=(select AccessLevellD from [dbo].[AccessLevels] where
AccessLevelName=SROLE_NAME)

Retrieve User Id Query

select CardholderlID from [dbo].[Cardholders] where UserText1=SUserText1

CREATE_USER1

INSERT INTO [AlUniversal].[dbo].[Cards]
([CardID],[CardholderID],[CardNumber],[FacilityCode],[PINNumber],[PINExempt],[APBExe
mpt],[UseExtendedAccessTimes],[CardStatus],[ActiveDate],[ExpireDate],[UserLevel],[UseC
ustomReporting],[Eventinfo],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[
CreatedByUser],[IssueLevel],[DeactivateExempt],[VacationDate],[VacationDuration],[UseCo
unt],[TempDeactivateStart],[TempDeactivateEnd], [Classification],[IPLocksetUserType],[IPLo
cksetAccessMode],[IPLocksetCredentialFormat],[IPLocksetAccessAlways],[RawPrimaryCred
ential],[LargeEncodedCardID],[EmbossedNumber]) VALUES (NEWID(),(select CardholderID
from [dbo].[Cardholders] where
UserText1=SUserText1),SCardNumber,SFacilityCode,$PIN,'0','0','0','1',NULL,NULL,'0','0',NUL
L,NULL,SYSDATETIME(), alertent’,SYSDATETIME(), 'alertent",'0','0', NULL,'0",'255',NULL,NULL,'
Active',NULL,NULL,NULL,NULL,NULL,NULL,")

LOCK_USER1 Fgadrzts u[:: ;J:ri]v:esrézlga[gz;]ggfrds1 set Cardstatus='0",Classification='InActive' where
2555 6. Click on Next.

2556 7. Attributes...Enter the following:

2557 e Application —All

2558 * Check the following boxes — Provisioning, Role Management, and Offline System.
2559 e Leave Connector Category as Production.

2560 e Time Zone — Eastern Daylight Time from drop-down

2561 8. Click on Next.

2562 9. Click on Save.

2563 Identity & Access— Enable Identity

2564 1. Setup > Manual Configuration >ldentity & Access>Enable Identity.

2565 2. Enable the following for “Identity DB” system, see Figure 131.
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Figure 131. Guardian Identity Configuration

9.3.3 Identity & Access— User Field Mapping
1. Setup > Manual Configuration > Identity & Access > User Field Mapping.
2. Select User = Identity (from drop-down) and click on Go.

3. Click the Create New button.
Select values for respective fields and hit on save (Refer to below sheet for values
selection.)

4. Repeat Steps 1-4 for all fields in the sheet.
Follow the steps above to configure the User Field mappings manually. You can match the
values in the file at https.//nccoe.nist.gov/sites/default/files/nccoe/UserFieldMapping_data.csv.

Identity & Access > Recon Authoritative Fields

1. Setup > Manual Configuration > Identity & Access > Recon Authoritative Fields.
2. Click on Create.

3. Enter the following shown in Figure 132.

Recon Authoritative Fields
Systems Authoritatiwe Field
DBCOMMECTOR Firsthame
DBCONMECTOR LastMame
PACS AD PacsallDoors
PaCs AD PacsHomeAccess
PACS AD PacswWorkaccess
PACS AD FirstMame
PACS AD LastMame

Figure 132. Guardian Recon Authoritative Fields

Identity & Access > Request Categories

1. Setup > Manual Configuration > Identity & Access > Request Categories.
2. Click on New.
3. Enter following at define Request Category screen:

e Name — New Hire

e Description — New Hire
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Visible — Yes

Hover Text —

Provisioning Actions — Create User, Change Roles
Request Category Type - Resources

Display the following in USS — Enterprise Roles

4. Click on Save.

5. Repeat similar to above for following Request Categories:

Termination

Name — Change Access

Description — Change of Access

Visible — Yes

Hover Text —

Provisioning Actions — Create User, Change Roles, Change User
Display the following in USS — Resources

Add Existing — Systems and Remove Roles

6. Click on Save.

ChangeAccess

O

O

O

Name — Terminate

Description — Terminate User

Visible — Yes

Hover Text —

Provisioning Actions — Lock User, Change Roles
Display the following in USS — Resources

Add Existing — Systems

7. Click on Save.

Identity & Access>Provisioning>Provisioning Mapping

1. Setup > Manual Configuration > Identity & Access > Provisioning > Provisioning Mapping.

2. On the next screen select System and click Next.
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3. Follow the mapping shown in Figure 133 to Create/Update provisioning mappings for
the ACCESS IT PACS system.

DB Connector Attribute Mapping

DB Connector Atribute

UserTextl
Firsthame
LastName
CompanylD
CardholderlD

Mandatory
No
Ves
Vs
No

Ves

DB Connector Connector Name
Connector Type

AertEnterprise Attrib...

Userld
Firsthlame
LastName
Prianty
Userld

DBConnector

ACCESSIT PACS

Defalt Value

Editable
Ho
Yes
Yes
Mo

Yes

Visible Validati... Is User-...
Ho Ho Ho
Yes Ho Ho
Yes Mo Mo
Mo Mo Mo
Yes Mo Mo

Figure 133. Guardian DB Connector Attribute Mapping

User Data> User Data Source

1. Setup > Manual Configuration > User Data > User Data Source.

2. Follow the mappings and configurations found in the files at
https://nccoe.nist.gov/sites/default/files/nccoe/UserManagement-UserDataSource.zip.
Create/Update accordingly.

User Data> User Mapping

1. Setup > Manual Configuration > User Data > User Mapping.

2. Select “Identity DB” system from the list and click on Save button.

Policy Engine> Rules

1. Setup > Manual Configuration > Policy Engine > Rules.

2. Click on New and add the following:

Table 12. Guardian Policy Engine Rules

Rule Name

Entity Type

Rule Type

Description

Applicable to

Attributes

Drop down value

Selection Value

All Door Access New

Workflow

AlertAccess

All Door Access New

Suggest/Default

PacsALLDoors AND Request Category

Equals

1. True and New Hire

2. True and Remove User
Access

3. True and ChangeAccess

Home Access Level New

Workflow

AlertAccess

Home Access Level New

Suggest/Default

PacsALLDoors AND Request Category

Equals

1. True and New Hire

2. True and Remove User
Access

3. True and ChangeAccess

WO Access Level New

Waorkflow

AlertAccess

WO Access Level New

Suggest/Default

PacsALLDoors AND Request Category

Equals

1. True and New Hire

2. True and Remove User
Access

3. True and ChangeAccess
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Policy Engine> Suggest/Default Access

1. Setup > Manual Configuration > Policy Engine > Suggest/Default Access.

2. Click on New and enter the following:

Table 13. Guardian Policy Engine Suggest/Default Access

Name Tvbe Rule Name Search Default Selected
yp By System Role
All Door Access Default | All Door Access NEW | Systems | ACCESSIT | ALL DOORS
PACS
Home Access Level Default | Home Access Level Systems | ACCESSIT | Home
PACS Access
Level
WO Access Level Default | Home Access Level Systems | ACCESSIT | WO Access
PACS Level
NewHireDefaultSystems | Default | NewHireDefaultSyst | Systems | ACCESSIT
ems PACS
Policy Engine>Rule Action Handler
1 —Setup > Manual Configuration > Policy Engine > Rule Action Handler.
2 — Click New and create the following Action Handlers:
Table 14. Guardian Policy Engine Rule Action Handler
. Update | Evaluate
Action Handler Workflow Task Type Value Priority | Identity | Enterprise
Name
Info Role
Recon New Hire | AlertAccess | Recon Create | New Hire | 0O Yes No
Request
Recon terminate | AlertAccess | Recon Create | Terminate | O Yes No
Handler Request
Recon Error AlertAccess | Recon 0
Handler Exception
Record Task
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ReconChangeHa | AlertAccess | Recon Create
ndler Request

Change
Access

Yes

No

Policy Engine>Policy Designer

1. Setup > Manual Configuration > Policy Engine > Policy Designer

2. Select New to create new Policy designer as:

User Policy New

1. Name — User Policy New
2. Rule Type — AlertAccess
3. Description — User Policy
4. Priority—29

5. Active —Yes

6.

Default Process — No

Figure 134 depicts the new policy interface to create the User Policy described above.
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Figure 134. Guardian User Policy

The following table describes User Policy New.

Table 15. Guardian User Policy

... Is Task Update
Step Name Type Condition handler Task Handler Query
User ID SmasterUser[Userld]
1 Check Decision .size='0'
Task Recon New
2 Create User Handler Yes Hire
ScheckStatus[UserSt
Terminate atus,Active,InActive]
3 Check Decision .action='LOCK'
Task
4 Terminate Handler Yes Recon
Terminate
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Is Task Update
N T iti Task H |
Step ame ype Condition handler ask Handler Query
Handler
Remove
Access ScheckAuthFields[].s
5 Check Decision tatus='Yes'
Error Task Recon Error
6 Handler Handler Yes Handler
Change Task Recon Change
7 Handler Handler Yes Handler

Job Scheduler>Triggers Field Map

N o vk~ w N

Click on New.
Enter Group Name — PACSAD Field Map
Description — PACSAD Field Mapping

Select Type — Reconciliation

Click New and create mapping per below table.
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Table 16. Guardian Job Scheduler Triggers Field Map

User
userEnt | Trainin
Mapped roleTyp | userRol | userBadg | RoleTyp g

AE Attribute Key userType e e e e Type

sAMAccountName | Userld TRUE FALSE FALSE FALSE FALSE FALSE

accountExpires ValidTo TRUE FALSE FALSE FALSE FALSE FALSE

givenName FirstName TRUE FALSE FALSE FALSE FALSE FALSE

sn LastName TRUE FALSE FALSE FALSE FALSE FALSE
userAccountContr

ol statusLDAP TRUE FALSE FALSE FALSE FALSE FALSE

pacsAllDoors PacsAllDoors TRUE FALSE FALSE FALSE FALSE FALSE

PacsHomeAcces
pacsHomeAccess s TRUE FALSE FALSE FALSE FALSE FALSE
pacsWorkAccess PacsWorkAccess TRUE FALSE FALSE FALSE FALSE FALSE

Job Scheduler>Triggers

1. Setup > Manual Configuration > Job Scheduler > Triggers

2. Click New and create the following Triggers:

AlertDbConnectorTrigger

Table 17. Guardian Job Scheduler Triggers

Name PACSAD Trigger
Description PACSAD Trigger
Type Reconciliation
Batch Size 100

Number of Attempts | 3

Policy Designer for

User policy New
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Users/Roles

System: PACS AD
Reconciliation From

Reconciliation System | PACS AD

Field Mapping Group | PACSAD Field Map

User Type True

User Role True

Job Scheduler>Scheduler

1. Setup > Manual Configuration > Job Scheduler > Scheduler.

2. Click New and enter the following as shown in Figure 135:

Job Type — Reconciliation Job

Job Name - <Job Name>

Reconciliation for — User

Reconciliation Type — Incremental Reconciliation
Reconciliation Triggers — PACSAD Trigger

Select the schedule as Immediate, Once, periodic or Advance.For Periodic Job,
specify the Job Start date, End date, and duration of job frequency.
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Figure 135. Guardian Reconciliation Job

3. Click Save.

9.4 SECTION 3. ALERTENTERPRISE APPLICATION CONFIGURATIONS FOR THE CA BUILD

9.4.1 System Type Import of DB Connector:
1. Login to Application.

2. Go to Setup tab > Manual Configuration > Import/Export
3. Check System Types and click on Import.

4. Select the .csv files, which are there in software build package under Connector
\ALNTDbconnector\InitDataFiles folder.

5. After selecting all the files, click on Upload button.
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2699 6. Refresh page until it shows as success or failed.

2700 7. Restart the server if required.

2701 9.4.2 System Types Param of DB Connector:

2702 1. Login to Application.
2703 2. Go to Setup tab> Manual Configuration _> Systems > System Types
2704 3. Search for Connector named “DBConnector” and click on Modify button.
2705 4. Click on Next.
2706 5. Add the following attributes one by one and click on the ADD button.
2707 The following fields in Table 18 need to be provided under Name field and Label can
2708 be any user-friendly name as shown in
MODIFIED_EMTITLEMEN. .. Fetch User Entitler. .. Mandataory
GET_alLL _USERSO GET_aLL_USERSO Mandataory
GET_IMCEEMENTAL_USE... GET_IMCREMENTAL_USE... Mandataory
CREATE_USERD Create CardHolder Q... Mandataory
UPDATE_LISERD Update CardHaolder Q... Mandataory
2709 LOCK_USERD Lock CardHolder Que... Mandataory
2710 and Figure 136: (If the name or label already exists do not add)
2711 Table 18. Guardian Name and Label Fields
Name Label
jndiName Jndi Name
DATE_TIME_FORMAT Date and Time Format
DATE_TIME Date Format
passwordColumnName Passwrd Column Name
userldColumnName Userld Column Name
EXTERNAL_USER_ID_ATTRIBUTE External Userld Attribute
MODIFIED_ENTITLEMENTS Fetch User Entitlement based on last
modified date(not by user)
GET_ALL_USERSO GET_ALL_USERSO
GET_INCREMENTAL_USERSO GET_INCREMENTAL_USERSO
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CREATE_USERO

Create CardHolder Query

UPDATE_USERO

Update CardHolder Query

LOCK_USERO

Lock CardHolder Query

UNLOCK_USERO

Unlock Card Holder Query

DELIMIT_USERO

Change CardHolder Validity Query

USER_PROVISIONEDO

Check Card Holder Provisioned Query

ADD_ROLESO

Assign Roles to Card Holder Query

DEPROVE_ROLESO

Remove Roles From Card Holder Query

GET_GENERATED_USERIDO

Retrieve User Id Query

driverName driverName
url URL

userName userName

password password

CREATE_USER1

CREATE_USER1

LOCK_USER1

LOCK_USER1

Mame Label Parameter Level
jndiMarme Indi Mare Mandatary
DATE_TIME_FORMAT Date and Time Forma... Mandatory
DATE_TIME Date Format Mandatary
passwordColumnMarme Passwrd Column Mame Mandatory
userldColumnMame Userld Column Mame Mandatary
EXTERMAL_USER_ID_AT... External Userld Att... Mandatary
MODIFIED_EMTITLEMEN. .. Fetch User Entitlem. .. Mandatary
GET_aLL_USERSO GET_aLL_USERSO Mandatary
GET_IMCREMEMTAL_USE... GET_IMCREMEMTAL_USE... Mandatary
CREATE_USERD Create CardHolder Q... Mandatary
UPDATE_USERD Update CardHalder Q... Mandatary
LOCK_USERD Lock CardHolder Que... Mandatary
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UMLOCK_IUSERD Unlock Card Holder ... Mandatory
DELIMIT_USERD Change CardHaolder ... Mandataory
IUSER_PROYISIOMNEDO Check Card Halder P... Mandataory
ADD_ROLESO Aszsign Roles to Car.., Mandataory
DEPROYE_ROLESD Remowe Roles From C... Mandataory
GET_GEMNERATED_USERI.., Retrieve User Id Qu... Mandatary

Figure 136. Guardian DB Connector Attributes

9.4.3 Create System Connectors for all Target Systems

1. CONFIGURATION: Create connector for “Alert User Database (External)”

This connector is required to connect the Alert user table exposed to third-party systems (CA in
this case) and get the data.

Steps to create this connector:

1. Setup Tab > Manual Configuration > Systems > System.
2. Click New to create a new system.
3. Definition...Enter the following:
o System Type — DBConnector
® Connector Name — ALERTDBCONNECTOR
® Connector Description — ALERT DB CONNECTOR
® Connector Long Description — ALERT DB CONNECTOR
e Connector Type — DbConnector (Label)
4. Click on Next.
5. Parameters...Enter the following:

Table 19. Guardian Manual Configuration System Parameters

System Param Name System Param Value
Jndi Name java:comp/env/jdbc/alertdb
Date and Time Format MM/dd/yyyy HH:mm:ss

select Userld,

FirstName,LastName,Email, WorkPhone,HomePhone,Department,EmployeeType,PacsAllDoor,Case
WHEN PacsAllDoor='1' then 'TRUE' Else 'FALSE' END as PacsAllDoor,CASE WHEN
PacsHomeAccess='1' then 'TRUE'else 'FALSE' END as PacsHomeAccess , CASE WHEN
GET_ALL_USERSO PacsWorkAccess="'1' then 'TRUE' else 'FALSE' END as

PacsWorkAccess,CardNumber,FacilityCode,LastModifiedDate,ValidFrom ValidTo,Title,UserStatus,PIN
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System Param Name

System Param Value

from alnt_idm_user_dtls

GET_INCREMENTAL_USERSO

select Userld,

FirstName,LastName,Email, WorkPhone,HomePhone,Department,EmployeeType,PacsAllDoor,Case
WHEN PacsAllDoor='1' then 'TRUE' Else 'FALSE' END as PacsAllDoor,CASE WHEN
PacsHomeAccess='1' then 'TRUE'else 'FALSE' END as PacsHomeAccess , CASE WHEN
PacsWorkAccess="'1' then 'TRUE' else 'FALSE' END as
PacsWorkAccess,CardNumber,FacilityCode,LastModifiedDate,ValidFrom,ValidTo,Title,UserStatus,PIN
from alnt_idm_user_dtls where LastModifiedDate> STR_TO_DATE(SLAST_RUN_DATE,'%m/%e/%Y
%H:%i:%s') and UserStatus="'Active'

External Userld Attribute

Userld

Userld Column Name

Userld

6. Click on Next.

7. Attributes...Enter the following:

® Application — Alert Access

® Check the following boxes — Provisioning, Role Management, Offline System.

® Leave Connector Category as Production

e Time Zone — Eastern Daylight Time from drop-down

Note: TimeZone should be same as the TimeZone where application is hosted.

8. Click on Next.

9. Click on Save.

2. CONFIGURATION: Create “Identity DB” System

This is connector is required for internal purposes. Ignore this step if Identity DB Connector

already setup

Steps to create this connector:

1. Setup Tab > Manual Configuration > Systems > System.

2. Click New to create a new system.

3. Definition...Enter the following:

e System Type — Database (JDBC J2EE) from drop-down
® Connector Name — IDENTITYDB
o Connector Description - IDENTITYDB
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® Connector Long Description - IDENTITYDB
e Connector Type — Database (JDBC J2EE) (default)
4. Click on Next.

5. Parameters...Enter the following:
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Table 20. Guardian Identity DB Parameters

System Param Name System Param Value
driverName (use default)
url (use default)
userName (use default)
password (use default)
whereClause (use default)
jndiName java:comp/env/jdbc/alntdb

6. Click on Next.
7. Attributes...Enter the following:
e Application —All

e Check the following boxes — Provisioning, Certification, Identity Provider, Allow
Modify Role and Allow Time Change.

e Leave Connector Category as Production
e Time Zone — Eastern Daylight Time from drop-down
8. Click on Next.

9. Click on Save.
3. CONFIGURATION: Create “ACCESSIT PACS” System

This is connector is required for integrating with RS2 PACS system and performing various
provisioning operations.

Steps to create this connector:

1. Setup Tab > Manual Configuration > Systems > System.
2. Click New to create a new system.
3. Definition...Enter the following:
e System Type — DBConnector from drop-down
® Connector Name — ACCESSIT PACS
® Connector Description - ACCESSIT PACS
® Connector Long Description - ACCESSIT PACS

NIST Cybersecurity Practice Guide SP 1800-2c



2781
2782
2783

2784

DRAFT

e Connector Type — DBConnector (default)

4. Click on Next.

5. Parameters...Enter the following:

Table 21. Guardian PACS DBConnector Parameters

System Param Name

System Param Value

driverName com.microsoft.sqlserver.jdbc.SQLServerDriver

URL jdbc:sqlserver://<HOST_NAME>:<PORT>;databaseName=Al
Universal
<HOST_NAME> should be replaced with the hostname of
the RS2 PACS system

username Login User Name to connect to RS2 PACS database

Password Login password to connect to RS2 PACS database

Date and Time Format

MM/dd/yyyy HH:mm:ss

External Userld Attribute

CardholderID

Create CardHolder Query

INSERT INTO
[AlUniversal].[dbo].[Cardholders]([CardholderID],[LastName],[FirstName],[Middlelnitial],[C
ompanylID],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[CreatedByUser],[
MemberOfAllSites],[UserText1],[UserText2],[UserText3],[UserText4],[UserText5],[UserText6
],[UserText7],[UserText8],[UserText9],[UserText10],[UserText11],[UserText12],[UserText13],
[UserText14],[UserText15],[UserText16],[UserText17],[UserText18],[UserText19],[UserText2
0],[Department],[UserDatel],[UserDate2],[UserDate3],[UserDate4],[UserDate5],[UserNum
ericl],[UserNumeric2],[UserNumeric3],[UserNumeric4],[UserNumeric5],[CardholderStatus
],[CardholderActiveDate],[CardholderExpireDate]) VALUES
(NEWID(),SLastName,SFirstName,SMiddlelnitial, 5CompanylD,SNotes,GetUTCDate(),'alerte
nt',GetUTCDate(),'alertent’,'1',SUserText1,SUserText2,SUserText3,SUserText4,SUserText5,$
UserText6,SUserText7,SUserText8,SUserText9,SUserText_10,SUserText_11,5UserText_12,$
UserText_13,SUserText_14,SUserText_15,5UserText_16,5UserText_17,5UserText_18,SUser
Text_19,SUserText_20,SDepartment,SUserDatel,SUserDate2,SUserDate3,SUserDate4,5Us
erDate5,SUserNumericl,SUserNumeric2,SUserNumeric3,SUserNumeric4,SUserNumeric5,'
1',SCardholderActiveDate,SCardholderExpireDate)

Update CardHolder Query

update [dbo].[Cardholders] set LastModified=GetUTCDate() where
CardholderlD=$CardholderID

Lock CardHolder Query

update [dbo].[Cardholders] set CardholderStatus='0' where CardholderID=$CardholderID

Unlock Card Holder Query

update [dbo].[Cardholders] set CardholderStatus='1"' where CardholderID=SCardholderID
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System Param Name

System Param Value

Check Card Holder Provisioned
Query

select CardholderlD from [dbo].[Cardholders] where CardholderID =$CardholderiD

Assign Roles to Card Holder Query

INSERT INTO [dbo].[CardholderAccessLevels] ( [CardholderAccessLevellD],
[CardholderID], [AccessLevellD],[LastModified],[ActivateDate],[ DeactivateDate]) VALUES (
NEWID(), SCardholderID,(select AccessLevellD from [dbo].[AccessLevels] where
AccessLevelName=$ROLE_NAME),GetUTCDate(), NULL, NULL)

Remove Roles From Card Holder
Query

delete from [dbo].[CardholderAccessLevels] where CardholderID=$CardholderID and
AccessLevellD=(select AccessLevellD from [dbo].[AccessLevels] where
AccessLevelName=SROLE_NAME)

Retrieve User Id Query

select CardholderID from [dbo].[Cardholders] where UserText1=SUserText1

CREATE_USER1

INSERT INTO [AlUniversal].[dbo].[Cards]
([CardID],[CardholderID],[CardNumber],[FacilityCode],[PINNumber],[PINExempt],[APBExe
mpt],[UseExtendedAccessTimes],[CardStatus],[ActiveDate],[ExpireDate],[UserLevel],[UseC
ustomReporting],[Eventinfo],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[
CreatedByUser],[IssueLevel],[DeactivateExempt],[VacationDate],[VacationDuration],[UseCo
unt],[TempDeactivateStart],[TempDeactivateEnd],[Classification],[IPLocksetUserType],[IPLo
cksetAccessMode],[IPLocksetCredentialFormat],[IPLocksetAccessAlways],[RawPrimaryCred
ential],[LargeEncodedCardID],[EmbossedNumber]) VALUES (NEWID(),(select CardholderID
from [dbo].[Cardholders] where
UserText1=SUserText1),SCardNumber,SFacilityCode,SPIN,'0','0','0",'1',NULL,NULL,'0','0',NUL
L,NULL,SYSDATETIME(),'alertent’,SYSDATETIME(),'alertent','0','0',NULL,'0','255',NULL,NULL,"'
Active',NULL,NULL,NULL,NULL,NULL,NULL,")

LOCK_USER1

update [AlUniversal].[dbo].[Cards] set CardStatus='0',Classification="InActive' where
[CardNumber]=$CardNumber

6. Click on Next.

7. Attributes...Enter the following:

e Application — All

® Check the following boxes — Provisioning, Role Management, and Offline System.

® Leave Connector Category as Production

e Time Zone — Eastern Daylight Time from drop-down

8. Click on Next.

9. Click on Save.

Form customization — Attributes

Create New Custom Form Attributes
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1. Setup > Manual Configuration > Form customization > Attributes

2. Click on New Button
3. Create new attribute called PacsAllDoors based on the information provided below in
Table 22.
4. Click Save
Table 22. PacsAllDoors Attributes
Field Name Field Value
Name PacsAllDoors
Label PacsAllDoors
Description PacsAllDoors
Visible Yes
Mandatory No
Read Only No
Field Type TextField (Select this value from drop down)

USS Create Request

Yes(Select CheckBox)

USS User Information

Yes(Select CheckBox)

Approver View

Yes(Select CheckBox)

Provisioning Yes(Select CheckBox)
Create Request 10

Sequence

User Info Sequence 10

Approver Sequence 10

Group Name

Personnel Information (Select this value from drop down)

5. Repeat Steps 1-4 to create the following custom form attributes
1. Create PacsHomeAccess Attributes (See Table 23)

169 | NIST Cybersecurity Practice Guide SP 1800-2c




DRAFT

2804 Table 23. PacsHomeAccess Attributes
Field Name Field Value
Name PacsHomeAccess
Label PacsHomeAccess
Description PacsHomeAccess
Visible Yes
Mandatory No
Read Only No
Field Type TextField (Select this value from drop down)
USS Create Request Yes(Select CheckBox)
USS User Information Yes(Select CheckBox)
Approver View Yes(Select CheckBox)
Provisioning Yes(Select CheckBox)
Create Request 11
Sequence
User Info Sequence 11
Approver Sequence 11
Group Name Personnel Information (Select this value from drop down)
2805
2806 2. Create PacsWorkAccess Attributes (as shown in Table 24)
2807 Table 24. PacsWorkAccess Attributes
Field Name Field Value
Name PacsWorkAccess
Label PacsWorkAccess
Description PacsWorkAccess
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Field Name Field Value

Visible Yes

Mandatory No

Read Only No

Field Type TextField (Select this value from drop down)
USS Create Request Yes(Select CheckBox)
USS User Information Yes(Select CheckBox)
Approver View Yes(Select CheckBox)
Provisioning Yes(Select CheckBox)
Create Request 12

Sequence

User Info Sequence 12

Approver Sequence 12

Group Name

Personnel Information (Select this value from drop down)

3. Create FacilityCode Attributes as shown in Table 25.

Table 25. FacilityCode Attributes

Field Name Field Value

Name FacilityCode

Label Facility Code

Description Facility Code

Visible Yes

Mandatory Yes

Read Only No

Field Type TextField (Select this value from drop down)
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Field Name Field Value

USS Create Request No

USS User Information No

Approver View No

Provisioning Yes(Select CheckBox)

Create Request
Sequence

User Info Sequence

Approver Sequence

Group Name

Personnel Information (Select this value from drop
down)

4. Create PIN Attributes as shown in Table 26.

Table 26. PIN Atributes

Field Name Field Value

Name PIN

Label PIN

Description PIN

Visible Yes

Mandatory No

Read Only No

Field Type TextField (Select this value from drop down)
USS Create Request Yes(Select CheckBox)
USS User Information No(Select CheckBox)
Approver View No(Select CheckBox)
Provisioning Yes(Select CheckBox)
Create Request 12
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Field Name Field Value

Sequence

User Info Sequence

Approver Sequence

Group Name Personnel Information (Select this value from drop down)

Modify Employee Type Attribute

PwwnNpeE

Setup > Manual Configuration > Form customization > Attributes
Select Employee Type Field from list of Attributes and Click Modify
Click on DropDown Values Icon

On the popup window, Click on New and Provide Employee in both Name and Label

fields, Figure 137.

Create DropDownValues

*Mame Emplovees *Label Employee|
Gancel Save

Figure 137. Create DropDownValues

5. Similarly configure values for Contractor field, Figure 138.
DropDown Yalues Y
Hame Label
Contractor Contractor
Employee Employes
Figure 138. Contractor Field

6. Click Save and then Click Save to save the configuration
7. lgnore this step if these values already exists

Modify Status Attribute

PwwnNpE

Setup > Manual Configuration > Form customization > Attributes

Select Status field from list of Attributes and Click Modify

Click on DropDown Values Icon

On the popup window Click on New and provide Active in both Name and Label
fields, Figure 139.
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Create DropDown¥alues

*Name Active *Label Active

Cancel Save

Figure 139. DropDownValues

DropDown Yalues

Name Lahel
Active Active
Inactive InActive

Figure 140. InActive

5. Similarly configure values for InActive field, Figure 140
6. Click Save and then Click Save to save the configuration
7. lgnore this step if these values already exists for Status field

Identity & Access— Enable Identity

1. Setup > Manual Configuration >ldentity & Access>Enable Identity
2. Enable the following for Identity DB system as shown in Figure 141.
Figure 141. Guardian Identity Configuration
9.4.4 |dentity & Access— User Field Mapping

1. Setup > Manual Configuration > Identity & Access > User Field Mapping.

2. Select User = Identity (from drop-down) and click Go.

3. Click the Create New button.

4. Select Custom Field, Primary Key, Visible In List, IsSearchable fields based on the table
listed below. Select checkbox for these fields if it is specified as “Yes” otherwise, keep it
as unselected.

5. Click on Save button to save the record

6. Repeat Steps 1-5 for all fields in the following table, Table 27. Ignore fields if pre-existing

mapping already exists for a particular field.
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Table 27. User Field Mapping Table

Custom Field Primary Key Visible In List IsSsearchable
Userld No Yes No
ValidFrom No Yes No
ValidTo No Yes No
FirstName No Yes Yes
LastName No Yes Yes
Email No No No
Building No No No
Managerld No No No
BadgeStatus No No No
BadgeType No No No
BadgeValidFrom No No No
BadgeValidTo No No No
Location No No No
Badgeld No No No
EmployeeType No No No
Department No No No
Password No No No
Groups No No No
ManagerName No No No
ManagerLN No No No
Manager No No No
Managerld No Yes No
Status No No No
Telephone No No No
ImageUpload No No No
Password_AD No No No
PacsAllDoors No Yes No
PacsHomeAccess No Yes No
PacsWorkAccess No Yes No

Identity & Access > Recon Authoritative Fields

1. Setup > Manual Configuration > Identity & Access > Recon Authoritative Fields.

2. Click on New.
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2858 3. Select ALERTDBCONNECTOR from Systems Drop down and select Authoritative field as
2859 PacsAllDoors as shown in

Create Recon Authoritative Fields

* Systems  ALERTDBCONMECTOR v
* Authoritative Field PacsallDoars v
Cancel Save

2860

2861 Figure 142. Authoritative Fields

2862 4. Click Save button to save the mapping.

2863 5. Repeat Steps 1-4 to configure mapping other fields PacsWorksAccess and

2864 PacsHomeAccess as listed in the screenshot shown in Figure 139.
ALERTDRBCOMMECTOR PacsallDoors
ALERTDBCOMMECTOR PacsworkAccess
ALERTDBCOMMECTOR PacsHome&ccess

2865 New Modify Delete

2866 Figure 143. Guardian Recon Authoritative Fields

2867 Identity & Access > Request Categories

2868 1. Setup > Manual Configuration > Identity & Access > Request Categories

2869 2. Select ChangeAccess Category name and Click Modify

2870 3. On the Modify screen make following changes

2871 a. Inthe Provisioning Actions section Un select Delimit user and Change Validity

2872 Dates check boxes if they are selected

2873 b. Go to Add Existing section and select System and Remove Role option for

2874 Resources/Roles Drop down field

2875 4. Click Save Button to save the configuration

2876  Identity & Access>Provisioning>External Provisioning Attributes

2877 1. Setup > Manual Configuration > Identity & Access > Provisioning > External Provisioning
2878 Attributes
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2879 2. Select ACCESSIT PACS system from the list and Click Configure

2880 3. On the Next screen, Click on New Button and provide “LastName” in both Name and
2881 description fields

2882 4. Click Save to save the configurations as shown in Figure 144,

Create External Provisioning Attribute

Name LastMarme
Description LastMame|
Cancel Save

2883

2884 Figure 144. External Provisioning Attribute

2885

2886 Repeat the Steps 1-4 to configure the following fields listed in the following screenshot,

2887 Figure 145. Note: The Fields Names are case sensitive.

2888 5.
Hame Description
LastMame LastMame
FirstMame Firsthame
Middlelnitial MiddleInitial
CampanyID CompanyID
UserTextl UsarTextl
CardholderID CardholderID
CardMumber CardMurnber
FacilityCode FacilityCode
PIM PIM

2889

2890 Figure 145. Attribute Fields

2891

2892 Identity & Access>Provisioning>Provisioning Mapping

2893 1. Setup > Manual Configuration > Identity & Access > Provisioning > Provisioning Mapping.
2894 2. Select ACCESSIT PACS and click on Configure.
2895 3. Onthe Next Screen, Figure 146, Click New Button and select UserText1 from
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DB Connector

Attribute Name LSS '
AlertEnterprise
Attribute Name Userld '
Derived Attribute v
MName
Mandatory Mo v
EditﬂhIE YES v
"-'.iSthE YES v

Default Yalue

Show Auto
Generate

Validation Flag

Is User-Id
attribute

Cancel Save

Figure 146. Provisioning Mapping

4. Click on Save button to save the mapping

5. Repeat the steps 1-4 to configure other fields as shown in Figure 140.

DB Connector Attribute Mandatory AlertEnterprise Attrib... Default Value Editable Visihle
UserTextl Mo Userld Mo
Firsthame Yes FirstName Yes
LastMame Yes LastName Yes
CompanylID Mo Priarity Mo
CardholderlD Yes Userld Yes
CardMurmnber Yes Badgeld Yes
FacilityCode Mo FacilityCode 20 Yes
PIM Mo PIN Yes

Cancel New Modify Delete

Figure 147. Guardian DB Connector Attribute Mapping

Policy Engine> Rules

1. Setup > Manual Configuration > Policy Engine > Rules
2. Click New Button

3. On the Next screen provide following information. See Figure 148.
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Define Rules

* Rule Name Al Door Access MNew
Entity Type o rkFlow Entity
Rule Type Alerticcess v
* Description All Door Access MNew
2
* applicable To Initiator

Decision
Suggest/Default
FRole Model
Palicy
Master User Search
Groups

Role Certification
unMitigatedrRiskallowed

* Aattributes:

aAnd fOr: and ar
PacsallDoors b Request Category v
2906 Mext Ccancel
2907 Figure 148. Policy Rules
2908 4. Click Next Button
2909 5. Onthe next screen, Figure 149, click New to define a new Rule Condition for NewHire
2910 request category

Define Condition

If PacsallDoors equals ¥ | True and
Fequest :
Categary equals ¥ || MewHire v
2911 Add Cancel
2912 Figure 149. Rule Conditions
2913
2914 6. Repeat the step 5 to define rule condition for other request categories Remove User
2915 Access and ChangeAccess as shown in Figure 150.
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If PacsallDoors and Request Category
= True = NewHire
= True = Remove User ACCess
= True = ChangeAccess
= true = Changeiccess

Figure 150. Rule Conditions

7. Repeat Step 1-6 to configure Other Rules Home Access Level New and WO Access Level
New as shown in following Table 21.

Table 28. Guardian Manual Configuration Policy Engine Rules

Rule Name Entity Type| Rule Type Description Applicable to Attributes Drop down value Selection Value

1. True and New Hire
2.True and Remove User
Suggest/Default Access

All Door Access New Workflow |AlertAccess |All Door Access New PacsALLDoors AND Request Category |Equals 3. True and ChangeAccess

1. True and New Hire

2. True and Remave User
Suggest/Default Access

Home Access Level New |Workflow |AlertAccess |Home Access Level New PacsALLDoors AND Request Category |Equals 3. True and ChangeAccess

1. True and New Hire

2. True and Remave User
Suggest/Default Access

WO Access Level New  |Workflow |AlertAccess |WO Access Level New PacsALLDoors AND Request Category |Equals 3. True and ChangeAccess

Policy Engine> Suggest/Default Access

1. Setup > Manual Configuration > Policy Engine > Suggest/Default Access.

2. Click New and enter the following information to create All Door Access criteria, shown
in Figure 151 .
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* Mame All Door Access

* Type Default

Use identity old
values

Provisioning Action

Cancel Back Next

3. Click Next Button

Description &ll Door Access

* Condition Al Door Access Mew

Search By Role
Attributes

Search by Systems +

Search by Training
Roles

Search by Training
Attributes

Search by Enterprise
Roles

Figure 151. Default Access

4. On the Next screen, Enter ACCESSIT PACS in System Name Field and hit Search button

5. The System will appear in Search Results pane. Click Add link under Action column to
add the system to Selected Systems section

6. Click Next Button

7. On the next screen, enter ALL DOORS in Role Name Field and hit Search button

8. The Role will appear in Search Results pane. Click Add link under Action column to add
the role to Selected Roles section

9. Click Save button to save the configuration

10. Repeat the steps 1-9 to configure other criteria for Home Access Level,

WO Access Level, NewHireDefaultSystems as listed in Table 29. Manual Configuration
Policy Engine Suggest/Default Access

Table 29. Manual Configuration Policy Engine Suggest/Default Access

... Search By Selected Selected
Name Type Condition
System System Role
All Door Access Default All Door Access Yes ACCESSIT ALL
NEW PACS DOORS
(Select
check box)
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Home Access Level | Default Work Access Level | Yes ACCESSIT Home
New PACS Access
(Select Level
check box)
WO Access Level Default Home Access Yes ACCESSIT wo
Level New PACS Access
(Select Level
check box)
NewHireDefaultSy | Default NewHireDefaultSy | Yes ACCESSIT
stems stems PACS
(Select
check box)

11. Select all existing Suggest Default Access criterias other than the one listed in Table 22
and Click Delete button to delete them.
Policy Engine>Rule Action Handler
1. Setup > Manual Configuration > Policy Engine > Rule Action Handler.
2. In Action Handlers List page select ReconChangeHandler and Click Modify
3. Onthe next screen Select Recon Create Request Task Type and Click Update Task

4. On the popup window Click on Value drop down field and select ChangeAccess from the
list as shown in Figure 152.

b
Task type | Recon Create Request v |
Value | Changefccess v |
Priority 0
Update Identity Info | Yes v |
Evaluate Enterprise Role | Mo v |
Cancel Sawve Task

Figure 152. Modify Task

5. Click on Save Task and then Click Save Button
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Policy Engine>Policy Designer

1. Setup > Manual Configuration > Policy Engine > Policy Designer
2. Select New to create new Policy designer as shown in Figure 153.
Name — User Policy New
Rule Type — AlertAccess

Description — User Policy

* Name User Policy New
* Rule Type Alertaccess v

Description User Palicy Mew

Back Next Cancel

Figure 153. Policy Designer

3. Click Next

4. Drag the elements from the tool bar section, available on top of the page and place
them onto the layout page and connect each node as shown in
Figure 154.

N Q BB & B 0O = H
S start end Merge Decision Task Task Group MNotify transition Save
B Figure 154. Toolbar

. represents Start button

“Stop
represents End Button

Us
represents Decision
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2977 represents transition

» v’ Create User

2978 represents Task

2979

2980 5. Guide lines to configure the policy

2981 a. To place an element/node on the layout page, drag it from the toolbar and place
2982 it.

2983 b. To connect two nodes, select transition icon from tool bar and then mouse over
2984 to the first node and connect to the other node in the same direction specified in
2985 the Figure 23)

2986 c. To provide text for a Decision or Task or Line, double click on the corresponding
2987 node and enter the text. Hit Enter after that to come out of the edit mode.

2988
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2999
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Figure 155. Guardian User Policy

6. Click on Step 1 decision box and it will open popup window with some fields. See Figure
156
7. Enter SmasterUser[Userld].size='0' in the Condition text box and hit Enter

< Tasks =

Templates
Decision
Condition:

FmaszterUszer[Userld].size="0"

Figure 156. Tasks Popup

8. Similarly, click on other Steps (2 to 7) and configure the data based on Table 30.

9. For decision nodes provide Condition value and for Task nodes like Create User,
Terminate User, Change Handler, Error Handler provide IsTaskHandler and Task Handler
fields
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Table 30. Condition Decision Values
... Is Task Task Update
Step Name Type Condition handler Handler Query
User ID
1 Check Decision | SmasterUser[Userld].size='0'
Create Task Recon New
2 User Handler Yes Hire
Terminat ScheckStatus[UserStatus,Acti
3 e Check | Decision ve,InActive].action='LOCK'
Recon
Terminat Task Terminate
4 e Handler Yes Handler
Remove
Access ScheckAuthFields[].status="Ye
5 Check Decision s'
Recon
Error Task Error
6 Handler | Handler Yes Handler
Recon
Change Task Change
7 Handler | Handler Yes Handler
Job Scheduler>Triggers Field Map
1. Setup > Manual Configuration > Job Scheduler > Triggers Field Map.
2. Click New
3. Enter Group Name — Alert DbConnector Field Mapping
4. Description — Alert DbConnector Field Mapping
5. Select Type — Reconciliation
6. After creating Field Map, select the newly created map and select Configure
7. Click New and create mapping per below, Table 31
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Table 31. Guardian Job Scheduler Triggers Field Map

AE Attribute mappedKey userType |[roleType |userRole |userBadge |userEntRoleType |userTrainingType
Userld Userld TRUE FALSE FALSE FALSE FALSE FALSE
FirstName FirstName TRUE FALSE FALSE FALSE FALSE FALSE
LastMame LastMame TRUE FALSE FALSE FALSE FALSE FALSE
Email Email TRUE FALSE FALSE FALSE FALSE FALSE
Telephone WorkPhone TRUE FALSE FALSE FALSE FALSE FALSE
Mobile HomePhone TRUE FALSE FALSE FALSE FALSE FALSE
EmployeeType |EmployeeType TRUE FALSE FALSE FALSE FALSE FALSE
PacsAllDoars PacsAllDoor TRUE FALSE FALSE FALSE FALSE FALSE
PacsHomeAccess [PacsHomeAccess TRUE FALSE FALSE FALSE FALSE FALSE
PacsWorkAccess |PacsWorkAccess TRUE FALSE FALSE FALSE FALSE FALSE
Badgeld CardNumber TRUE FALSE FALSE FALSE FALSE FALSE
Format FacilityCode TRUE FALSE FALSE FALSE FALSE FALSE
ValidFrom ValidFrom TRUE FALSE FALSE FALSE FALSE FALSE
ValidTo ValidTo TRUE FALSE FALSE FALSE FALSE FALSE
Title Title TRUE FALSE FALSE FALSE FALSE FALSE
Status UserStatus TRUE FALSE FALSE FALSE FALSE FALSE
PIN PIN TRUE FALSE FALSE FALSE FALSE FALSE
AlertDepartment |Department TRUE FALSE FALSE FALSE FALSE FALSE

Job Scheduler>Triggers

1. Setup > Manual Configuration > Job Scheduler > Triggers

2. Click New and create the following Triggers in Table 32.

AlertDbConnectorTrigger

Table 32. Guardian AlertEnterprise DB Trigger

Name AlertDbConnectorTrigger
Description AlertDbConnectorTrigger
Type Reconciliation

Batch size 100

Number of Attempts 3

Policy Designer for Users/ Roles

User policy New

System: Reconciliation From

ALERTDBCONNECTOR

Reconciliation System

ALERTDBCONNECTOR

Field Mapping Group

ALERTDBCONNECTOR Field Mapping

User Type

True

User Role

True

Job Scheduler>Scheduler

1. Setup > Manual Configuration > Job Scheduler > Scheduler.
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2. Click New and enter the following, shown in Figure 142.

3. Click Save.
e Job Type — Reconciliation Job
e Job Name - <Job Name>
e Select Global check box
e Reconciliation for — User
e Reconciliation Type — Incremental Reconciliation
e Reconciliation Triggers — AlertDbConnectorTrigger
e Select the schedule as Immediate, Once, periodic or Advance.
e For a periodic job, specify the job start date, end date, and duration of job

frequency.
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Figure 157. Guardian Reconciliation Job

3. Click Save.

The Access It Universal RS2 Technologies PACS Server is installed on the PACS Network to help
control physical access to simulated facilities, rooms, etc. RS2 Technologies cards and card
readers were also included in both builds. The RS2 Technologies PACS Server is installed on a
VM that is running the Windows Server 2012 R2 OS.

10.1 SECURITY CHARACTERISTICS

Cybersecurity Framework Categories: PR.AC-2: Physical access to assets is managed and
protected

NIST 800-53 rev 4 Security Controls: PE-2, PE-3, PE-4, PE-5, PE-6, PE-9
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3047 10.2 SYSTEM ENVIRONMENT

3048 The system for the PACS-Console Server configured by the NCCoE contains the following
3049 configuration settings and environmental constraints:

3050 e Windows Server 2012 R2

3051 e VM with CPU Quad Core 2.199GHz

3052 e VM with 8192MB of memory

3053 e Virtual Hard Disk containing 240 GB of storage.

3054 10.3 AIUNIVERSAL INSTALLATION

3055 1. Insert the AIUNIVERSAL CD into the CD-ROM drive.

3056 2. Launch Setup64.exe as Administrator.

3057 3. Follow install instructions:

3058 e Select|do not have a SQL Server installed.

3059 e When prompted to install SQL Server 2008 R2 Express Edition select Yes.

3060 e Afterinstallation of SQL Server. Select Install Access It! Universal.

3061 e When prompted to install a Stand-Alone Server version of Access It! select OK.
3062 e When prompted by the install wizard select Next >.

3063 e Read the license agreement and select Next > if you agree with the terms of the
3064 agreement.

3065 e Use default installation folder C:\Program Files(x86)\RS2 Technologies\Access It!
3066 Universal\ then select Next >.

3067 e When the installer is ready select Next > to continue.

3068 e Select Close to exit the installer after completion.

3069 10.4 PoOST INSTALLATION

3070 1. Launch Access It! by selecting it from the Start menu.
3071 2. When prompted to select server, enter the host name of server: PACS-CONSOLE.
3072 3. Log in with the default user name and password.

3073 10.4.1 Connect Access It! Universal to Door Controller

3074 1. Under the Main > Hardware tab, select Channels.
3075 2. Create a new Channel.

3076 3. For Channel Type select IP Server.

3077 4. Ensure Protocol Type is SCP.
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10.
11.

12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.

Select Save.

Create a new SCP.

Under the General tab ensure that Model is set to EP-1501Plus.

Under the Comm tab ensure that Channel is set to Channel 000 (the channel just
created).

TCP/IP Settings:

IP Address: 172.16.7.101
Port Number: 3001

Encryption Settings: None.

Under the Card Formats tab:

Format Name: 26 Bit Wiegand Facility code: 20
Format Name: 26 Bit Wiegand Facility code: 219

Save changes to SCP 000.
Under SIOs
Edit SCP 000 - SIO 00

Under General tab ensure Model is set to EP-1501.
Edit SCP 000 —SIO 01

Under General tab ensure Model is set to MR-52.

Under Main > Hardware select Installed Readers
Create SCP 000 — SIO 00-Reader 1

Create SCP 000 — SIO 01-Card Reader

Create SCP 000 -SIO 01-MRDT Keypad

Under Configuration > Access Levels create New Access Level.

Create new access levels.

Access Level Name: All Doors.

Assigned Readers for All Doors: SCP 000 — SIO 01-Card Reader and SCP 000 - SIO
01-MRDT Keypad.

Access Level Name: Home Access Level.
Assigned Reader for Home Access Level: SCP 000 — SIO 01-MRDT Keypad.
Access Level Name: Work Order Access Level.

Assigned Reader for Work Order Access Level: SCP 000 — SIO-Card Reader
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10.4.2 Enable TCP/IP to SQL 2008 R2 Server

Launch Microsoft SQL Server Configuration Manager.

Expand SQL Server Network Configuration (32-bit).

Select Protocols for AIUNIVERSAL.

Right-click on TCP/IP and then select Properties.

Select tab IP Addresses.

Under IP1 ensure IP Address is set to 0.0.0.0 and TCP Port is set to 1433.

Under IPALL ensure TCP Dynamic Ports is set to 52839 and TCP Port is set to 1433.

© N O Uk W N E

Restart the SQL server by selecting SQL Server Services then right click on SQL Server
(AIUNIVERSAL) and select Restart.

The TDi ConsoleWorks server was installed in two different locations in the builds. It was
installed on the OT network to control and monitor access between OT technicians and physical
devices such as the RTUs and the RADiFlow ICS firewall. The following two sections provide
details on the steps needed to install and configure each of these servers.

11.1 SEecCURITY CHARACTERISTICS
Cybersecurity Framework Categories:

e PR.PT-1: Audit/log records are determined, documented, implemented, and reviewed in
accordance with policy

e PR.PT-3: Access to systems and assets is controlled, incorporating the principle of least
functionality

NIST 800-53 rev 4 Security Controls: au Family, AC-3, cM-7

11.2 CONSOLEWORKS SERVER INSTALLATION

ConsoleWorks was installed on the OT network to control and monitor access between OT
technicians and physical devices such as the RTUs and the RADiFlow ICS firewall. ConsoleWorks
uses the OT directory to authenticate users requesting access to these devices. It also
establishes a permanent SSH or telnet connection to each of the RTUs and ICS firewall using
pre-established usernames and passwords. As users request access and are authenticated
ConsoleWorks makes the cross-connection from the user to the specific SSH or telnet session to
allow access. Once the cross-connection is established the user has access to the device to
make any changes needed. When the user completes their task they log-off of the connection
and ConsoleWorks removes the cross-connect between the user and the SSh or telnet session.
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ConsoleWorks logs all user access requests, all of the traffic on the session, and can alert on any
pre-defined aspect of the traffic. Directory based authentication is used to manage the user
access in near real time.

On the OT network, the ConsoleWorks Server is installed on a VM that is running the Windows
Server 2012 R2 (hardened server OS) image, as explained in Section 1.

11.2.1

System Environment

The system for the OT Network ConsoleWorks Server configured by the NCCoE contains the
following configuration settings and environmental constraints:

L ©® N o

Windows Server 2012 R2 OS

VM with CPU Quad Core 2.199GHz

VM with 8192MB of memory

Virtual Hard Disk containing 240 GB of storage.

ConsoleWorks Server Installation on the OT Network

After installing the OS, download the TDi Technologies Installer from
http://support.tditechnologies.com/get consoleworks.

Launch the cw_server v4.9-0u0.exe application. The installer requires administrative
privileges to execute.

When prompted by Windows User Account Control, select Yes to continue.

The ConsoleWorks Server InstallShield Wizard should display a welcome message. Select
Next > to continue.

When prompted by the InstallShield Wizard to accept the license agreement, read
carefully. If you agree with the license terms, select Next > to continue with the
installation.

Enter the User Name and Organization fields, then select Next > to continue.
Select Complete when prompted for setup type, then select Next > to continue.
Click Install to begin installation of ConsoleWorks Server.

After the InstallShield Wizard has completed, ensure that Launch upgrade script (if
upgrading from 32 bit) is unchecked.

. Select Finish.

Post-installation Configuration of ConsoleWorks on the OT Network

Copy TDi Technologies license key files into
C:\ProgramData\ConsoleWorks/Server\LMF\TDI_Licenses

Go to Start > Run > services.msc.

Right-click on the ConsoleWorks Server Service, then select Properties.
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4. Select Start to start the service. Then change the Startup Type from Manual to
Automatic.

5. Select Apply to save changes. Both the ConsoleWorks Server and ConsoleWorks LMF
Server services should be running.

6. Test browser connectivity by going to http://localhost:5176. The default account is
CONSOLE_MANAGER. The default password is: Setup

11.2.4 Configuring External Authentication for the OT Network ConsoleWorks Server

1. From the left menu, select the SECURITY tab.
2. Select External Authentication.
3. Ensure the Enable External Authentication checkbox has been selected.
4. Select Add.
e Parameter 1: OT-ES-IDAM-B1
e Parameter 2: CW _
e Required Profile: CONSOLE WORKS
e Template User: CONSOLE MANAGER
e Leave all other fields blank.
5. Then select Next.
6. Enter a Username and Password to test Exte